ASIMON V3

Configuration software for
AS-Interface safety monitors

Programming and Operating Manual · 04/2016
Safety Guidelines

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

**Danger**
indicates that death or severe personal injury **will** result if proper precautions are not taken.

**Warning**
indicates that death or severe personal injury **may** result if proper precautions are not taken.

**Caution**
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

**Caution**
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

**Notice**
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The device/system may only be set up and used in conjunction with this documentation. Commissioning and operation of a device/system may only be performed by qualified personnel. Within the context of the safety notes in this documentation qualified persons are defined as persons who are authorized to commission, ground and label devices, systems and circuits in accordance with established safety practices and standards.

Prescribed Usage

Note the following:

**Warning**
This device may only be used for the applications described in the catalog or the technical description and only in connection with devices or components from other manufacturers which have been approved or recommended by Siemens. Correct, reliable operation of the product requires proper transport, storage, positioning and assembly as well as careful operation and maintenance.

Trademarks

All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
# Table of Contents

1 General Information .......................................................... 7
   1.1 About the ASIMON program ........................................... 7
   1.2 Version information .................................................... 8
   1.3 Explanation of symbols ............................................... 11
   1.4 Definition of terms .................................................. 12
   1.5 Abbreviations ......................................................... 13

2 Installation of hardware and software ...................................... 15
   2.1 Hardware ............................................................... 15
      2.1.1 Prerequisites ..................................................... 15
   2.2 Software ............................................................... 16
      2.2.1 System requirements ............................................ 16
      2.2.2 Installation ....................................................... 16

3 First steps ........................................................................... 17
   3.1 Launching the program ................................................ 17
   3.2 Description of the user interface .................................... 26
      3.2.1 The menu bar ....................................................... 26
      3.2.2 The toolbar ......................................................... 28
      3.2.3 The status/info bar ............................................... 29
      3.2.4 The work area ..................................................... 30
   3.3 Program settings ......................................................... 35
      3.3.1 Setting the program language ................................ 35
      3.3.2 Selecting the serial interface .................................. 36

4 Configuring the AS-Interface safety monitor ................................. 37
   4.1 Function of the AS-Interface safety monitor ....................... 37
   4.2 General procedure ..................................................... 39
   4.3 Creating and changing a configuration .............................. 40
      4.3.1 Monitoring devices ............................................... 43
      4.3.2 Logic devices ...................................................... 76
      4.3.3 External device monitoring devices .......................... 90
      4.3.4 Start devices ..................................................... 102
      4.3.5 Output devices .................................................... 110
      4.3.6 Diagnostic devices ............................................... 132
      4.3.7 System devices .................................................... 135
      4.3.8 User devices ...................................................... 136
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.3.9</td>
<td>Activating and deactivating devices</td>
<td>138</td>
</tr>
<tr>
<td>4.4</td>
<td>Saving / loading a configuration</td>
<td>142</td>
</tr>
<tr>
<td>5</td>
<td>Commissioning the AS-Interface safety monitor</td>
<td>143</td>
</tr>
<tr>
<td>5.1</td>
<td>Procedure</td>
<td>143</td>
</tr>
<tr>
<td>5.2</td>
<td>Reading in a configuration from the AS-Interface safety monitor</td>
<td>146</td>
</tr>
<tr>
<td>5.3</td>
<td>Transferring a configuration to the AS-Interface safety monitor</td>
<td>146</td>
</tr>
<tr>
<td>5.4</td>
<td>Teach safe configuration</td>
<td>147</td>
</tr>
<tr>
<td>5.5</td>
<td>Validating the configuration</td>
<td>151</td>
</tr>
<tr>
<td>5.6</td>
<td>Starting the AS-Interface safety monitor</td>
<td>153</td>
</tr>
<tr>
<td>5.7</td>
<td>Stopping the AS-Interface safety monitor</td>
<td>154</td>
</tr>
<tr>
<td>5.8</td>
<td>Configuration documentation</td>
<td>154</td>
</tr>
<tr>
<td>5.9</td>
<td>Entering and changing the password</td>
<td>163</td>
</tr>
<tr>
<td>6</td>
<td>Diagnostics and error handling</td>
<td>165</td>
</tr>
<tr>
<td>6.1</td>
<td>Diagnostics</td>
<td>165</td>
</tr>
<tr>
<td>6.2</td>
<td>Troubleshooting and error rectification</td>
<td>168</td>
</tr>
<tr>
<td>6.3</td>
<td>Known problems</td>
<td>168</td>
</tr>
<tr>
<td>7</td>
<td>Diagnostics via AS-Interface</td>
<td>169</td>
</tr>
<tr>
<td>7.1</td>
<td>General procedure</td>
<td>169</td>
</tr>
<tr>
<td>7.2</td>
<td>Assignment of the AS-Interface diagnosis indices</td>
<td>171</td>
</tr>
<tr>
<td>7.3</td>
<td>Telegrams</td>
<td>175</td>
</tr>
<tr>
<td>7.3.1</td>
<td>Diagnosis of AS-Interface safety monitor</td>
<td>175</td>
</tr>
<tr>
<td>7.3.2</td>
<td>Diagnosis of devices, sorted by OSSD</td>
<td>178</td>
</tr>
<tr>
<td>7.3.3</td>
<td>Diagnosis of devices, unsorted</td>
<td>180</td>
</tr>
<tr>
<td>7.4</td>
<td>Example: Querying with diagnosis sorted according to OSSD</td>
<td>182</td>
</tr>
<tr>
<td>8</td>
<td>Appendix</td>
<td>183</td>
</tr>
</tbody>
</table>
1.1 About the ASIMON program

The software described here is intended for the configuration and commissioning of the AS-Interface safety monitor with the use of a PC.

By means of an easy-to-use user interface, the AS-Interface safety monitor can be configured in combination with safe AS-Interface slaves, such as emergency shutdown switches, safety gate switches, protective photoelectric sensors etc., within an AS-Interface bus system to provide safeguarding of the danger areas present at power-driven machinery.

The commissioning and documentation of your safe application are also supported by ASIMON.

Note
A brief introduction to secure AS-Interface transmission can be found in the operating manual of the AS-Interface safety monitor.

This version of the ASIMON configuration software has been developed for use under the Microsoft® Windows 95/98/ME/NT/2000/XP/Vista®/7 operating systems.
1.2 Version information

The AS-Interface safety monitor and the corresponding ASIMON configuration software have been further developed and their functionality expanded since their production start in the year 2001.

This handbook describes software version 3.05. Listed below is an overview of the new features with respect to software version 1.

New features in software version 2

In addition to the old device types, type 1 and type 2 of version 1, the device types of version 2 support type 1 to type 4 of the AS-Interface safety monitor:

<table>
<thead>
<tr>
<th>Number of output circuits</th>
<th>Function range</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&quot;Basic&quot;</td>
</tr>
<tr>
<td>1</td>
<td>Type 1</td>
</tr>
<tr>
<td>2</td>
<td>Type 2</td>
</tr>
</tbody>
</table>

The "Basic" and "Enhanced" function ranges differ as follows:

<table>
<thead>
<tr>
<th>Function range</th>
<th>&quot;Basic&quot;</th>
<th>&quot;Enhanced&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of functional devices at logic level</td>
<td>32</td>
<td>48</td>
</tr>
<tr>
<td>OR gates (inputs)</td>
<td>2</td>
<td>6</td>
</tr>
<tr>
<td>AND gates (inputs)</td>
<td>no</td>
<td>6</td>
</tr>
<tr>
<td>Safe time function, switch-on and switch-off delay</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Function &quot;button&quot;</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Safety guard/module with debouncing</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Safety guard with lock</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Deactivation of functional devices</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Reset of error condition</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Diagnosis stop</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Support of A/B technology for non-safe slaves</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>New functional devices (flip-flop, pulse on pos. edge, etc.)</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Dummy device (NOP)</td>
<td>no</td>
<td>yes</td>
</tr>
</tbody>
</table>
New features in software version 2.1

Version 2.1 of the ASIMON configuration software includes the following new features:

- New monitoring device zero sequence detection
- Expansion of the output device door lock by means of delay time:
  now optionally available with stop category 1 for the first OSSD
- Expansion of the output device door lock by means of zero-speed relay and delay time:
  now optionally available with stop category 1 for the first OSSD
- New start device activation via standard slave (level-sensitive)
- New start device activation via monitor input (level-sensitive)
- New monitoring device operational switching by means of monitor input
- Expansion of monitoring device double channel dependent with debouncing for local
  acknowledgement and startup test
- Expansion of monitoring device double channel independent for local acknowledgement
  and startup test
- Incremental teaching of the code sequences
- Device index assignment
- Display of inverted icon when standard slave is inverted
- Number of simulated slaves can be selected
- Signalling of relay outputs and message outputs via the AS-Interface

Notice
The new functions of software version 2.1 can only be used in combination with AS-Interface
safety monitors of version 2.12 and higher.

New features in software version 3.0

In addition to the previous device types type 1 … type 4, also supported are two new device
 types of version 3 (type 5 and type 6) of the AS-Interface safety monitor with safe AS-i output:

Table 1-3 Features of device versions

<table>
<thead>
<tr>
<th>Number of output circuits</th>
<th>Function range &quot;Enhanced&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Output circuit 1</td>
</tr>
<tr>
<td>Type 5</td>
<td>Relay</td>
</tr>
<tr>
<td>Type 6</td>
<td>Relay</td>
</tr>
</tbody>
</table>
Version 3.0 of the ASIMON configuration software includes the following new features:

- Support of safe AS-Interface transmission for controlling safe AS-Interface actuators
- Coupling of multiple safe AS-i networks through the function of the safety monitor as a safe input slave (only for new device types with safe AS-i output)
- Multi-window technology with graphical printout of the configuration for each window
- Circuit diagram display of the logical links from left to right
- Extension of the device library and restructuring of the monitoring devices
- New monitoring device: 2-channel dependent with filtering
- Definition of user-specific functional devices
- Manual input of code sequences
- Availability of the standard out bits of the safe slaves for operational switching tasks (acknowledgements, validations, unlocking, etc.)

Notice
The new functions of software version 3.0 can only be used in combination with AS-Interface safety monitors of version 3.0 and higher.

Compatibility
With version 3.0 of the ASIMON configuration software, old configurations from version 1 and version 2 can be opened, edited and saved.

Note
ASIMON configuration files have the extension *.ASI (version 1 AS-Interface safety monitors), *.AS2 (version 2 AS-Interface safety monitors) or *.AS3 (version 3 AS-Interface safety monitors).

New features beginning with version 3.08 of the operating software
Beginning with version 3.08 of the operating software for the AS-interface safety monitor, the "double channel dependent with debouncing" monitoring device is replaced within the device by the "double channel dependent with filtering" monitoring device.

Note
Device versions of operating software 3.08 are backwards compatible with device versions of operating software 1.1, 2.0, 2.1 and 3.0.
New features in software version 3.10

Version 3.05 of the asimon configuration software dof the AS-i safety monitor includes the following new features:

• Diagnostics device for safety-oriented AS-i output slaves (actuator diagnostics)
• Transmission of diagnostic information of the safety-oriented AS-i actuator through the AS-i safety monitor as a display in the asimon configuration software
• Transmission of diagnostic information of the safety-oriented AS-i actuator via the AS-interface for evaluation in the superior control (PLC)
• External device monitoring circuit module External device monitoring circuit for safe output slave with Activate operational switching selection for the safety-oriented AS-interface actuator

Note
The new functions of software version 3.05 can only be used in combination with AS-i safety monitors with operating software version 3.10 and higher.

1.3 Explanation of symbols

The symbols used in this manual are explained below.

Note
This symbol indicates text which contains important information.
1.4 Definition of terms

Output switching element (safety output) of the AS-Interface safety monitor
Element activated by the logic of the monitor which is able to safely switch off the downstream control elements. The output switching element may switch to or remain in the ON state only when all components are functioning as intended.

Output circuit
Consists of the two logically connected output switching elements.

OSSD
The safe AS-Interface components and functional devices assigned to an output circuit of the AS-Interface safety monitor. They are responsible for releasing the machine element which generates the hazardous movement.

Integrated slave
Component with which sensor and/or actuator functions are grouped together with the slave into a unit.

Configuration operation
Operating state of the safety monitor in which the configuration is loaded and checked.

Master
Component for data transmission which controls the logical and temporal behaviour on the AS-Interface line.

Protective operation
Operating state of the safety monitor in which the sensors are monitored and the output switching elements are switched.

Safety output
See output switching element.

Safe output slave
Slave to which the safe ON or OFF state is transferred by the safety monitor and which controls a safe actuator for switching off or shutting down while under voltage.

Safe input slave
Slave which reads in the safe ON or OFF state of the connected sensor or command device and transmits it to the master or safety monitor.

Safe slave
Slave for connecting safe sensors, actuators and other devices.

Safety monitor
Component which monitors the safe slaves and the correct function of the network.
Slave

Component for data transmission; the master cyclically addresses this component by its address. Only then does it generate an answer.

Standard slave

Slave for connecting non-safe sensors, actuators and other devices.

Synchronisation time

The maximum permissible temporal offset between the occurrence of two events which are dependent on one another.

ON state

Switched on, logical "1", TRUE. This state means that the device has agreed to validate the circuit, i.e. to activate the safe switching outputs. Depending on the device type, various conditions must first be met.

OFF state

Switched off, logical "0", FALSE. This state means that the device has not agreed to validate the circuit, i.e. it results in the switching off of the safe switching outputs.

1.5 Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AOPD</td>
<td>Active Optoelectronic Protective Device</td>
</tr>
<tr>
<td>AS-interface</td>
<td>Actuator Sensor Interface</td>
</tr>
<tr>
<td>EDM</td>
<td>External Device Monitoring</td>
</tr>
<tr>
<td>OSSD</td>
<td>Output Signal Switching Device</td>
</tr>
<tr>
<td>PLC</td>
<td>Programmable Logic Control</td>
</tr>
</tbody>
</table>
2 Installation of hardware and software

2.1 Hardware

2.1.1 Prerequisites

To configure the AS-Interface safety monitor via a PC, you will need:

- an AS-Interface safety monitor type 1 … type 6
- the interface cable for connecting the PC and AS-Interface safety monitor
- a PC or a laptop with the following minimum requirements:
  - an Intel® processor at Pentium® level (or compatible models, e.g. AMD® or Cyrix®)
  - a CD-ROM drive for installing from CD-ROM
  - a mouse (recommended)
  - a free RS 232 (serial) interface with 9-pin Sub-D connection

Notice
When using a USB-RS 232 interface converter or a serial interface card, communication problems may occur with the safety monitor.

2.1.2 Connection between the AS-Interface safety monitor and the PC

Note
The connection of the AS-Interface safety monitor to the PC is described here only briefly. Detailed information can be found in the operating manual for the AS-Interface safety monitor.

To configure the AS-Interface safety monitor with ASIMON, you must connect your PC and the AS-Interface safety monitor using the serial interface cable (available as accessory).

Caution
Use only the interface cable which is available as an accessory. The use of a different cable may lead to data loss or damage to the connected AS-Interface safety monitor!
To connect, plug the interface cable end with the RJ45 connector into the 'CONFIG' socket on the front of the AS-Interface safety monitor and the other end with the 9-pin Sub-D socket connector to a free COM port (serial RS232 interface) on your PC.

**Notice**
If the connection between the AS-Interface safety monitor and the PC is already established when the PC is started, the mouse cursor may move erratically about the screen.

**Remedy:**
• When starting the PC, unplug the connection cable between the PC and the safety monitor.
• Change the start behaviour of the PC (see user documentation for the PC or that of the operating system manufacturer).

### 2.2 Software

#### 2.2.1 System requirements
The following system requirements are necessary for the AS-Interface safety monitor configuration software:
- at least 32 MB free main memory (RAM)
- at least 32 MB free hard disk memory
- Microsoft® Windows 95/98/ME/NT/2000/XP/Vista®/7 as operating system

#### 2.2.2 Installation
To install the configuration software, you need the installation CD-ROM.

Upon execution of the setup program `setup.exe` on the installation CD-ROM, a self-explanatory installation routine is started. After the installation, the program is ready to be started.

With an update installation, the setup program checks whether ASIMON version 2.x is already installed on the PC. If a previous installation is detected, the setup program offers the option of replacing the existing installation with version 3.0 or, as an alternative, creating a second subfolder.

**Note**
General notice for installing with Windows 7:
Please make sure you execute the installation file as an administrator. To do this, right click on the 'setup.exe' and select the "Run as administrator" option. This must also be done when you already have administration rights for your user account.
3 First steps

3.1 Launching the program

To start the configuration software for the AS-Interface safety monitor, select from the Start menu the ASIMON item, which is located in the program folder you specified during installation.

After the program has started, the window with the ASIMON configuration software user interface appears on the screen. When the program is started, the Start Assistant is called up to guide you through the first steps following program startup.

Note

Connect the interface cable to the PC and the safety monitor as described in chapter 2.1.2. Switch on the power supply for the safety monitor before starting the configuration software. Data transmission is otherwise not possible.

However, even if the safety monitor is not connected to the PC, you may still define device configurations and save them on your PC or edit a previously stored configuration.

Figure 3-1 User interface of the ASIMON configuration software after starting the software

1 Start Assistant window
2 Menu bar
3 Toolbar
4 Status/Info bar
Start Assistant

**Note**
In order to query the diagnostic information, the connected AS-Interface safety monitor must be in protective operation.

If a connection to the AS-Interface safety monitor cannot be established on program startup (no AS-Interface safety monitor connected, connected to wrong interface etc.) or if the connected AS-Interface safety monitor is in configuration operation, the **Diagnostics** option is deactivated.

In this case, it is only possible to create a new configuration, load and edit a configuration which has been stored on a data carrier or to search for errors (see chapter 6.2 "Troubleshooting and error rectification").

**Option Diagnostics**

When you select the **Diagnostics** option, first a window opens with the following query. By clicking **Neutral**, the diagnostic information of the connected AS-Interface safety monitor is queried, even if no configuration is loaded in **ASIMON**.

**Note**
Querying the diagnostic information of an unknown configuration can take several minutes, as the configuration of the connected AS-Interface safety monitor must be reconstructed in **ASIMON**. In this way you can load an unknown configuration without needing to exit protective operation.

---

Figure 3-2 Query with the **Diagnostics** option

Next, the Diagnostics window opens (see chapter 6.1 "Diagnostics").
Option **New configuration**

With the **New configuration** option, you can create a completely new configuration for the AS-Interface safety monitor. First, you must enter the base data for the new configuration in the **Information about monitor and bus** window. This window is displayed automatically.

**Note**

The **Information about monitor and bus** window can be called up at any time. To do this, on the **Edit** menu, select the **Information about monitor and bus...** menu item or click the `Info` button.

**Note**

If a valid configuration has been loaded to or from an AS-Interface safety monitor, the time at which the current configuration in the program was transmitted to the AS-Interface safety monitor is shown in the **Download time** window area.

In the **Information monitor** tab, you must enter a title for the configuration, select the operating mode, specify whether a safe AS-i output exists and specify the "Basic" or "Enhanced" function range of the AS-Interface safety monitor.

![Information about monitor and bus window, Information monitor tab](image)

**Configuration title**

In this field, enter a title for the new configuration. The title may contain up to 63 characters.
### Operating mode

You can select from three operating modes:

- **one OSSD**
  for AS-Interface safety monitors of type 1 or type 3 with 1 OSSD (1 redundant safe relay output)

- **two independent OSSDs**
  for AS-Interface safety monitors of type 2 or type 4 with 2 independently functioning OSSDs (2 redundant safe relay outputs)
  Select this operating mode when you would like to configure two completely independent shutdown modes.

- **two dependent OSSDs**
  for AS-Interface safety monitors of type 2 or type 4 with 2 OSSDs (2 redundant safe relay outputs) in which the second OSSD is dependent on the first (see chapter 4.3.5 "Output devices").
  Special switch-off functions are available in this operating mode.

### Note

Prior to a subsequent change of operating mode, determine whether this operating mode is compatible with the AS-Interface safety monitor type which you are using (see table 3-1).

### AS-i output

Here, you specify whether the AS-Interface safety monitor which is to be configured has a safe AS-i output and whether it is linked to a safe AS-i input. Furthermore, you also specify here whether a safe actuator is connected or whether the AS-Interface safety monitor functions as a safe input slave in a coupled AS-Interface network. In this case, you must specify the AS-Interface address of the actuator or assign the safe input slave an AS-Interface address.

### Function range

Here, enter the function range of the AS-Interface safety monitor which is to be configured. The following table shows how the six device types of the AS-Interface safety monitor differ from one another:

<table>
<thead>
<tr>
<th>Number of output circuits</th>
<th>Function range</th>
<th>Type</th>
<th>Output circuit 1</th>
<th>Output circuit 2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&quot;Basic&quot;</td>
<td>&quot;Enhanced&quot;</td>
<td>Output circuit 1</td>
<td>Output circuit 2</td>
</tr>
<tr>
<td>1 Type 1 Type 3 Type 2</td>
<td>Relay</td>
<td>Relay</td>
<td>Relay</td>
<td>AS-i output</td>
</tr>
<tr>
<td></td>
<td>Relay</td>
<td>AS-i output</td>
<td>Relay</td>
<td>Relay + AS-i output</td>
</tr>
<tr>
<td>2 Type 6</td>
<td>Relay</td>
<td>Relay</td>
<td>Relay</td>
<td>Relay + AS-i output</td>
</tr>
</tbody>
</table>
On the **Information bus** tab, you must enter the AS-Interface bus addresses of the used standard slave and the safety-oriented AS-Interface slaves which are present in this AS-Interface network.

![Information about monitor and bus window](image)

**Figure 3-4** **Information about monitor and bus** window, **Information bus** tab

**Notice**

If you would like to operate two or more AS-Interface safety monitors on the same AS-Interface bus, you must enter for all AS-Interface safety monitors all safe slaves on this AS-Interface bus in the Information bus tab even when they are not monitored by the given AS-Interface safety monitor.

With the **Find** button, you can also search the AS-Interface bus for slaves when the AS-Interface safety monitor is in configuration operation.

**Note**

The AS-Interface slaves found when searching the AS-Interface bus are first all listed in the **Information bus** tab as standard. You must then manually assign each as safe/standard!

If you clicked the **Simulate slaves** checkbox on the **Diagnosis / Service** tab, two or four bus addresses are automatically assigned for the simulated slaves and the corresponding checkbox deactivated. In order to be able to activate **Simulate slaves**, the one or three addresses which follow the monitor address must be free.
3.1 Launching the program

On the **Diagnosis / Service** tab, you can make service settings for Diagnosis stop and for Reset of error condition as well as configure the diagnostics via the AS-Interface bus.

![Information about monitor and bus window, Diagnosis / Service tab](image)

**Figure 3-5**  Information about monitor and bus window, Diagnosis / Service tab

**Service settings, Diagnosis stop sub-tab**

![Diagnosis stop sub-tab of the Diagnosis / Service tab](image)

**Figure 3-6**  Diagnosis stop sub-tab of the Diagnosis / Service tab

The Diagnosis stop function is activated by clicking the **Activate:** checkbox. This function is used when a stop condition is fulfilled (specified AS-Interface standard/A/B slave is in the ON state) to keep the devices in a ready state (diagnostics LED yellow, waiting for confirmation). This does not occur with activated local acknowledgement. The diagnosis stop is level-sensitive and is deactivated if the specified standard/A/B slave has no bus communication.

This function is very useful, for example, for detecting during very brief switch-off actions which device, and, thus, which safe input slave caused the switch-off.

**Note**

For additional information on calling up diagnostic information see chapter “Diagnostics and error handling” and chapter “Diagnostics via AS-Interface”.
Service settings, **Reset of error condition** sub-tab

By selecting the **Activate:** checkbox, the global reset of error conditions via one of the standard/A/B slaves connected to the AS-Interface bus is activated.

If a device detects an error, the AS-Interface safety monitor enters the error state. The error state is locked (error lock). With versions of the AS-Interface safety monitor before 2.0, the error state can be rectified only by resetting the AS-Interface communication or by resetting the AS-Interface safety monitor by switching off and then switching back on the AS-Interface safety monitor or by pressing the Service button on the AS-Interface safety monitor.

As of version 2.0 of the AS-Interface safety monitor, it is possible to differentiate the reset of error conditions (Reset). Reset of error condition can be activated by an AS-Interface standard/A/B slave, e.g. a button, and acts only on a device level. Thus, the complete safety monitor is not reset, but rather only the device locked in the error. For a safety monitor with two independent OSSDs, therefore, only that OSSD is reset in which the device locked in the error is configured.

**AS-Interface diagnosis**

**Monitor base address**

You can assign an AS-Interface bus address for the AS-Interface safety monitor. In this case, it is possible to query diagnostic information about the AS-Interface bus from your AS-Interface master (e.g. the PLC). If you do not assign an AS-Interface bus address, the AS-Interface safety monitor functions strictly as a "listener", i.e. only as a monitor on the bus. It is not possible to communicate with the safety monitor via AS-Interface in this case.

For assigned monitor base addresses, you can set under Data selection whether the diagnostic data are to be output via AS-Interface sorted by OSSD or are to be left unsorted (all devices) (see chapter 7).

**Note**

When performing diagnostics via the AS-i, the PLC is informed of the indices of the devices which are switched off. Previously, if a device was added to or deleted from the configuration, all subsequent indices were shifted. As a result, it was necessary for the user to modify the diagnostics program in the PLC.

In the **Edit** menu of **ASIMON** version 2.1, you can now use the **Device index assignment** menu item to freely assign the diagnosis indices to the devices for AS-Interface diagnostics (see chapter 7.2 "Assignment of the AS-Interface diagnosis indices").
Simulate slaves

If less than four safe or unsafe AS-Interface slaves are connected to the AS-Interface bus, you must set Simulate slaves to zero in order for the AS-Interface safety monitor to function correctly.

The number of simulated slaves can be 1 (for large AS-Interface networks) or 3 (for small AS-Interface networks).

**Note**

If Simulate slaves is set unequal to zero, either 1 or 3 additional AS-Interface slaves are simulated internally. These slaves are automatically assigned the first or first three bus address(es), respectively, which follow on the AS-Interface safety monitor.

If the Simulate slaves function is activated (number of simulated slaves: 1 or 3), the state of the relay- and message outputs can be queried by the AS-Interface master (PLC) via the AS-Interface at monitor base address+1, data bits D3 ... D0. Bit state 0 identifies an inactive output, bit state 1 an active output, corresponding to the substitute value in the process image of the AS-Interface master.

<table>
<thead>
<tr>
<th>Data bit</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>D0</td>
<td>State of relay output 1</td>
</tr>
<tr>
<td>D1</td>
<td>State of message output 1</td>
</tr>
<tr>
<td>D2</td>
<td>State of relay output 2</td>
</tr>
<tr>
<td>D3</td>
<td>State of message output 2</td>
</tr>
</tbody>
</table>

According to this, the AS-Interface safety monitor occupies a different number of bus addresses in the AS-Interface network:

<table>
<thead>
<tr>
<th>Number of occupied bus addresses</th>
<th>Meaning</th>
</tr>
</thead>
</table>
| 0                                | No bus address was assigned to the AS-Interface safety monitor. No communi-
                                    | cation and, thus, no diagnostics possible via AS-Interface with the safety moni-
                                    | tor.                                                                     |
| 1                                | One bus address was assigned to the AS-Interface safety monitor. Diagnostics |
                                    | possible via AS-Interface with the safety monitor. Number of simulated slaves |
                                    | equal to 0.                                                              |
| 2                                | One bus address was assigned to the AS-Interface safety monitor. Diagnostics |
                                    | possible via AS-Interface with the safety monitor. Number of simulated slaves |
                                    | equal to 1. State of relay- and message outputs can be accessed via AS-
                                    | Interface at monitor base address+1 (monitor version 2.12 and higher).     |
| 4                                | One bus address was assigned to the AS-Interface safety monitor. Diagnostics |
                                    | possible via AS-Interface with the safety monitor. Number of simulated slaves |
                                    | equal to 3. State of relay- and message outputs can be accessed via AS-
                                    | Interface at monitor base address+1 (monitor version 2.12 and higher).     |
Option **Open configuration**

With the Open configuration option, you can open an existing configuration file (*.asi) which was previously stored on a data carrier for purposes of editing or transmitting to an AS-Interface safety monitor.

![Opening a stored configuration file](image)

**Figure 3-8 Opening a stored configuration file**

**Note**


**Option Load configuration from AS-Interface safety monitor**

**Note**

If a connection to the AS-Interface safety monitor cannot be established on program startup (no AS-Interface safety monitor connected, connected to wrong interface etc.) or if the connected AS-Interface safety monitor is in protective operation, the Load configuration from AS-Interface safety monitor option is deactivated. In this case, it is only possible to create a new configuration, load and edit a configuration which has been stored on a data carrier or to search for errors (see chapter 6.2 "Troubleshooting and error rectification").

When you select the Load configuration from AS-Interface safety monitor option, the configuration of the connected AS-Interface safety monitor is queried and displayed in the main program window.

**Checkbox Show dialog on startup**

When this checkbox is activated, the Start Assistant is called up each time the ASIMON program is started. If you do not wish to use this program feature, simply deactivate this checkbox and the Start Assistant will no longer automatically be opened on program startup.

On the Extras menu under Use Start Assistant, you can reactivate or deactivate the automatic call of the Start Assistant on program startup at any time.
3.2 Description of the user interface

3.2.1 The menu bar

Menu overview

![Menu overview](image)

Figure 3-9 Menu overview 1
Note
Depending on the program state, particularly when no connection to an AS-Interface safety monitor exists, not all menu commands are available.
3.2 Description of the user interface

3.2.2 The toolbar

As in other Windows® programs, you can use the buttons located in the toolbar to directly execute important functions without accessing the menu.

![Toolbar Diagram]

- **Menu command**
  - Monitor → Start/Stop
  - Monitor → Diagnostics
  - Device index assignment
  - Display options…
  - Check configuration
  - Information about monitor and bus…
  - File → Printer setup…
  - File → Print
  - File → Save as…
  - File → Save
  - File → Open…
  - File → New

- **Menu command**
  - Help → About…
  - Help → Help topics…
  - Reduce (zoom out)
  - Enlarge (zoom in)
  - Windows tiled vertically
  - Windows tiled horizontally
  - Cascading windows
  - New window
  - Redo
  - Undo

Figure 3-11 Toolbar
### 3.2.3 The status/info bar

The status/info bar provides valuable information regarding program operation and alerts you of problems and errors during program execution.

<table>
<thead>
<tr>
<th>Left side:</th>
<th>Centre:</th>
<th>Right side:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help information</td>
<td>Monitor version (in configuration operation)</td>
<td>Status and error information</td>
</tr>
<tr>
<td>Printer setup</td>
<td>CV 03.00E</td>
<td>The safety monitor is running in configuration operation</td>
</tr>
</tbody>
</table>

The information on the monitor version in the centre has the following meaning:

- **CV** - Configuration Validated
- **03.00E** - safety monitor version
- **03** - number of safety outputs (00 = type1/type3, 01 = type2/type4, 02 = type5, 03 = type6)
- **25** - UART version
- **00** - free
- **90C4** - 4-digit code

Click the status/info bar in configuration operation to open a window with status information on the connected AS-Interface safety monitor.

![Monitor status window](image)

Figure 3-12 Status/info bar

Figure 3-13 Monitor status window
3.2.4 The work area

The configuration of an AS-Interface safety monitor with the ASIMON software is performed graphically and interactively. Using a library of icons representing devices (left window, docked), you can select the safe AS-Interface slaves which are to be monitored as well as other functional devices and assemble a configuration with them.

The configuration (or parts thereof) are represented in a circuit diagram display as logically linked devices from left to right in the windows.

![Work area with windows](image)

**Note**

You can switch between the new circuit diagram display (beginning with software version 3) and the old tree structure display.

To do this, select the **Extras -> Display options** menu item or press `<Ctrl> + <S>` or `<Ctrl> + <T>`.

The sizes of the individual windows can be adjusted to meet your needs as in other Windows® programs.
Window

The work area may contain any number of windows. The functions in the **Window menu** are available for arranging the windows.

As in the past, a device is inserted from the icon library using drag&drop. All windows are initially equal. A window becomes an OSSD window by inserting an output device. If all OSSDs are defined by a separate configuration window, no further output devices can be inserted in other windows.

In addition to the OSSD windows, which contain the actual configuration for an AS-Interface safety monitor, you can use other windows to form substructures (sub-devices) and create user devices.

**Note**

The **Preprocessing** window area familiar from previous software versions no longer exists.

For AS-Interface safety monitors of types 1 and 2 with "Basic" function range, the only possible logic device available for the linking of **two** monitoring or system devices is the logic OR function.

In the **1st OSSD** and **2nd OSSD** windows, the monitoring devices (safe AS-Interface slaves), start devices, external device monitoring devices, system devices, logic devices and output devices are grouped into the desired configuration and linked to one another using the logical AND function. Very complex functions can be created in this way.

**Note**

The view in the window is updated by pressing the `<F5>` key; i.e. the window contents are redrawn on the screen.

Operation

To paste devices from the icon library into the other windows, as well as to edit, delete, move and copy devices between the windows, various options are available depending on your personal preference:

- **With the mouse:**
  - by **drag&drop** from the icon library:
    - click device with the left mouse button, keep mouse button pressed, and move the device. Simultaneously press the `<Ctrl>` key for further options:
    - If devices are pulled from the selection list to a window with the mouse, the device is automatically inserted. If the `<Ctrl>` key is pressed before the mouse button is released, the selected device replaces the device previously present at this position.

- **using the right mouse button:**
  - click device with right mouse button and select action from the pop-up menu. If necessary, change to another window area, click the right mouse button again and select action.

- **using menu commands:**
  - click device with the left mouse button, on the **Edit** menu select one of the commands **Deactivate**, **Invert**, **Delete**, **Select**, **Paste**, **Move**, **Assign** or **Replace**. If necessary, change to another window area, click OSSD, Preprocessing, device or position and again click a command on the **Edit** menu.
• With the keyboard:
  - with the <Tab> key: change window areas.
  - with the arrow keys: select circuit, device or position.
  - execute actions using the following keyboard commands:

  
<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Ctrl&gt; + &lt;D&gt;</td>
<td>Activate/Deactivate</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;I&gt;</td>
<td>Invert</td>
</tr>
<tr>
<td>&lt;Delete&gt;</td>
<td>Delete</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;C&gt;</td>
<td>Select</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;V&gt;</td>
<td>Paste</td>
</tr>
<tr>
<td>&lt;Shift&gt; + &lt;Ctrl&gt; + &lt;V&gt;</td>
<td>Move</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;A&gt;</td>
<td>Assign</td>
</tr>
<tr>
<td>&lt;Ctrl&gt; + &lt;R&gt;</td>
<td>Replace</td>
</tr>
</tbody>
</table>

In addition to the devices themselves, you can also change the connection lines of the devices (and thus the device assignment).

1
2
3

Click the output of a device with the left mouse button and hold down. Pull the connection line ("rubber band") to the input on the desired device and release the left mouse button.

Device is assigned to the link

Figure 3-15 Device assignment by creating/moving connection lines

Note

If a monitoring device from an OSSD is to be assigned to a link in a new (non-OSSD window), the link must first be created. After creating the link, select the monitoring device in the OSSD (<Ctrl> + <C>) and assign it to the logic device in the new window (click the logic device and press <Ctrl> + <A>).


Display options…

You can set with which informational content the devices are to be displayed in the windows and the size in which the windows are printed out as graphics. To do this, on the Extras menu, select the Display options… menu item or click the button.

Figure 3-16  Display options - Display

In addition, you can globally set the type of configuration display for all windows here:

- new circuit diagram display (beginning with software version 3) -> tick in Circuit diagram display.
- old tree structure display -> no tick in Circuit diagram display.

Figure 3-17  Example: Old tree structure display

The Horizontal raster and Vertical raster values determine the distances between the individual devices in the circuit diagram display. By setting the tick for Standard setting, the default values (h:100, v:50) for the device raster are restored.
First steps

3.2 Description of the user interface

You can specify the scaling for printing the active window as a graphic on the **Printer** tab.

![Display options - Printer](image)

Figure 3-18 Display options - Printer
3.3 Program settings

3.3.1 Setting the program language

The user interface of the ASIMON configuration software supports the following languages:

- German
- Spanish
- Swedish
- English
- Italian
- French
- Japanese

To change the language of the user interface, select on the Extras menu under the Language menu item the desired language. The program does not need to be restarted after changing the language.

![Setting the program language](image.png)

Figure 3-19 Setting the program language

Note

The Japanese characters can be displayed only if the operating system supports such characters.
3.3 Program settings

3.3.2 Selecting the serial interface

When starting the program, ASIMON asks if and at which PC serial interface (COM-port) an AS-Interface safety monitor is connected. If the connection between the PC and safety monitor is established only after the ASIMON software has been started, you must manually select the correct COM port in the program. Otherwise, no connection can be established to the AS-Interface safety monitor.

The transmission parameters for serial communication with the AS-Interface safety monitor are automatically set by ASIMON.

![Figure 3-20 Selecting the serial interface](image)

Notice

When using a USB-RS 232 interface converter or a serial interface card, the intermediate buffering of data may cause communication problems with the safety monitor.
Configuring the AS-Interface safety monitor

The AS-Interface safety monitor is a universally usable protective device and can, therefore, be configured for a very wide range of applications.

4.1 Function of the AS-Interface safety monitor

The functional task of the AS-Interface safety monitor is to continuously specify the state(s) of the OSSD(s) in accordance with the configuration specified by the user based on the states of the configured devices and to activate or deactivate the assigned safe switching outputs or safe actuators.

The ASIMON software automatically arranges the devices in the respective windows during configuration.

Each device can take on two states:

**ON state** (switched on, logical "1")

This state means that the device has agreed to validate the circuit, i.e. to activate the safe switching outputs. Depending on the device type, various conditions must first be met.

**OFF state** (switched off, logical "0")

This state means that the device has not agreed to validate the circuit, i.e. it results in the switching off of the safe switching outputs.

In the first step of the evaluation, the states of all monitoring, logic and EDM devices are linked to one another by means of a global logic AND function, i.e. only when all configured monitoring, logic and EDM devices have the ON state is the result of the AND function equal to ON.

In principle, the device states are evaluated in the same way as in an electrical safety circuit in which all safety switch elements are connected in series and validation is possible only when all contacts are closed.

In the second step, the start devices which determine the startup behaviour of the OSSD are evaluated. A start device enters the ON state when the result of the global AND function from the first step of the evaluation is equal to ON and when the respective start condition is fulfilled. With regard to the start condition, the start devices have a lock. The start condition must therefore only be fulfilled once. A start device is reset (OFF state) when the result of the global AND function from the first step of the evaluation returns the OFF state. The states of the start devices used are linked to one another with an OR function, i.e. only one of the start devices needs to be in the ON state in order for the internal validation of the circuit to occur.
In the third step, the output device is then analysed. If the circuit has been internally validated (result of the OR function from the second step of the evaluation is equal to ON), the output device switches the message and safe switching outputs of the OSSD in accordance with its function characteristics and time behaviour, i.e. the relays trip and the switching contacts close or the safe AS-Interface output is set.

![Diagram of the AS-Interface safety monitor configuration process]

Figure 4-1 Order of events during the evaluation of the configured devices
4.2 General procedure

The process is identical for all device variants of the AS-Interface safety monitor (1 or 2 OSSDs, "Basic" or "Enhanced" function range, with or without safe AS-Interface output).

Step 1 - Information about monitor and bus

In order to create a new configuration, you must first make the required entries in the Information about monitor and bus window for the AS-Interface safety monitor and the slaves which are to be monitored (see "Start Assistant" on page 18):

- Assign the configuration title
- Specify operating mode of the AS-Interface safety monitor
  - One OSSD
  - Two independent OSSDs
  - Two dependent OSSDs
- Specify safe AS-i output if necessary
  - Linked to AS-i input
  - Control of a safe actuator or safe input slave in the coupled AS-i network
- Specify function range of the AS-Interface safety monitor
  - "Basic" or "Enhanced" function range
- Enter the AS-Interface bus addresses of the safe and unsafe AS-Interface slaves which are to be monitored
- If necessary, activate diagnosis stop via Standard slave
- If necessary, activate reset of error condition via Standard slave
- Activate diagnostics via AS-Interface
  - Enter the AS-Interface bus address of the AS-Interface safety monitor
  - Selection of the diagnostic data: sorted by OSSD or by all devices
  - If necessary, activate the option 1 or 3 Simulate slaves

Step 2 - Create configuration

You can now assemble a new configuration with the required devices from the icon library. See “Creating and changing a configuration” on page 40. In addition, in ASIMON version 2.1, you can freely assign the devices diagnosis indices for the AS-Interface diagnostics. See “Assignment of the AS-Interface diagnosis indices” on page 171.

Step 3 - Commissioning

After you have created a valid configuration, you can commission the AS-Interface safety monitor. The commissioning procedure is described in chapter 5.
4.3 Creating and changing a configuration

A valid configuration for the AS-Interface safety monitor must consist of the following devices for each independent OSSD:

- at least 1 monitoring device
- at least 1 start device (with two dependent output groups, only for OSSD 1)
- exactly 1 output device (with two dependent output groups, only for OSSD 1)

The maximum number of devices is dependent on the function range of the AS-Interface safety monitor type:

- function range "Basic": maximum 32 devices (device index 32 … 63).
- function range "Enhanced": maximum 48 devices (device index 32 … 79).

Procedure

Select a device from the icon library and insert it into the window of the desired OSSD (see "Operation" on page 31).

Note

Detailed information about which devices can be used with which configurations can be found in the description of the individual devices.

When you insert the device into a window, the input mask for the device first opens. Here, you can make all required entries for this device.

This includes information such as:

- designation (name) of the device within your application, e.g. "Lock gate1"
- type, e.g. "double channel forced"
- AS-Interface bus address
- additional device options which can be activated
- monitoring and delay times

After confirming your entries with the OK button, the device appears in the window of the respective OSSD.

Note

The view in the window is updated by pressing the <F5> key; i.e. the window contents are redrawn on the screen.
Example:

<table>
<thead>
<tr>
<th>Device designation in quotation marks</th>
<th>Device symbol</th>
<th>Device index for the device</th>
<th>AS-Interface address of the assigned slave</th>
<th>Name of the device</th>
</tr>
</thead>
</table>

![Figure 4-2 Graphic depiction of the devices](image)

In addition to icon, designation and name, the respective device index for each device is specified. The index, which is automatically assigned by ASIMON for each configured device, uniquely identifies each device, regardless of whether it has been configured for the first or second OSSD.

The index begins with 32 and increases incrementally by 1. Within the configuration log, each configured device can be uniquely identified using the index.

**Note**

The display of the devices can be modified.

To do this, on the **Extras** menu select the **Display options…** menu item or click the button (see chapter 3.2.4 "The work area").

**Note**

When performing diagnostics via the AS-i, the PLC is informed of the indices of the devices which are switched off. Previously, if a device was added to or deleted from the configuration, all subsequent indices were shifted. As a result, it was necessary for the user to modify the diagnostics program in the PLC.

In the **Edit** menu of ASIMON version 2.1, you can now use the **Device index assignment** menu item to freely assign diagnosis indices to the devices for AS-Interface diagnostics (see chapter 7). When making the assignments, you can specify whether the diagnosis index range is 0 … 47 or analogous to the device indices 32 … 79.
**ASIMON** automatically organises all devices of a configuration with respect to the device indices in the following order:

1. Monitoring and logic devices in any order
2. External device monitoring (EDM) devices (contactor monitoring)
3. Start devices
4. Output device

Upon insertion of a new device, the indices are correspondingly rearranged.

**Note**

A monitoring or logic device configured in the 1st OSSD can also be used in the 2nd OSSD and vice versa.

You can define a device or a logical group of devices as a user device; this user device can then very easily be used multiple times in the OSSDs.

**Example:**

![Diagram](image)

**Figure 4-3** Example: Structure of a configuration

To delete a device from the configuration, mark it with the mouse and then select the **Delete** command from the **Edit** menu or the pop-up menu (right mouse button) or simply press the **<Delete>** key.

To edit a device, double-click its icon to reopen its input mask. Here, you can edit all device parameters. Alternatively, you can use the **Device parameters**... command in the **Edit** menu or the **Edit ...** command in the pop-up menu.
4.3.1 Monitoring devices

The monitoring devices constitute the actual safe switching components of the OSSD(s) in the configuration.

For the safe monitoring devices, a distinction is made depending on type between:

**Double channel, forced components**

Upon actuation of an emergency-off switch with its two redundant contacts, the two contacts open simultaneously. As a result of this construction, both contacts are always either open or closed. If one of the two contacts closes or opens either too early or too late, an error results after a tolerated transition time has passed.

The functional device for double channel, forced components can, thus, be used for applications such as

- emergency shutdown switches
- safety guards
- active optoelectronic protective device
- zero-speed relays

Here, both the direct connection of an integrated AS-Interface slave as well as the connection of a conventional device via a safe coupling module are possible. Local acknowledgement and/or the startup test are available as options.

**Double channel, dependent components**

The monitoring to determine whether a safety guard is open or closed is performed by two protective switches. If this safety guard is opened or closed, the protective switches are not actuated simultaneously. In the double channel dependent functional device, a synchronisation time can, therefore, be specified. Both switches must close within this synchronisation time. If the synchronisation time is exceeded, the start-test state results.

The safety monitor also monitors the switches to ensure that one of the two end positions "both switches open" or "both switches closed" is always achieved.

The functional device for double channel, dependent components can, thus, be used for applications such as

- safety guards with two protective switches
- two-handed operations

Here, both the direct connection of an integrated AS-Interface slave as well as the connection of a conventional device via a safe coupling module are possible. Local acknowledgement and/or the startup test are available as options.
Double channel, dependent components with debouncing

**Note**

These components are only available for the types of the AS-Interface safety monitor with enhanced function range (type 3 … type 6).

The monitoring to determine whether a safety guard is open or closed is performed by two protective switches. If this safety guard is opened or closed, the protective switches are not actuated simultaneously. Moreover, the switches bounce, for example when the guard is closed too fast. In the double channel dependent functional device with debouncing, it is, therefore, also possible to specify a bounce time in addition to the synchronisation time. The bounce time begins when both contacts close the first time. Within the specified bounce time, the switches can change their state freely. After the bounce time has passed, both contacts are again queried. If they are then closed and if the synchronisation time has not yet passed, the validation is performed. The selected synchronisation time must be greater than the bounce time. If the synchronisation time is exceeded, the start-test state results. The safety monitor also monitors the switches to ensure that one of the two end positions "both switches open" or "both switches closed" is always achieved.

The functional device for double channel, dependent components with debouncing can, thus, be used for applications such as

- slow-action switch
- switches with high bounce times

Here, both the direct connection of an integrated AS-Interface slave as well as the connection of a conventional device via a safe coupling module are possible. Local acknowledgement and/or the startup test are available as options.

Double channel, dependent components with filtering

**Note**

These components are only available for the types of the AS-Interface safety monitor with enhanced function range (type 3 … type 6).

The monitoring to determine whether a safety guard is open or closed is performed by two protective switches. If this safety guard is opened or closed, the protective switches are not actuated simultaneously. In addition, guard vibrations may result in short-term, single-channel interruptions. This monitoring device can be used to "filter out" such interference without causing the system to be switched off. The user defines a synchronisation time, a stabilising time and, if necessary, a tolerance time for short-term, single-channel interruptions. When switched on, the protective switch may switch between all possible states (none, one, or both contacts closed) during the synchronisation time.

If both contacts remain open for the duration of the stabilising time, the synchronisation time is restarted when the contacts are again closed. If the protective switch is in an undefined state for the duration of the stabilising time, the functional device switches to the locked error state. Only if both contacts close within the synchronisation time and remain closed for the duration of the stabilising time is the validation performed.

The functional device offers various possibilities for handling short-term, single-channel interruptions. Local acknowledgement and/or the startup test are available as options.
Double channel, conditionally dependent components

Note
These components are only available for the types of the AS-Interface safety monitor with enhanced function range (type 3 and type 4).

The monitoring to determine whether a safety guard is open or closed is performed by a protective switch with lock. One contact is switched by the protective switch, the second by the lock monitor. If the lock is opened, the guard can also be opened. This sequence of events is monitored. It is an error if the protective switch opens first.

Which contact is dependent on which can be freely selected in the double channel conditionally dependent functional device. The dependent contact can be freely opened and closed as long as the independent contact is not opened.

The functional device for double channel, conditionally dependent components can, thus, be used for applications such as:
- door switch with lock

Here, both the direct connection of an integrated AS-Interface slave as well as the connection of a conventional device via a safe coupling module are possible.

Notice
As a result of the permissible, independent actuation, a loss of redundancy is not detected!

Double channel, independent components

The monitoring to determine whether a safety guard is open or closed is performed by a protective switch with lock. One contact is switched by the protective switch, the second by the lock monitor. With this functional device, it is possible to open and close the lock without forcing the guard to open or close.

The functional device for double channel independent components can, thus, be used for applications such as:
- protective switch for door monitoring

Here, both the direct connection of an integrated AS-Interface slave as well as the connection of a conventional device via a safe coupling module are possible. Local acknowledgement and/or the startup test are available as options.

Notice
As a result of the permissible, independent actuation, a loss of redundancy is not detected!
Standard slave

Within an OSSD, it is also possible to use standard AS-Interface slaves in order to realise, by means of their switching signals (inputs or outputs), an exclusively operational switching of the safe switching outputs of the AS-Interface safety monitor in an OSSD.

Notice

The use of a standard slave device for safe switching tasks is not permitted!

Monitor input

Within the OSSDs or preprocessing, the input signals of the 2 or 4 inputs 1.Y1, 1.Y2 and 2.Y1, 2.Y2, respectively, of the AS-Interface safety monitor can also be used to implement strictly operational switching of the safe switching output(s) of the AS-Interface safety monitor in an OSSD.

Notice

The use of a monitor input device for safe switching tasks is not permitted!

Button

The Button device can be integrated within the OSSD or Preprocessing. The Button device makes acknowledgement possible on the device level. As soon as the validation for the device which is linked to the button is present, this device can be validated by actuating the button, i.e. acknowledged.

With the aid of the Device button, it is possible, for example, to assign a common local acknowledgement to multiple light barriers which have been linked together by an AND gate.

NOP

Dummies (NOP - No OPeration) can be used within an (OSSD) window to make the configuration or the graphical display in ASIMON easier to organise or to create a sample configuration to be used as a pattern for different configuration variants. An NOP dummy occupies an index within the configuration. Each functional device can be replaced by an NOP dummy and vice versa.
Zero sequence detection

The zero sequence detection monitoring device can be used to monitor whether both switches of a safe input slave are open. The device switches to the ON state when the value 0000 is continuously transmitted by the safe slave.

Notice

The use of a zero sequence detection device for safe switching tasks is not permitted!

Application icons

The safe monitoring devices generally differ from one another only in type, e.g. double channel dependent. From an application perspective, a device of the same type can be used both as a safety guard as well as for two-handed operation.

Described in the following are the safe monitoring devices organised according to type. In the icon library, you must first select the application icon for the desired device and then select the respective type in the input mask.

To the left of the application icon in the configuration window, the type icon (double channel forced, double channel dependent, double channel independent, etc.) is displayed for all safe monitoring devices in order to clearly represent the configuration with a practical perspective.

The input mask of the application icons offers all device options, even if e.g. a local acknowledgement for a two-handed operation does not make much sense.

Device options

Many monitoring devices also possess, in addition to their safe switching behaviour, options which can be used to realise more complex applications. These include:

Startup test

The startup test is used, for example, when the proper function of a safety guard is to be inspected prior to starting the machine. In this case, the startup test requires that the guard be opened and closed again before the machine is started. Only then can the machine be started.
Local acknowledgement

Local acknowledgement is used, for example, when a safety guard is located in an area not visible from the control desk. With local acknowledgement, acknowledgement (i.e. a confirmation that no persons are present in this part of the machine) can only be performed from the local operating desk.

In terms of the AS-Interface bus, an additional switching signal is linked to the monitoring device. Only if this switching signal was active is the monitoring device validated in the safety monitor. The switching signal for the local acknowledgement can be a standard slave, an A/B slave or the non-safe OUT bits of a safe input slave whose AS-Interface bus address and bit address must be specified.

Note

Certain time conditions apply to the arrival of the signals. These are illustrated using a safety light barrier as an example:

1. Between the release of the safety light barrier and the actuation of the local acknowledgement, at least 50ms must pass.
2. An actuation of the local acknowledgement is evaluated as valid when the switching signal is present for a minimum of 50ms and a maximum of 2s.
3. After the local acknowledgement is released, the monitoring device is validated following a wait period of 50ms.

The available monitoring devices are described individually below.

Note

The functional devices and their variants, e.g. double channel forced safety input with startup test, included in the devices described below can be found in this form in the configuration log of the AS-Interface safety monitor (see chapter 5.8 and examples of the respective monitoring devices).
Double channel forced

Icon

Functional device  Double channel forced safety input

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>double channel forced safety input</td>
</tr>
</tbody>
</table>

### Variants

<table>
<thead>
<tr>
<th></th>
<th>SUBTYPE:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Without startup test</td>
<td>no startup test</td>
</tr>
<tr>
<td>With startup test</td>
<td>startup test</td>
</tr>
<tr>
<td>Without local acknowledgement</td>
<td>no local acknowledge</td>
</tr>
<tr>
<td>With local acknowledgement</td>
<td>local acknowledge</td>
</tr>
<tr>
<td>With local acknowledgement also after startup</td>
<td>local acknowledge always</td>
</tr>
</tbody>
</table>

### Parameter

**Name:** max. 29 ASCII characters plaintext

**Address:** AS-Interface bus address (1 … 31)

**Start-up test:** with / without

**Local acknowledgement:** with / also after startup / without

**Slave type:** standard/A/B slave

**Address:** AS-Interface bus address of the local acknowledgement (1 … 31)

**Bit address:** In-0 … In-3 or Out-0 … Out-3, inverted / not inverted

### Input mask

![Input mask diagram](image-url)
4.3 Creating and changing a configuration

Description
With the **double channel forced** monitoring device, the switching signal of the respective safe AS-Interface slave acts on all four bits of the transmission sequence.

Optionally, a startup test and/or a local acknowledgement are/is possible. Upon activation of the **Also acknowledge after startup** checkbox, local acknowledgement is always mandatory even after switching on the AS-Interface safety monitor or following a communication error (warm start of the AS-Interface safety monitor).

Note
If only one contact opens/closes, after a tolerated transition time of 100ms the device switches to the "Error" state.

Application icons
- Emergency shutdown
- Safety guard
- AOPD - contactless active protective device
- Module - used to connect conventional safe switching elements via a safe AS-Interface module.
- Enabling switch
- Key switch
- Coupling - AS-Interface safety monitor of a coupled network which provides its validation information as a safe input slave for processing to this AS-Interface network (no local acknowledgement possible).
Example: Without startup test + without local acknowledgement

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ASSIGNED</th>
<th>SAFE SLAVE</th>
</tr>
</thead>
<tbody>
<tr>
<td>32</td>
<td>20</td>
<td>0</td>
<td>channel one</td>
<td>5</td>
</tr>
</tbody>
</table>

Example: With startup test + without local acknowledgement

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ASSIGNED</th>
<th>SAFE SLAVE</th>
</tr>
</thead>
<tbody>
<tr>
<td>33</td>
<td>20</td>
<td>7</td>
<td>channel one</td>
<td>5</td>
</tr>
</tbody>
</table>

Example: Without startup test + with local acknowledgement

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ADDRESS</th>
<th>BIT</th>
<th>ASSIGNED</th>
<th>SAFE SLAVE</th>
</tr>
</thead>
<tbody>
<tr>
<td>34</td>
<td>20</td>
<td>4</td>
<td>21</td>
<td>In-0 noninv</td>
<td>channel one</td>
<td>5</td>
</tr>
</tbody>
</table>

Example: Without startup test + with local acknowledgement also after startup

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ADDRESS</th>
<th>BIT</th>
<th>ASSIGNED</th>
<th>SAFE SLAVE</th>
</tr>
</thead>
<tbody>
<tr>
<td>35</td>
<td>20</td>
<td>1</td>
<td>21</td>
<td>In-0 invert</td>
<td>channel one</td>
<td>5</td>
</tr>
</tbody>
</table>

Example: With startup test + with local acknowledgement

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ADDRESS</th>
<th>BIT</th>
<th>ASSIGNED</th>
<th>SAFE SLAVE</th>
</tr>
</thead>
<tbody>
<tr>
<td>36</td>
<td>20</td>
<td>8</td>
<td>21</td>
<td>In-0 noninv</td>
<td>channel one</td>
<td>5</td>
</tr>
</tbody>
</table>
Double channel dependent

Icon

Functional device  Double channel dependent safety input

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>double channel dependent safety input</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Variants</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Without startup test</td>
<td>SUBTYPE: no startup test</td>
</tr>
<tr>
<td>With startup test</td>
<td>SUBTYPE: startup test</td>
</tr>
<tr>
<td>Without local acknowledgement</td>
<td>SUBTYPE: no local acknowledge</td>
</tr>
<tr>
<td>With local acknowledgement</td>
<td>SUBTYPE: local acknowledge</td>
</tr>
<tr>
<td>With local acknowledgement</td>
<td>SUBTYPE: local acknowledge always</td>
</tr>
</tbody>
</table>

Parameter

Name: max. 29 ASCII characters plaintext
Address: AS-Interface bus address (1 … 31)
Start-up test: with / without
Synchronisation time: 100ms … 30s in multiples of 100ms or ∞ (infinite)
Local acknowledgement: with / also after startup / without
   Slave type: standard/A/B slave
   Address: AS-Interface bus address of the local acknowledgement (1 … 31)
   Bit address: In-0 … In-3 or Out-0 … Out-3, inverted / not inverted

Input mask

![Input mask diagram](image-url)
Description

With the double channel dependent monitoring device, both switching signals of the respective safe AS-Interface slave each act on 2 bits of the transmission sequence. In this case, both of the switching signals must arrive within a synchronisation time defined by the user. If only one contact opens, the second contact must still open before both contacts can be closed again.

Optionally, a startup test and/or a local acknowledgement are/is possible. Upon activation of the Also acknowledge after startup checkbox, local acknowledgement is always mandatory even after switching on the AS-Interface safety monitor or following a communication error (warm start of the AS-Interface safety monitor).

Note

If the synchronisation time defined by the user is exceeded, the activation must be repeated. If the synchronisation time is set to infinite (∞), the AS-Interface safety monitor does not grant the validation until the second switching signal arrives.

Application icons

- Emergency shutdown
- Safety guard
- AOPD - contactless active protective device
- Module - used to connect conventional safe switching elements via a safe AS-Interface module.
- Enabling switch
- Key switch
- Two-handed operation (as per EN 574: with startup test, max. synchronisation time 500ms)

Caution

When using for two-handed operation, the corresponding application notes in the manufacturer's documentation must be observed!
## Configuration log

### Example: Without startup test + without local acknowledgement

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ASSIGNED</th>
<th>SAFE SLAVE</th>
<th>SYNC TIME</th>
</tr>
</thead>
<tbody>
<tr>
<td>0018</td>
<td>double channel dependent safety input</td>
<td>no startup test</td>
<td>channel one</td>
<td>5</td>
<td>0.100 Sec</td>
</tr>
<tr>
<td>0019</td>
<td>21</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0020</td>
<td>32</td>
<td>'Name'</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0021</td>
<td>21</td>
<td>double channel dependent safety input</td>
<td>no local acknowledge</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0022</td>
<td>channel one</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0023</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0024</td>
<td>0.100 Sec</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Example: With startup test + without local acknowledgement

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ASSIGNED</th>
<th>SAFE SLAVE</th>
<th>SYNC TIME</th>
</tr>
</thead>
<tbody>
<tr>
<td>0025</td>
<td>double channel dependent safety input</td>
<td>startup test</td>
<td>channel one</td>
<td>5</td>
<td>0.100 Sec</td>
</tr>
<tr>
<td>0026</td>
<td>21</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0027</td>
<td>33</td>
<td>'Name'</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0028</td>
<td>21</td>
<td>double channel dependent safety input</td>
<td>no local acknowledge</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0029</td>
<td>channel one</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0030</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0031</td>
<td>0.100 Sec</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Example: Without startup test + with local acknowledgement

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ADDRESS: BIT:</th>
</tr>
</thead>
<tbody>
<tr>
<td>0032</td>
<td>double channel dependent safety input</td>
<td>local acknowledge</td>
<td>21 In-0 noninv</td>
</tr>
<tr>
<td>0033</td>
<td>21</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0034</td>
<td>34</td>
<td>'Name'</td>
<td></td>
</tr>
<tr>
<td>0035</td>
<td>21</td>
<td>double channel dependent safety input</td>
<td></td>
</tr>
<tr>
<td>0036</td>
<td>channel one</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0037</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0038</td>
<td>0.100 Sec</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Example: Without startup test + with local acknowledgement also after startup

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ADDRESS: BIT:</th>
</tr>
</thead>
<tbody>
<tr>
<td>0040</td>
<td>double channel dependent safety input</td>
<td>local acknowledge always</td>
<td>21 In-0 invert</td>
</tr>
<tr>
<td>0041</td>
<td>21</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0042</td>
<td>35</td>
<td>'Name'</td>
<td></td>
</tr>
<tr>
<td>0043</td>
<td>21</td>
<td>double channel dependent safety input</td>
<td></td>
</tr>
<tr>
<td>0044</td>
<td>channel one</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0045</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0046</td>
<td>0.100 Sec</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Example: With startup test + with local acknowledgement

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ADDRESS: BIT:</th>
</tr>
</thead>
<tbody>
<tr>
<td>0048</td>
<td>double channel dependent safety input</td>
<td>local acknowledge</td>
<td>21 In-0 noninv</td>
</tr>
<tr>
<td>0049</td>
<td>21</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0050</td>
<td>36</td>
<td>'Name'</td>
<td></td>
</tr>
<tr>
<td>0051</td>
<td>21</td>
<td>double channel dependent safety input</td>
<td></td>
</tr>
<tr>
<td>0052</td>
<td>channel one</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0053</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0054</td>
<td>0.100 Sec</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Double channel dependent with debouncing

**Icon**

**Functional device** Double channel dependent safety input with debouncing

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>24</td>
<td>double channel dependent slow action safety input</td>
</tr>
</tbody>
</table>

**Variants**

- Without startup test
  
  SUBTYPE: no startup test

- With startup test
  
  SUBTYPE: startup test

- Without local acknowledgement
  
  SUBTYPE: no local acknowledge

- With local acknowledgement
  
  SUBTYPE: local acknowledge

- With local acknowledgement also after startup
  
  SUBTYPE: local acknowledge always

**Parameter**

- Name: max. 29 ASCII characters plaintext
- Address: AS-Interface bus address (1 … 31)
- Start-up test: with / without
- Synchronisation time: 200 ms … 60s in multiples of 100ms or ∞ (infinite), default 0.5s
- Bounce time: 100ms … 25s in multiples of 100ms
- Local acknowledgement: with / also after startup / without
  
  - Slave type: standard/A/B slave
  - Address: AS-Interface bus address of the local acknowledgement (1 … 31)
  - Bit address: In-0 … In-3 or Out-0 … Out-3, inverted / not inverted

**Input mask**
Description

With the double channel dependent with debouncing monitoring device, both switching signals of the respective safe AS-Interface slave each act on 2 bits of the transmission sequence. In this case, both of the switching signals must arrive within a synchronisation time defined by the user.

For debouncing the contacts, a bounce time can be defined. During this time, the contacts are not evaluated. The bounce time begins when both contacts close the first time. After the bounce time has passed, both contacts are again queried. If they are then closed and if the synchronisation time has not yet passed, the validation is performed. The selected synchronisation time must be greater than the bounce time.

Note

The set bounce time is always allowed to pass. This means that if a bounce time of 10s is set, then the device is validated no sooner than this time.

If only one contact opens, the second contact must still open before both contacts can be closed again.

Note

If the synchronisation time defined by the user is exceeded, the activation must be repeated. If the synchronisation time is set to infinite (∞), the AS-Interface safety monitor does not grant the validation until the second switching signal arrives.

Optionally, a startup test and/or a local acknowledgement are/is possible. Upon activation of the Also acknowledge after startup checkbox, local acknowledgement is always mandatory even after switching on the AS-Interface safety monitor or following a communication error (warm start of the AS-Interface safety monitor).

Application icons

- 🛡️ Safety guard
- 🔒 AOPD - contactless active protective device
- 🎨 Module - used to connect conventional safe switching elements via a safe AS-Interface module.
## Configuration log

### Example: Synchronisation time 0.3 s, bounce time 0.2 s

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ASSIGNED</th>
<th>SAFE SLAVE</th>
<th>SYNC TIME</th>
<th>CHATTER</th>
</tr>
</thead>
<tbody>
<tr>
<td>0020</td>
<td>32</td>
<td>24</td>
<td>both channels</td>
<td>1</td>
<td>0.300 Sec</td>
<td>0.200 Sec</td>
</tr>
</tbody>
</table>

### Example: Synchronisation time infinite, bounce time 0.1 s

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ASSIGNED</th>
<th>SAFE SLAVE</th>
<th>SYNC TIME</th>
<th>CHATTER</th>
</tr>
</thead>
<tbody>
<tr>
<td>0029</td>
<td>33</td>
<td>24</td>
<td>channel one</td>
<td>2</td>
<td>infinite</td>
<td>0.100 Sec</td>
</tr>
</tbody>
</table>

### Example: With startup test

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ASSIGNED</th>
<th>SAFE SLAVE</th>
<th>SYNC TIME</th>
<th>CHATTER</th>
</tr>
</thead>
<tbody>
<tr>
<td>0038</td>
<td>34</td>
<td>24</td>
<td>channel one</td>
<td>3</td>
<td>0.500 Sec</td>
<td>0.100 Sec</td>
</tr>
</tbody>
</table>

### Example: With startup test and local acknowledgement

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ADDRESS</th>
<th>BIT</th>
<th>ASSIGNED</th>
<th>SAFE SLAVE</th>
</tr>
</thead>
<tbody>
<tr>
<td>0056</td>
<td>36</td>
<td>24</td>
<td>10</td>
<td>In-0 noninv</td>
<td>channel one</td>
<td>5</td>
</tr>
</tbody>
</table>
Double channel dependent with filtering

**Note**
The "double channel dependent with filtering" monitoring device is available beginning with device version C (V03.04) of the AS-i safety monitor.

It was developed for applications in areas with electrical interference as well as with vibrating guards.

**Icon**

**Functional device**  Double channel dependent safety input with filtering

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>24</td>
<td>double channel dependent safety input with filtering</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Variants</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Without startup test</td>
<td>SUBTYPE: no startup test</td>
</tr>
<tr>
<td>With startup test</td>
<td>SUBTYPE: startup test</td>
</tr>
<tr>
<td>Without local acknowledgement</td>
<td>SUBTYPE: no local acknowledge</td>
</tr>
<tr>
<td>With local acknowledgement</td>
<td>SUBTYPE: local acknowledge</td>
</tr>
<tr>
<td>With local acknowledgement also after startup</td>
<td>SUBTYPE: local acknowledge always</td>
</tr>
</tbody>
</table>

**Parameter**

Name: max. 29 ASCII characters plaintext

Address: AS-Interface bus address (1 … 31)

Start-up test: with / without

Synchronisation time: 100 ms … 60 s in multiples of 100 ms or ∞ (infinite), default 0.5s

Stabilising time: 100 ms … 10 s in multiples of 100 ms

Short-term, single-channel interruption: shutdown with test request/

shutdowm without test request/
tolerancing without shutdown

Tolerance time: 100 ms … 1 s in multiples of 100 ms,

default 0.1s

Local acknowledgement: with / also after startup / without

Slave type: standard/A/B slave

Address: AS-Interface bus address of the local acknowledgement (1 … 31)

Bit address: In-0 … In-3 or Out-0 … Out-3, inverted / not inverted
### Input mask

![Input mask screenshot]

### Description

With the **double channel dependent with filtering** monitoring device, both switching signals of the respective safe AS-Interface slave each act on 2 bits of the transmission sequence. The user defines a synchronisation time, a stabilising time and, if necessary, a tolerance time. When switched on, the protective switch may switch between all possible states (none, one, or both contacts closed) during the synchronisation time.

If both contacts remain open for the duration of the stabilising time, the synchronisation time is restarted when the contacts are again closed. If the protective switch is in an undefined state for the duration of the stabilising time, the functional device switches to the locked error state. Only if both contacts close within the synchronisation time and remain closed for the duration of the stabilising time is the validation performed.

The functional device offers 3 possibilities for handling short-term, single-channel interruptions.

- **If the shutdown with test request** is activated, the functional device always calls for restart with test request.
- **If shutdown without test request** is activated, the functional device calls for restart with test request only for single channel interruptions which have lasted longer than the set tolerance time.
- **If tolerancing without shutdown** is selected, shutdown in the event of single channel interruptions only occurs after the tolerance time has passed. Note here that the reaction time is extended by the set tolerance time!
Notice

If tolerancing without shutdown is selected, shutdown in the event of single channel interruptions only occurs after the tolerance time has passed. The reaction time is extended by the set tolerance time!

The set tolerance time in the "Tolerancing without shutdown" operating mode must not exceed one tenth of the average time between two actuations of the monitored switch!

Example:
The shortest time between 2 opening operations of a safety guard is 5 s.
The set tolerance time in this case may be maximum 0.5 seconds.

Optionally, a startup test and/or a local acknowledgement are/is possible. Upon activation of the Also acknowledge after startup checkbox, local acknowledgement is always mandatory even after switching on the AS-Interface safety monitor or following a communication error (warm start of the AS-Interface safety monitor).

Application icons

Safety guard

Module - used to connect conventional safe switching elements via a safe AS-Interface module.
## Configuration log

### Example: Synchronisation time 0.3 s, stabilising time 0.2 s, shutdown with test request

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ASSIGNED</th>
<th>SAFE SLAVE</th>
<th>SYNC TIME</th>
<th>STABLE TIME</th>
<th>1-CHANNEL-INTERRUPT TOLERANCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>0022</td>
<td>32</td>
<td>“F1”</td>
<td>channel one</td>
<td>5</td>
<td>0.300 Sec</td>
<td>0.200 Sec</td>
<td>off</td>
</tr>
</tbody>
</table>

### Example: Synchronisation time infinite, stabilising time 0.2 s, shutdown without test request

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ADDRESS</th>
<th>BIT</th>
<th>ASSIGNED</th>
<th>SAFE SLAVE</th>
<th>SYNC TIME</th>
<th>STABLE TIME</th>
<th>1-CHANNEL-INTERRUPT TOLERANCE</th>
<th>TOLERANCE TIME</th>
</tr>
</thead>
<tbody>
<tr>
<td>0170</td>
<td>45</td>
<td>“F2”</td>
<td></td>
<td></td>
<td>channel one</td>
<td>14</td>
<td>infinite</td>
<td>0.200 Sec</td>
<td>delayed test request</td>
<td>0.700 Sec</td>
</tr>
</tbody>
</table>

### Example: Synchronisation time infinite, stabilising time 0.2 s, tolerancing without shutdown

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ADDRESS</th>
<th>BIT</th>
<th>ASSIGNED</th>
<th>SAFE SLAVE</th>
<th>SYNC TIME</th>
<th>STABLE TIME</th>
<th>1-CHANNEL-INTERRUPT TOLERANCE</th>
<th>TOLERANCE TIME</th>
</tr>
</thead>
<tbody>
<tr>
<td>0308</td>
<td>55</td>
<td>“F3”</td>
<td></td>
<td></td>
<td>channel one</td>
<td>26</td>
<td>infinite</td>
<td>2.000 Sec</td>
<td>delayed switch off</td>
<td>0.600 Sec</td>
</tr>
</tbody>
</table>

For the additional fault detection time, it is 0.600 seconds.
Double channel conditionally dependent

**Icon**

![Icon](image)

**Functional device** Double channel conditionally dependent safety input

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>25</td>
<td>double channel priority safety input</td>
</tr>
</tbody>
</table>

**Variants**

none

**Parameter**

Name: max. 29 ASCII characters plaintext

Address: AS-Interface bus address (1 … 31)

Independent: Bit address of the independent contact (In-1 or In-2)

**Input mask**

![Safety guard](image)
Description

With the double channel conditionally dependent monitoring device, both switching signals of the respective safe AS-Interface slave each act on 2 bits of the transmission sequence. In order for the second, dependent switching signal to be accepted in this case, the first switching signal must be present. Which contact is dependent on which can be freely selected. It is an error if the second, dependent switching signal arrives before the first switching signal.

Example: A door switch with locking. One contact is operated by the door switch (independent contact), the second by the lock monitor (dependent contact). Only if the door is closed, the lock can be opened and closed. An opened door contact with the lock closed is an error.

Caution

Double channel conditionally dependent monitoring devices offer only limited safety, as they cannot be checked for simultaneousness. Check carefully to ensure that the use of a double channel conditionally dependent monitoring device fulfills the requirements of the desired safety category.

Application icons

Safety guard with lock

Module - used to connect conventional safe switching elements via a safe AS-Interface module.

Configuration log

Example: Contact with bit address In-1 is the independent contact

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ASSIGNED</th>
<th>SAFE SLAVE</th>
</tr>
</thead>
<tbody>
<tr>
<td>0026</td>
<td>33</td>
<td>25</td>
<td>9</td>
<td>4</td>
</tr>
</tbody>
</table>

Example: Contact with bit address In-2 is the independent contact

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ASSIGNED</th>
<th>SAFE SLAVE</th>
</tr>
</thead>
<tbody>
<tr>
<td>0020</td>
<td>32</td>
<td>25</td>
<td>3</td>
<td>3</td>
</tr>
</tbody>
</table>
4.3  Creating and changing a configuration

Double channel independent

Icon

Functional device  Double channel independent safety input

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>22</td>
<td>double channel independent safety input</td>
</tr>
</tbody>
</table>

Variants

- Without startup test: SUBTYPE: no startup test
- With startup test: SUBTYPE: startup test
- Without local acknowledgement: SUBTYPE: no local acknowledge
- With local acknowledgement: SUBTYPE: local acknowledge
- With local acknowledgement also after startup: SUBTYPE: local acknowledge always

Parameter

Name: max. 29 ASCII characters plaintext
Address: AS-Interface bus address (1 ... 31)
Start-up test: with / without
Local acknowledgement: with / also after startup / without
Slave type: standard/A/B slave
Address: AS-Interface bus address of the local acknowledgement (1 ... 31)
Bit address: In-0 ... In-3 or Out-0 ... Out-3, inverted / not inverted

Input mask

[Image of configuration software interface]
Description

With the double channel independent monitoring device, the two switching signals of the respective safe AS-Interface slave each act on 2 bits of the transmission sequence. In this case, it is only necessary that both switching signals arrive. There is no synchronisation time.

 Optionally, a startup test and/or a local acknowledgement are/is possible. Upon activation of the Also acknowledge after startup checkbox, local acknowledgement is always mandatory even after switching on the AS-Interface safety monitor or following a communication error (warm start of the AS-Interface safety monitor).

Note

If the startup test option is selected, both switches must be open at all times during the test. Moreover, a startup test must be performed following the reset of an error condition.

Caution

Double channel independent monitoring devices offer only limited safety, as they cannot be checked for simultaneity. Check carefully to ensure that the use of a double channel independent monitoring device fulfils the requirements of the desired safety category.

Application icons

- Emergency shutdown
- Safety guard
- Module - used to connect conventional safe switching elements via a safe AS-Interface module.
- Enabling switch
- Key switch

Configuration log

Example: With startup test

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ASSIGNED</th>
<th>SAFE SLAVE</th>
</tr>
</thead>
<tbody>
<tr>
<td>0020</td>
<td>32</td>
<td>22</td>
<td>both channels</td>
<td>1</td>
</tr>
<tr>
<td>0021</td>
<td>22</td>
<td>startup test</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>0022</td>
<td></td>
<td>no local acknowledge</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>0023</td>
<td></td>
<td>startup test</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>0024</td>
<td></td>
<td>both channels</td>
<td></td>
<td>4</td>
</tr>
<tr>
<td>0025</td>
<td></td>
<td>1</td>
<td></td>
<td>5</td>
</tr>
</tbody>
</table>

Example: With local acknowledgement also after startup

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ADDRESS</th>
<th>BIT</th>
<th>SAFE SLAVE</th>
</tr>
</thead>
<tbody>
<tr>
<td>0027</td>
<td>33</td>
<td>22</td>
<td>10</td>
<td>In-0 noninv</td>
<td>7</td>
</tr>
<tr>
<td>0028</td>
<td>22</td>
<td>no startup test</td>
<td></td>
<td></td>
<td>8</td>
</tr>
<tr>
<td>0029</td>
<td></td>
<td>local acknowledge always ADDRESS:</td>
<td></td>
<td></td>
<td>9</td>
</tr>
<tr>
<td>0030</td>
<td></td>
<td>channel one</td>
<td></td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>0031</td>
<td></td>
<td>1</td>
<td></td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>0032</td>
<td></td>
<td>2</td>
<td></td>
<td>2</td>
<td></td>
</tr>
</tbody>
</table>
Standard slave

Icon

Functional device Standard slave

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>23</td>
<td>activation switch</td>
</tr>
</tbody>
</table>

Variants none

**Parameter**

Name: max. 29 ASCII characters plaintext
Slave type: standard/A/B slave
Address: AS-Interface bus address (1 … 31)
Bit address: In-0 … In-3 or Out-0 … Out-3, inverted / not inverted

**Input mask**

![Image of input mask](image-url)
Description

The standard slave monitoring device is used to integrate one bit (input or output) of a non-safe, standard AS-Interface switching signal as an additional switching signal for operational switching of the AS-Interface safety monitor relay(s) in an OSSD.

Note

With the input and output bits of a non-safe, standard AS-Interface slave, the process image is always analysed, i.e. the ON state always means an active signal in the process image. With the standard slave, the output bits of a slave address can also be used. In this way it is possible to react to a signal from the controller as well. As of version 2.0 the slaves simulated by the monitor can also be used for this purpose.

If the Inverted parameter is activated, the inverter icon precedes the icon for the standard slave device in the configuration.

Notice

The use of a standard slave device for safe switching tasks is not permitted!

Configuration log

| Example: |
|-----------------|-----------------|-----|
| 0018 INDEX:     | 32 = “Name“     | 8   |
| 0019 TYPE:      | 23 = activation switch | 9   |
| 0020 ASSIGNED:  | channel one     | 0   |
| 0021 ADDRESS:   | 21 BIT: In-0 noninv | 1   |
Monitor input

Icon or

Functional device

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>28</td>
<td>monitor input</td>
</tr>
</tbody>
</table>

Variants

none

Parameter

Name: max. 29 ASCII characters plaintext

Monitor input: 1.Y1, 1.Y2, 2.Y1 or 2.Y2, inverted / not inverted

Input mask

![Monitor input dialog box](image)
Description

The monitor input monitoring device is used to link a signal to one of the inputs 1.Y1 through 2.Y2 of the AS-Interface safety monitor as an additional switching signal for operational switching of the AS-Interface safety monitor relay(s) in an OSSD.

The state of the device corresponds to the level at the selected monitor input. In order to change the state of the device, the level at the selected monitor input must remain stable for the duration of three machine cycles. It is possible to invert the device state.

Note

A configuration which uses inputs 2.Y1 or 2.Y2 cannot be operated in a single channel AS-Interface safety monitor.

If the Inverted parameter is activated, the inverter icon precedes the icon for the monitor input device in the configuration.

Notice

The use of a monitor input device for safe switching tasks is not permitted!

Configuration log

Example:

| 0018 INDEX: | 32 = "Name" | 8 |
| 0019 TYPE:  | 28 = monitor input | 9 |
| 0020 ASSIGNED: | channel one | 0 |
| 0021 INPUT: | 1.Y2 invert | 1 |
4.3 Creating and changing a configuration

### Button

<table>
<thead>
<tr>
<th>Icon</th>
<th>Functional device</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Button Icon]</td>
<td>Button</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>26</td>
<td>button</td>
</tr>
</tbody>
</table>

**Variants**
- none

### Parameter

- **Name**: max. 29 ASCII characters plaintext
- **Slave type**: standard/A/B slave
- **Address**: AS-Interface bus address (1 … 31)
- **Bit address**: In-0 … In-3 or Out-0 … Out-3, inverted / not inverted
- **Pulse length**: 5ms … 300s in multiples of 5ms or ∞ (infinite)

**Input mask**

![Input Mask Diagram]
Description

The **Button** device can be integrated within the OSSD or Preprocessing. The Button device makes acknowledgement possible on the device level. As soon as the validation for the device which is linked to the button is present, this device can be released by actuating the button, i.e. acknowledged (device switches to the ON state). If the device is not validated before the acknowledgement arrives, the device switches to the OFF state.

**Note**

This function requires that the button remain unactuated after the validation condition has been fulfilled for at least 50ms and then be actuated for at least 50ms yet for no more than 2s. After the button is released, the device switches to the ON state after an additional 50ms for the time set under pulse length.

**Configuration log**

<table>
<thead>
<tr>
<th>Example:</th>
</tr>
</thead>
<tbody>
<tr>
<td>0020 INDEX: 32 = &quot;Name&quot; 0</td>
</tr>
<tr>
<td>0021 TYPE: 26 = button 1</td>
</tr>
<tr>
<td>0022 ASSIGNED: channel one 2</td>
</tr>
<tr>
<td>0023 ADDRESS: 10 BIT: In-0 noninv 3</td>
</tr>
<tr>
<td>0024 ENABLE DEV: 8 = system device: dev before start one 4</td>
</tr>
<tr>
<td>0025 PULSE WIDTH: 0.005 Sec 5</td>
</tr>
</tbody>
</table>
NOP

Icon

Functional device

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>59</td>
<td>no operation</td>
</tr>
</tbody>
</table>

Variants

| none |

Parameter

Name: max. 29 ASCII characters plaintext

State: ON or OFF

Input mask

![Input mask image]
Description

Dummies (NOP - No OPeration) can be used within one of the OSSDs or Preprocessing to make the configuration or the graphical display in **ASIMON** easier to organise or to create a sample configuration to be used as a pattern for different configuration variants. An NOP dummy occupies an index within the configuration. Each functional device can be replaced by an NOP dummy and vice versa.

Note

With NOP devices, make certain that the status values are assigned correctly in the configuration. In AND logic operations, NOP devices should be assigned the ON state; in OR logic operations, on the other hand, they should assigned the OFF state.

Configuration log

### Example: NOP device with OFF state

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>32</td>
<td>59</td>
<td>device value is false</td>
<td>channel one</td>
</tr>
</tbody>
</table>

### Example: NOP device with ON state

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>32</td>
<td>59</td>
<td>device value is true</td>
<td>channel one</td>
</tr>
</tbody>
</table>
Zero sequence detection

Icon

Functional device

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>27</td>
<td>zero sequence detection</td>
</tr>
</tbody>
</table>

Variants

<table>
<thead>
<tr>
<th>Name: max. 29 ASCII characters plaintext</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address: AS-Interface bus address (1 ... 31)</td>
</tr>
<tr>
<td>State: ON or OFF</td>
</tr>
</tbody>
</table>

Input mask

![Image of the ASIMON V3 configuration software interface for zero sequence detection]
Description

The zero sequence detection monitoring device can be used to monitor whether both switches of a safe input slave are open. It is used to perform operational switching tasks. The device switches to the ON state when the value 0000 is continuously transmitted by the safe slave. With zero sequence detection, safe input slaves which are included at a different point in the configuration can also be monitored. And vice versa, the address selected for zero sequence detection for monitoring devices remains available.

Notice

In the event of a defect or error, e.g. insufficient voltage at the slave, the ON state can also be achieved when both switches are closed. For this reason, it is not permitted to use a zero sequence detection device for safe switching tasks!

Configuration log

<table>
<thead>
<tr>
<th>Example: Zero sequence detection device</th>
</tr>
</thead>
<tbody>
<tr>
<td>0020 INDEX: 32 = &quot;Name&quot;</td>
</tr>
<tr>
<td>0021 TYPE: 27 = zero sequence detection</td>
</tr>
<tr>
<td>0022 ASSIGNED: channel one</td>
</tr>
<tr>
<td>0023 SAFE SLAVE: 2</td>
</tr>
</tbody>
</table>
4.3.2 Logic devices

In more complex safety tasks, the various input signals and intermediate states must be linked – something not possible with the global AND. Logic devices are available for this purpose:

- Logical AND operation
- Logical OR operation
- R/S FlipFlop with SET and HOLD input
- Switch-on delay
- Switch-off delay
- Pulse on positive edge

**Note**
You can also link monitoring devices from the other OSSD by assigning them to a logic device. For AS-Interface safety monitors of types 1 and 2 with "Basic" function range, the only possible logic device available for the linking of two monitoring or system devices is the logic OR function.

Example 1:

In the example shown here, the OR logic device switches to the ON state (switched on) when the active optoelectronic protective device "LG1" is in the ON state (switched on) or the safe switching output of the second OSSD is activated (relay triggered) or both conditions are true.
Example 2:

Circuit diagram display

Tree structure display

Figure 4-5  Nested logic devices example

As shown in the second example, logic devices can also be nested.
4.3 Creating and changing a configuration

**OR**

**Note**

For AS-Interface safety monitors of types 1 and 2 with "Basic" function range, the only possible logic device available for the linking of two monitoring or system devices is the logic OR function.

**Icon**

![OR icon](image)

**Functional device**

OR gate

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>40</td>
<td>or gate</td>
</tr>
</tbody>
</table>

**Variants**

- **2 inputs**
  - SUBTYPE: number of inputs 2
- **2 ... 6 inputs**
  - SUBTYPE: number of inputs 2 or
  - SUBTYPE: number of inputs 3 or
  - SUBTYPE: number of inputs 4 or
  - SUBTYPE: number of inputs 5 or
  - SUBTYPE: number of inputs 6

1) Only AS-Interface safety monitor type 1/type 2 with "Basic" function range (see chapter 1.2)!

2) Only AS-Interface safety monitor type 3/type 4 with "Enhanced" function range (see chapter 1.2)!

**Parameter**

Name: max. 29 ASCII characters plaintext

**Input mask**

![Input mask](image)
Description
With the OR logic device, up to 6 monitoring or system devices are linked to one another via the logic OR function.

The OR logic device is in the ON state when **at least one** of the linked devices has the ON state.

Notice
In the configuration of the AS-Interface safety monitor, the same functional devices can be used e.g. for a light barrier and an emergency-off switch. When configuring, you must pay attention to which safety functions may and which may not be bridged.

An application which can make use of the OR logic device is, for example, a material lock in which the machine may only be put into operation when at least one of the two lock gates is closed.

Configuration log

**Example: OR link**

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ASSIGNED</th>
<th>IN DEVICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>38</td>
<td>40</td>
<td>6</td>
<td>1</td>
<td>32</td>
</tr>
<tr>
<td>40</td>
<td>or</td>
<td>gate</td>
<td>channel</td>
<td>device 1</td>
</tr>
<tr>
<td>40</td>
<td>or</td>
<td>gate</td>
<td>channel</td>
<td>device 2</td>
</tr>
<tr>
<td>40</td>
<td>or</td>
<td>gate</td>
<td>channel</td>
<td>device 3</td>
</tr>
<tr>
<td>40</td>
<td>or</td>
<td>gate</td>
<td>channel</td>
<td>device 4</td>
</tr>
<tr>
<td>40</td>
<td>or</td>
<td>gate</td>
<td>channel</td>
<td>device 5</td>
</tr>
<tr>
<td>40</td>
<td>or</td>
<td>gate</td>
<td>channel</td>
<td>device 6</td>
</tr>
</tbody>
</table>
4.3 Creating and changing a configuration

AND

Note
This logic device is not available for AS-Interface safety monitors of types 1 and 2 with "Basic" function range.

Icon

Functional device AND gate

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>41</td>
<td>and gate</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Variants</th>
<th>Subtype: number of inputs</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 ... 6 inputs 1)</td>
<td>2 or 3 or 4 or 5 or 6</td>
</tr>
</tbody>
</table>

1) Only AS-Interface safety monitor type 3/type 4 with "Enhanced" function range (see chapter 1.2)!

Parameter
Name: max. 29 ASCII characters plaintext

Input mask

![Input mask image]

80 Programming and Operating Manual, Edition 04/2016, NEB333155802000/RS-AA/003
Description

With the AND logic device, up to 6 monitoring or system devices are linked to one another via the logic AND function.

The AND logic device only has the ON state when all linked devices have the ON state.

Configuration log

<table>
<thead>
<tr>
<th>Example: AND link</th>
</tr>
</thead>
<tbody>
<tr>
<td>0073 INDEX: 39 = &quot;Name&quot; 3</td>
</tr>
<tr>
<td>0074 TYPE: 41 = and gate 4</td>
</tr>
<tr>
<td>0075 SUBTYPE: number of inputs 6 5</td>
</tr>
<tr>
<td>0076 ASSIGNED: channel one 6</td>
</tr>
<tr>
<td>0077 IN DEVICE: 32 = &quot;Name device 1&quot; 7</td>
</tr>
<tr>
<td>0078 IN DEVICE: 33 = &quot;Name device 2&quot; 8</td>
</tr>
<tr>
<td>0079 IN DEVICE: 34 = &quot;Name device 3&quot; 9</td>
</tr>
<tr>
<td>0080 IN DEVICE: 35 = &quot;Name device 4&quot; 0</td>
</tr>
<tr>
<td>0081 IN DEVICE: 36 = &quot;Name device 5&quot; 1</td>
</tr>
<tr>
<td>0082 IN DEVICE: 37 = &quot;Name device 6&quot; 2</td>
</tr>
</tbody>
</table>
Configuring the AS-Interface safety monitor

4.3 Creating and changing a configuration

**FlipFlop**

**Note**
This logic device is not available for AS-Interface safety monitors of types 1 and 2 with "Basic" function range.

**Icon**  
![FlipFlop Icon](image)

**Functional device**  
R/S-flipflop

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>42</td>
<td>r/s - flipflop</td>
</tr>
</tbody>
</table>

**Variants**
none

**Parameter**

Name:  
max. 29 ASCII characters plaintext

**Input mask**

![Input mask diagram](image)
Description

With the FlipFlop logic device, two monitoring or system devices are linked to one another via the logic R/S-flipflop function.

The state of the FlipFlop logic device is calculated according to the following table:

<table>
<thead>
<tr>
<th>Old output</th>
<th>Set input (Set)</th>
<th>Hold input (Hold)</th>
<th>New output</th>
</tr>
</thead>
<tbody>
<tr>
<td>any</td>
<td>switched on (ON)</td>
<td>switched on (ON)</td>
<td>switched on (ON)</td>
</tr>
<tr>
<td>switched on (ON)</td>
<td>any</td>
<td>switched on (ON)</td>
<td>switched on (ON)</td>
</tr>
<tr>
<td>switched off (OFF)</td>
<td>any</td>
<td>switched off (OFF)</td>
<td>switched off (OFF)</td>
</tr>
<tr>
<td>other</td>
<td></td>
<td></td>
<td>switched off (OFF)</td>
</tr>
</tbody>
</table>

Configuration log

Example:

0084 INDEX: 40 = "Name" 4
0085 TYPE: 42 = r/s - flipflop 5
0086 ASSIGNED: channel one 6
0087 HOLD DEVICE: 34 = "Name device 1" 7
0088 SET DEVICE: 36 = "Name device 2" 8
4.3 Creating and changing a configuration

Switch-on delay

**Note**
This logic device is not available for AS-Interface safety monitors of types 1 and 2 with "Basic" function range.

**Icon**

**Functional device** Switching delay

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>43</td>
<td>delay timer</td>
</tr>
</tbody>
</table>

**Variants**

| Switch-on delay   | SUBTYPE: on delay                   |

**Parameter**

Name: max. 29 ASCII characters plaintext

Delay time: 5ms … 300s in multiples of 5ms

**Input mask**

![Input mask image]
Description

With the switch-on delay logic device, the switching on of a monitoring or system device can be delayed by the adjustable delay time. The state of the switch-on delay logic device is calculated according to the following table:

<table>
<thead>
<tr>
<th>Linked device</th>
<th>Result of the link</th>
</tr>
</thead>
<tbody>
<tr>
<td>switched on (ON) for ( t \geq ) delay time</td>
<td>switched on (ON) after the delay time has passed</td>
</tr>
<tr>
<td>switched on (ON) for ( t &lt; ) delay time</td>
<td>switched off (OFF)</td>
</tr>
<tr>
<td>other</td>
<td>switched off (OFF)</td>
</tr>
</tbody>
</table>

Configuration log

Example:

0090 INDEX: 41 = "Name" 0
0091 TYPE: 43 = delay timer 1
0092 SUBTYPE: on delay 2
0093 ASSIGNED: channel one 3
0094 IN DEVICE: 32 = "Name device" 4
0095 DELAY TIME: 0.005 Sec 5
Configuring the AS-Interface safety monitor

4.3 Creating and changing a configuration

Switch-off delay

**Note**
This logic device is not available for AS-Interface safety monitors of types 1 and 2 with "Basic" function range.

**Notice**
Note that the system reaction time can be lengthened as a result of the use of the **switch-off delay** device.

**Icon**

![Icon](image)

**Functional device**
Switching delay

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>43</td>
<td>delay timer</td>
</tr>
</tbody>
</table>

**Variants**

| Switch-off delay | SUBTYPE: off delay                    |

**Parameter**

| Name:     | max. 29 ASCII characters plaintext |
| Delay time: | 5ms … 300s in multiples of 5ms     |

**Input mask**

![Input mask](image)
Description

With the switch-off delay logic device, the switching off of a monitoring or system device can be delayed by the adjustable delay time. The state of the switch-off delay logic device is calculated according to the following table:

<table>
<thead>
<tr>
<th>Linked device</th>
<th>Result of the link</th>
</tr>
</thead>
<tbody>
<tr>
<td>switched off (OFF) for ( t \geq ) delay time</td>
<td>switched off (OFF) after the delay time has passed</td>
</tr>
<tr>
<td>switched off (OFF) for ( t &lt; ) delay time</td>
<td>switched on (ON)</td>
</tr>
<tr>
<td>other</td>
<td>switched on (ON)</td>
</tr>
</tbody>
</table>

Example:

```
0097 INDEX: 42 = "Name" 7
0098 TYPE: 43 = delay timer 8
0099 SUBTYPE: off delay 9
0100 ASSIGNED: channel one 0
0101 IN DEVICE: 33 = "Name device" 1
0102 DELAY TIME: 0.005 Sec 2
```
Pulse on pos. edge

Note
This logic device is not available for AS-Interface safety monitors of types 1 and 2 with "Basic" function range.

Icon

Functional device
Pulse generator on positive edge

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>44</td>
<td>convert edge to pulse</td>
</tr>
</tbody>
</table>

Variants
On positive edge

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUBTYPE</td>
<td>on positive edge</td>
</tr>
</tbody>
</table>

Parameter

Name: max. 29 ASCII characters plaintext

Pulse duration: 5ms … 300s in multiples of 5ms

Input mask
Description
With the Pulse on pos. edge logic device, an ON pulse with adjustable pulse duration is created if a monitoring or system device changes state from OFF to ON.

The state of the Pulse on pos. edge logic device is calculated according to the following table:

<table>
<thead>
<tr>
<th>Linked device</th>
<th>Result of the link</th>
</tr>
</thead>
<tbody>
<tr>
<td>switched off (OFF)</td>
<td>switched off (OFF)</td>
</tr>
<tr>
<td>switched on (ON)</td>
<td>switched on (ON) for the length of time set under pulse duration</td>
</tr>
<tr>
<td>other</td>
<td>switched off (OFF)</td>
</tr>
</tbody>
</table>

Notice
While the ON pulse is present at the output, the input is not monitored, i.e. a change of the input state during the ON pulse is not evaluated and has no effect on the ON pulse. The function of the device corresponds to a non-retriggering monoflop.

Notice
Even a short communication error on the AS-Interface line results in an ON pulse at the output!

Configuration log

Example:

0104 INDEX: 43 = "Name" 4
0105 TYPE: 44 = convert edge to pulse 5
0106 SUBTYPE: on positive edge 6
0107 ASSIGNED: channel one 7
0108 IN DEVICE: 36 = "AOPD1" 8
0109 PULSE WIDTH: 0.005 Sec 9
4.3.3 External device monitoring devices

External device monitoring devices (also called EDM devices - External Device Monitor) are used for realizing dynamic contactor monitoring for a configuration of the AS-Interface safety monitor. If no EDM device is configured, contactor monitoring is deactivated.

**Note**

Multiple EDM devices can be integrated in an OSSD.

For example, with dynamic contactor monitoring, the motor contactors connected downstream of the safety monitor for the potentially dangerous movement are connected to the safe switching outputs of the AS-Interface safety monitor. Via a feedback control loop, the state of the contactors is monitored by the input contactor monitor on the AS-Interface safety monitor.

**Note**

Additional information about the electrical design and connection of a contactor monitor can be found in the operating manual of the AS-Interface safety monitor.

**Reset of error condition**

If a device detects an error, the AS-Interface safety monitor enters the error state. The error state is locked (error lock). With versions of the AS-Interface safety monitor before 2.0, the error state can be rectified only by resetting the AS-Interface safety monitor by switching off and then switching back on the AS-Interface safety monitor or by pressing the Service button on the AS-Interface safety monitor.

With software versions of the AS-Interface safety monitor > 2.0, the reset of error conditions (Reset) on the device level after OSSDs is possible, i.e. via an AS-Interface standard/A/B slave, e.g. a button can trigger the error lock (see chapter 3.1 "Launching the program").
External device monitoring circuit

Icon

Functional device External device monitoring circuit

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>60</td>
<td>external device monitor</td>
</tr>
</tbody>
</table>

Variants

<table>
<thead>
<tr>
<th>Error lock</th>
<th>SUBTYPE: none</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limited error lock</td>
<td>SUBTYPE: limited error lock</td>
</tr>
</tbody>
</table>

Parameter

Name: max. 29 ASCII characters plaintext

Switching time: 10 ... 1000ms, switching time of the contactor

Limited error lock: with / without

Input mask

Description

As long as the safe outputs are switched off, the input contactor monitor on the AS-Interface safety monitor must be active = ON. After the safe outputs have been switched on (validation), the input contactor monitor is not relevant for set switching time. Afterward, the input must be inactive = OFF. The state of the contactor monitor is active = ON (switched on).

After the safe outputs have been switched off, the state of the contactor monitor returns to inactive = OFF (switched off) and the input contactor monitor is not queried for the set switching time. Afterward, the input contactor monitor must again be active = ON.

Contactor monitoring prevents the monitor from being switched back on for the duration of the set switching time after it is switched off. This should allow all downstream contactors to reach the idle state before contactor monitoring again queries the input signal, thereby preventing an error lock.
Error lock

If the input is inactive when the safe outputs are switched off or active when the safe outputs are switched on, the system switches to the error state and locks.

Note

With dynamic contactor monitoring with error lock, series connection of the contactor controller with operational switches is not possible.

Limited error lock

If the input is inactive = OFF when the safe outputs are switched off, the system switches to the error state and locks. If the input remains active after the safe outputs are switched active = ON, e.g. when the contactor no longer engages due to a blown fuse, the contactor monitor switches the safe outputs of the OSSD back off.

Notice

The combination of the dynamic contactor monitoring with limited error lock together with automatic start is not permitted, as in this combination it is possible for the safe outputs of the AS-Interface safety monitor to be continuously switched on and off.

Configuration log

Example: Error lock

<table>
<thead>
<tr>
<th>INDEX</th>
<th>32 = 'Name'</th>
</tr>
</thead>
<tbody>
<tr>
<td>TYPE</td>
<td>60 = external device monitor</td>
</tr>
<tr>
<td>SUBTYPE</td>
<td>none</td>
</tr>
<tr>
<td>ASSIGNED</td>
<td>channel one</td>
</tr>
<tr>
<td>OFF TIME</td>
<td>0.100 Sec</td>
</tr>
</tbody>
</table>

Example: Limited error lock

<table>
<thead>
<tr>
<th>INDEX</th>
<th>32 = 'Name'</th>
</tr>
</thead>
<tbody>
<tr>
<td>TYPE</td>
<td>60 = external device monitor</td>
</tr>
<tr>
<td>SUBTYPE</td>
<td>limited error lock</td>
</tr>
<tr>
<td>ASSIGNED</td>
<td>channel one</td>
</tr>
<tr>
<td>OFF TIME</td>
<td>0.100 Sec</td>
</tr>
</tbody>
</table>
External device monitoring circuit with standard slave

Icon

Functional device  External device monitoring circuit with standard slave

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>62</td>
<td>external device monitor standard slave</td>
</tr>
</tbody>
</table>

Variants

| Error lock | SUBTYPE: none |
| Limited error lock | SUBTYPE: limited error lock |

Parameter

Name: max. 29 ASCII characters plaintext
Switching time: 10 … 1000ms, switching time of the contactor
Limited error lock: with / without
Slave type: standard/A/B slave
Address: AS-Interface bus address (1 … 31)
Bit address: In-0 … In-3 or Out-0 … Out-3, inverted / not inverted

Input mask

Description

The external device monitoring circuit with standard slave is functionally identical to the normal external device monitoring circuit.

As long as the safety outputs are switched off, the standard/A/B slave must be in the state active = ON. After the safe outputs have been switched on (validation), the state of the standard/A/B slave is not relevant for set switching time. Afterward, the standard/A/B slave must be in the inactive = OFF state again. The state of the contactor monitor is active = ON (switched on).

After the safe outputs have been switched off, the state of the contactor monitor returns to inactive = OFF (switched off) and the state of the standard/A/B slave is not queried for the set switching time. Afterward, the standard/A/B slave must be in the state active = ON again.

Contactor monitoring prevents the monitor from being switched back on for the duration of the set switching time after it is switched off. This should allow all downstream contactors to reach the idle state before contactor monitoring again queries the input signal, thereby preventing an error lock.
4.3 Creating and changing a configuration

**Error lock**

If the input is inactive = OFF when the safe outputs are switched off or active = ON when the safe outputs are switched on, the system switches to the error state and locks.

**Note**

With dynamic contactor monitoring with error lock, series connection of the contactor controller with operational switches is not possible.

**Limited error lock**

If the input is inactive = OFF when the safe outputs are switched off, the system switches to the error state and locks. If the input remains active after the safe outputs are switched active = ON, e.g. when the contactor no longer engages due to a blown fuse, the contactor monitor switches the safe outputs of the OSSD back off.

**Notice**

The combination of the dynamic contactor monitoring with limited error lock together with automatic start is not permitted, as in this combination it is possible for the safe outputs of the AS-Interface safety monitor to be continuously switched on and off.

---

**Configuration log**

[Example: Error lock]

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ASSIGNED</th>
<th>ADDRESS</th>
<th>OFF TIME</th>
</tr>
</thead>
<tbody>
<tr>
<td>33</td>
<td>62</td>
<td>none</td>
<td>channel one</td>
<td>10</td>
<td>0.100 Sec</td>
</tr>
</tbody>
</table>

[Example: Limited error lock]

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>SUBTYPE</th>
<th>ASSIGNED</th>
<th>ADDRESS</th>
<th>OFF TIME</th>
</tr>
</thead>
<tbody>
<tr>
<td>33</td>
<td>62</td>
<td>limited error lock</td>
<td>channel one</td>
<td>10</td>
<td>0.100 Sec</td>
</tr>
</tbody>
</table>
External device monitoring circuit for safe output slave

Note

AS-i safety monitor devices with operating software version 3.10 and higher feature the External device monitoring circuit for safe output slave functional device.

With this external device monitoring circuit module, an additional release signal can be configured for operational switching of the safety-oriented AS-interface actuator.

Icon

External device monitoring circuit for safe output slave

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>66</td>
<td>external device monitor for safe actuator slave</td>
</tr>
</tbody>
</table>

Variants

| Error lock | SUBTYPE: none |
| Limited error lock | SUBTYPE: limited error lock |

Parameter

Name: max. 29 ASCII characters plain text
Switching time: 10 ... 1000 ms, switching time of the contactor
Limited error lock: with / without
Slave type: standard/A/B slave
Address: AS-interface bus address (1 ... 31)
Bit address: In-0 ... In-3 or Out-0 ... Out-3, inverted / not inverted
Input mask

Description

In the state without Activate operational switching parameter selection, the EDM circuit for safe output slave is functionally identical to the normal EDM circuit.

As long as the safety outputs are switched off, the standard/A/B slave must be in the state active = ON. After the safe outputs have been switched on (validation), the state of the standard/A/B slave is not relevant for set switching time. Afterward, the standard/A/B slave must be in the inactive = OFF state again. The state of the contactor monitor is active = ON (switched on).

After the safe outputs have been switched off, the state of the contactor monitor returns to inactive = OFF (switched off) and the state of the standard/A/B slave is not queried for the set switching time. Afterward, the standard/A/B slave must be in the state active = ON again.

Contactor monitoring prevents the monitor from being switched back on for the duration of the set switching time after it is switched off. This should allow all downstream contactors to reach the idle state before contactor monitoring again queries the input signal, thereby preventing an error lock.
In the state with **Activate operational switching** parameter selection, the EDM circuit acts for the safe output slave according to the following state table:

<table>
<thead>
<tr>
<th>Release of AS-interface safety monitor</th>
<th>Standard / A/B slave release signal - operational switching of the safe AS-interface actuator</th>
<th>State of the contactor monitoring</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inactive = OFF</td>
<td>Inactive = OFF</td>
<td>Active = ON</td>
</tr>
<tr>
<td>Inactive = OFF</td>
<td>Active = ON</td>
<td>Active = ON</td>
</tr>
<tr>
<td>Active = ON</td>
<td>Inactive = OFF</td>
<td>Active = ON</td>
</tr>
<tr>
<td>Active = ON</td>
<td>Active = ON</td>
<td>Inactive = OFF</td>
</tr>
</tbody>
</table>

The safe output slave (safety-oriented actuator) is released for start-up when a release is present for the AS-i safety monitor and when a standard slave grants an operational release. At the same time, it is ensured that pure operational switching-off of the actuator via AS-interface does not result in automatic error lock in the AS-interface safety monitor if a release is still present for the AS-interface safety monitor.

**Error lock**

If the input is inactive = OFF when the safe outputs are switched off or active = ON when the safe outputs are switched on, the system switches to the error state and locks.

**Note**

With dynamic contactor monitoring with error lock, series connection of the contactor controller with operational switches is not possible.

**Limited error lock**

If the input is inactive = OFF when the safe outputs are switched off, the system switches to the error state and locks. If the input remains active after the safe outputs are switched active = ON, e.g. when the contactor no longer engages due to a blown fuse, the contactor monitor switches the safe outputs of the OSSD back off.

**Notice**

The combination of the dynamic contactor monitoring with limited error lock together with automatic start is not permitted, as in this combination it is possible for the safe outputs of the AS-interface safety monitor to be continuously switched on and off.

**Configuration log**

**Example: Error log**

<table>
<thead>
<tr>
<th>Example: Error log</th>
</tr>
</thead>
<tbody>
<tr>
<td>0040 INDEX: 35 = &quot;Name&quot;</td>
</tr>
<tr>
<td>0041 TYPE: 66 = ext. devl. monitor std. slave operat. switching</td>
</tr>
<tr>
<td>0042 SUBTYPE: none</td>
</tr>
<tr>
<td>0043 ASSIGNED: channel two</td>
</tr>
<tr>
<td>0044 EDM ADDRESS: 7 BIT: In-3 noninv</td>
</tr>
<tr>
<td>0045 OPS ADDRESS: 7 BIT: Out-0 noninv</td>
</tr>
<tr>
<td>0046 OFF TIME: 0.100 Sec</td>
</tr>
</tbody>
</table>
4.3 Creating and changing a configuration

External device monitoring circuit for dependent, second OSSD

**Note**
This EDM device can only be used in the 1st OSSD of a configuration with two dependent output groups.

**Icon**

**Functional device**
External device monitoring circuit for dependent, second OSSD

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>61</td>
<td>external device monitor channel two</td>
</tr>
</tbody>
</table>

**Variants**

| Error lock      | SUBTYPE: none |
| Limited error lock | SUBTYPE: limited error lock |

**Parameter**

**Name:** max. 29 ASCII characters plaintext

**Switching time:** 10 ... 1000 ms, switching time of the contactor

**Limited error lock:** with / without

**Input mask**

**Description**
The external device monitoring circuit for a second, dependent OSSD is functionally identical with a normal external device monitoring circuit. It monitors the downstream contactor on the second channel, but acts on the validation of channel 1.

As long as the safe outputs are switched off, the input contactor monitor on the AS-Interface safety monitor must be active = ON. After the safe outputs have been switched on (validation), the input contactor monitor is not relevant for set switching time. Afterward, the input must be
inactive = OFF. The state of the contactor monitor is active = ON (switched on).

After the safe outputs have been switched off, the state of the contactor monitor returns to
inactive = OFF (switched off) and the input contactor monitor is not queried for the set swit-
ching time. Afterward, the input contactor monitor must again be active = ON.

Contactor monitoring prevents the monitor from being switched back on for the duration of the
set switching time after it is switched off. This should allow all downstream contactors to reach
the idle state before contactor monitoring again queries the input signal, thereby preventing an
error lock.

**Error lock**

If the input is inactive when the safe outputs are switched off or active when the safe outputs
are switched on, the system switches to the error state and locks.

**Note**

With dynamic contactor monitoring with error lock, series connection of the contactor controller
with operational switches is not possible.

**Limited error lock**

If the input is inactive = OFF when the safe outputs are switched off, the system switches to
the error state and locks. If the input remains active after the safe outputs are switched
active = ON, e.g. when the contactor no longer engages due to a blown fuse, the contactor
monitor switches the safe outputs of the OSSD back off.

**Notice**

The combination of the dynamic contactor monitoring with limited error lock together with
automatic start is not permitted, as in this combination it is possible for the safe outputs of the
AS-Interface safety monitor to be continuously switched on and off.

**Configuration log**

**Example: Error lock**

| 0033 INDEX: | 34 = "Name" | 3 |
| 0034 TYPE: | 61 = external device monitor channel two | 4 |
| 0035 SUBTYPE: | none | 5 |
| 0036 ASSIGNED: | channel one | 6 |
| 0037 OFF TIME: | 0.100 Sec | 7 |

**Example: Limited error lock**

| 0033 INDEX: | 34 = "Name" | 3 |
| 0034 TYPE: | 61 = external device monitor channel two | 4 |
| 0035 SUBTYPE: | limited error lock | 5 |
| 0036 ASSIGNED: | channel one | 6 |
| 0037 OFF TIME: | 0.100 Sec | 7 |
External device monitoring circuit with standard slave for dependent, second OSSD

**Note**
This EDM device can only be used in the 1st OSSD of a configuration with two dependent output groups.

**Icon**
![Icon](image)

**Functional device**
External device monitoring circuit with standard slave for dependent, second OSSD

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>63</td>
<td>external device monitor channel two standard slave</td>
</tr>
</tbody>
</table>

**Variants**

<table>
<thead>
<tr>
<th>Error lock</th>
<th>SUBTYPE: none</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limited error lock</td>
<td>SUBTYPE: limited error lock</td>
</tr>
</tbody>
</table>

**Parameter**

- **Name:** max. 29 ASCII characters plaintext
- **Switching time:** 10 … 1000ms, switching time of the contactor
- **Limited error lock:** with / without
- **Slave type:** standard/A/B slave
- **Address:** AS-Interface bus address (1 … 31)
- **Bit address:** In-0 … In-3 or Out-0 … Out-3, inverted / not inverted

**Input mask**

![Image of input mask](image)
Description

The external device monitoring circuit with standard slave for the second, dependent OSSD is functionally identical with a normal external device monitoring circuit for the second, dependent OSSD.

As long as the safety outputs are switched off, the standard/A/B slave must be in the state active = ON. After the safe outputs have been switched on (validation), the state of the standard/A/B slave is not relevant for set switching time. Afterward, the standard/A/B slave must be in the inactive = OFF state again. The state of the contactor monitor is active = ON (switched on).

After the safe outputs have been switched off, the state of the contactor monitor returns to inactive = OFF (switched off) and the state of the standard/A/B slave is not queried for the set switching time. Afterward, the standard/A/B slave must be in the state active = ON again.

Contactor monitoring prevents the monitor from being switched back on for the duration of the set switching time after it is switched off. This should allow all downstream contactors to reach the idle state before contactor monitoring again queries the input signal, thereby preventing an error lock.

Configuration log

<table>
<thead>
<tr>
<th>Example: Error lock</th>
</tr>
</thead>
<tbody>
<tr>
<td>INDEX: 35 = &quot;Name&quot;</td>
</tr>
<tr>
<td>TYPE: 63 = external device monitor channel two standard slave</td>
</tr>
<tr>
<td>SUBTYPE: none</td>
</tr>
<tr>
<td>ASSIGNED: channel one</td>
</tr>
<tr>
<td>ADDRESS: 10 BIT: In-0 noninv</td>
</tr>
<tr>
<td>OFF TIME: 0.100 Sec</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Example: Limited error lock</th>
</tr>
</thead>
<tbody>
<tr>
<td>INDEX: 35 = &quot;Name&quot;</td>
</tr>
<tr>
<td>TYPE: 63 = external device monitor channel two standard slave</td>
</tr>
<tr>
<td>SUBTYPE: limited error lock</td>
</tr>
<tr>
<td>ASSIGNED: channel one</td>
</tr>
<tr>
<td>ADDRESS: 10 BIT: In-0 noninv</td>
</tr>
<tr>
<td>OFF TIME: 0.100 Sec</td>
</tr>
</tbody>
</table>
## 4.3.4 Start devices

In the course of the analysis, after all monitoring, logic and EDM devices have been processed, the result of the AND link of all device states is determined for each OSSD. In the start devices, this result is analysed together with a possible start condition.

For each independent OSSD, at least one start device is required. If multiple start devices are present in an OSSD, they are linked with one another by means of an OR function. Thus, for the validation of an OSSD, it is sufficient when one of the start devices fulfils the condition for the validation.

Possible start conditions are:
- Automatic start (no additional start condition)
- Monitored start by means of an AS-Interface standard slave
- Monitored start by means of start input on the AS-Interface safety monitor
- Monitored start by means of a safe AS-Interface slave
- Activation via standard slave
- Activation via monitor input

---

### Note

A start device can only be assigned to one OSSD. If, for example, both OSSDs are to be started with one button, a start device is to be configured for each OSSD. Both of the devices, however, use the same button.
Automatic start

Icon

Functional device  Automatic start

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>80</td>
<td>automatic start</td>
</tr>
</tbody>
</table>

Variants
none

Parameter

Name:  max. 29 ASCII characters plaintext

Input mask

![Automatic start window]

Description

The "automatic start" start device requires no additional start condition. If the AND link for all monitoring, logic and EDM devices of an OSSD returns the result ON, the "automatic start" start device releases the OSSD via the respectively configured output device.

Danger

In the event of an automatic start, the OSSD switches on as soon as all conditions are fulfilled! The machine can, in this case, start unexpectedly!

Configuration log

Example:

| 0106 INDEX: | 45 = "Name" |
| 0107 TYPE:  | 80 = automatic start |
| 0108 ASSIGNED: | channel one |

Note

The combination of the automatic start start device with other start devices is not useful, as a start would occur in every case.
Monitored start - standard slave

Icon

Functional device Monitored start - standard slave

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>81</td>
<td>manual start standard slave</td>
</tr>
</tbody>
</table>

Variants

- none

Parameter

- Name: max. 29 ASCII characters plaintext
- Slave type: standard/A/B slave
- Address: AS-Interface bus address (1 … 31)
- Bit address: In-0 … In-3 or Out-0 … Out-3

Input mask

Description

The "monitored start - standard slave" start device requires as additional start condition the ON state of a standard/A/B slave on the AS-Interface bus (e.g. start button via AS-Interface standard slave module). If the AND link of all monitoring, logic and EDM devices of an OSSD returns the result ON and start condition is fulfilled, the "monitored start - standard slave" start device passes on the validation request to the output device.

Note

Between the occurrence of the ON state of the AND link of all monitoring, logic and EDM devices of an OSSD and the activation of the standard/A/B slave, at least 50ms must pass. The standard/A/B slave must be activated for at least 50ms and at most 2s. 50ms after activation of the standard/A/B slave has concluded, the validation request is performed.

Configuration log

Example:

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0027 INDEX:</td>
<td>33 = &quot;Name&quot;</td>
</tr>
<tr>
<td>0028 TYPE:</td>
<td>81 = manual start standard slave</td>
</tr>
<tr>
<td>0029 ASSIGNED:</td>
<td>channel one</td>
</tr>
<tr>
<td>0030 ADDRESS:</td>
<td>10 BIT: In-0 noninv</td>
</tr>
</tbody>
</table>

Monitored start - monitor input

Icon

Functional device Monitored start - monitor input

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>82</td>
<td>manual start monitor input</td>
</tr>
</tbody>
</table>

Variants

none

Parameter

Name: max. 29 ASCII characters plaintext

Input mask

Description

The "monitored start - monitor input" start device requires as additional start condition the activation of the start input of the corresponding OSSD. If the AND link of all monitoring, logic and EDM devices of an OSSD returns the result ON and the start condition is fulfilled, the "monitored start - monitor input" start device passes on the validation request to the output device.

Note

Between the occurrence of the ON state of the AND link of all monitoring, logic and EDM devices of an OSSD and the activation of the start input, at least 50ms must pass. The start input must be activated at least 50ms and at most 2s. 50ms after deactivation of the input, the validation request is performed.

Configuration log

Example:

| 0115 INDEX: 47 | "Name" | 5 |
| 0116 TYPE: 82 | manual start monitor input | 6 |
| 0117 ASSIGNED: channel one | 7 |
Monitored start - safe input slave

Icon

Functional device  Monitored start - safe input slave

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>83</td>
<td>manual start safe input</td>
</tr>
</tbody>
</table>

Variants  none

Parameter

Name:  max. 29 ASCII characters plaintext
Address:  AS-Interface bus address (1 … 31)

Input mask

![Monitored start - safe input slave](image)

Description

The "monitored start - safe input slave" start device requires as additional start condition the ON state of a safe input slave on the AS-Interface bus. If the AND link of all monitoring, logic and EDM devices of an OSSD returns the result ON and the start condition is fulfilled, the "monitored start - safe input slave" start device passes on the validation request to the output device.

Note

Between the occurrence of the ON state of the AND link of all monitoring, logic and EDM devices of an OSSD and the activation of the safe input slave, at least 50ms must pass. The safe input slave must be activated for at least 50ms and at most 2s. 50ms after activation of the safe input slave has concluded, the validation request is performed.

Configuration log

Example:

<table>
<thead>
<tr>
<th>Example:</th>
</tr>
</thead>
<tbody>
<tr>
<td>0119 INDEX: 48 = &quot;Name&quot;</td>
</tr>
<tr>
<td>0120 TYPE: 83 = manual start safe input</td>
</tr>
<tr>
<td>0121 ASSIGNED: channel one</td>
</tr>
<tr>
<td>0122 SAFE SLAVE: 5</td>
</tr>
</tbody>
</table>
Activation via standard slave

Icon

Functional device  Activation via standard slave

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>84</td>
<td>enable start standard slave</td>
</tr>
</tbody>
</table>

Variants

| none |

Parameter

Name:  max. 29 ASCII characters plaintext
Slave type:  standard/A/B slave
Address:  AS-Interface bus address (1 … 31)
Bit address:  In-0 … In-3 or Out-0 … Out-3

Input mask

Description

The activation via standard slave start device is used to implement a start function via an AS-Interface input (Start signal) or an AS-Interface PLC output. Unlike the monitored start - standard slave start device, this start device is not pulse-sensitive, but rather level-sensitive. The start signal must be applied for at least 100ms before the device switches to the ON state and sends the validation request to the output device.

Danger

Danger! Upon activation via a standard slave, the OSSD switches on as soon as all conditions are fulfilled and the activating level is reached! When the level is frozen while in the activated state, the machine can, thus, start unexpectedly!

Note

A combination with the automatic start start device is not permitted.
### Configuration log

**Example:**

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ADDRESS</th>
<th>ASSIGNED</th>
<th>BIT</th>
</tr>
</thead>
<tbody>
<tr>
<td>33</td>
<td>84</td>
<td>10</td>
<td>channel one</td>
<td>In-0</td>
</tr>
</tbody>
</table>

- `INDEX`: 33 = 'Name'
- `TYPE`: 84 = enable start standard slave
- `ASSIGNED`: channel one
- `ADDRESS`: 10
- `BIT`: In-0 noninv
Activation via monitor input

**Icon**

**Functional device** Activation via monitor input

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>85</td>
<td>enable start monitor input</td>
</tr>
</tbody>
</table>

**Variants**

none

**Parameter**

Name: max. 29 ASCII characters plaintext

**Input mask**

![Activation via monitor input dialog box]

**Description**

The activation via monitor input start device is used to implement a start function via the monitor input. Unlike the monitored start - monitor input start device, this start device is not pulse-sensitive, but rather level-sensitive. The start signal must be applied for at least 100ms before the device switches to the ON state and sends the validation request to the output device.

**Danger**

Upon activation via a monitor input, the OSSD switches on as soon as all conditions are fulfilled and the activating level is reached! When the level is frozen while in the activating state, the machine can, thus, start unexpectedly!

**Note**

A combination with the automatic start start device is not permitted.

**Configuration log**

**Example:**

0115 INDEX: 47 = “Name”
0116 TYPE: 85 = enable start monitor input
0117 ASSIGNED: channel two
4.3.5 Output devices

The output devices set the validation of the start devices according to their function in the logical nominal states of the output circuits and message outputs.

In the AS-Interface safety monitor, a shutdown system consists of a redundantly constructed relay output and a message output. If two shutdown systems are present in one monitor, the second shutdown system can be operated dependently or independently of the first. The output devices differ from one another at this point.

Note
For two independent OSSDs, exactly one output device must be present for each OSSD.
For two dependent OSSDs, exactly one output device in the 1st OSSD establishes the dependence.

The conversion of the logical to the physical switching state for relays, message outputs and LEDs is then performed in the hardware of the AS-Interface safety monitor. A false switching state in the hardware detected when reading the data back in also results in the switching of the affected output device to the error state.
Stop category 1 - message and delayed relay output

Note
This output device is available only for one OSSD or for two independent OSSDs.

Symbol

Functional device
Stop category 1 - message and delayed relay output

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>stop category 1 with delayed relay</td>
</tr>
</tbody>
</table>

Variants
none

Parameter

Name: max. 29 ASCII characters plaintext
Switch-off delay: 0s … 300s in multiples of 100ms

Input mask

Description
Upon validation of the circuit, ON state, the message output and the output circuit are simultaneously activated by the stop category 1 - message and delayed relay output output device. If the circuit is switched off, OFF state, the message output is switched off immediately and the output circuit is switched off after the set switch-off delay has elapsed. The switch-off delay can be set to values between 0s and 300s in increments of 100ms. The circuit can be switched back on only after both output circuits have been switched off.

Notice
The message output is not safe. A safe maximum switch-off delay only exists for the output circuits.

In the event of an internal error in the AS-Interface safety monitor, the output circuits are switched off immediately. For all other errors, e.g. communication interruption, the set switch-off delay is retained.
### Configuration log

Example:

<table>
<thead>
<tr>
<th>0124 INDEX: 49 = 'Name'</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>0125 TYPE: 100 = stop category 1 with delayed relay</td>
<td>5</td>
</tr>
<tr>
<td>0126 ASSIGNED: channel one</td>
<td>6</td>
</tr>
<tr>
<td>0127 DELAY TIME: 10.000 Sec</td>
<td>7</td>
</tr>
</tbody>
</table>
Stop category 0

Note
This output device is available only for one OSSD or for two independent OSSDs.

Symbol
Functional device

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>stop category 0</td>
</tr>
</tbody>
</table>

Variants
none

Parameter
Name: max. 29 ASCII characters plaintext

Input mask

Description
Upon validation of the circuit, ON state, the message output and the output circuit are simultaneously activated by the stop category 0 output device. If the circuit is switched off, OFF state, the message output and the output circuit are switched off immediately without delay.

Note
In the event of an error in the AS-Interface safety monitor, the state of the message output is undefined. The output circuit is switched off.

Configuration log

Example:

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>101</td>
<td>channel one</td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>101</td>
<td>channel one</td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>101</td>
<td>channel one</td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>101</td>
<td>channel one</td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>101</td>
<td>channel one</td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>101</td>
<td>channel one</td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>101</td>
<td>channel one</td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>101</td>
<td>channel one</td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>101</td>
<td>channel one</td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>101</td>
<td>channel one</td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>101</td>
<td>channel one</td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>101</td>
<td>channel one</td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>101</td>
<td>channel one</td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>101</td>
<td>channel one</td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>101</td>
<td>channel one</td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>101</td>
<td>channel one</td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>101</td>
<td>channel one</td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>101</td>
<td>channel one</td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>101</td>
<td>channel one</td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>101</td>
<td>channel one</td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>101</td>
<td>channel one</td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>101</td>
<td>channel one</td>
</tr>
</tbody>
</table>
Stop category 1 - two relay outputs

Note
This output device is available only with two dependent OSSDs.

Symbol
stop category 1 - two relay outputs

Functional device
Stop category 1 - two relay outputs

Parameter
Name: max. 29 ASCII characters plaintext
Switch-off delay: 0s … 300s in multiples of 100ms

Input mask

Description
Upon validation of the circuit, ON state, the output circuits (two relays each) of both OSSDs are simultaneously activated by the stop category 1 - two relay outputs output device. If the circuit is switched off, OFF state, the output circuit of OSSD 1 is switched off immediately without delay. The output circuit of the dependent OSSD is switched off with the set switch-off delay. The switch-off delay can be set to values between 0s and 300s in increments of 100ms. The circuit can be switched back on only after both output circuits have been switched off.

Note
In the event of an internal error in the AS-Interface safety monitor, all output circuits are switched off immediately. For all other errors, e.g. communication interruption, the set switch-off delay is retained.
### Configuration log

**Example:**

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0042</td>
<td>INDEX:</td>
<td>36 = “Name”</td>
</tr>
<tr>
<td>0043</td>
<td>TYPE:</td>
<td>102 = stop category 1 with two relay</td>
</tr>
<tr>
<td>0044</td>
<td>ASSIGNED:</td>
<td>channel one</td>
</tr>
<tr>
<td>0045</td>
<td>DELAY TIME:</td>
<td>1.000 Sec</td>
</tr>
</tbody>
</table>
4.3 Creating and changing a configuration

Door lock by means of zero-speed relay and delay time

**Note**
This output device is available only with two dependent OSSDs.

**Symbol**

![Symbol](image)

**Functional device** Door lock

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>103</td>
<td>door lock</td>
</tr>
</tbody>
</table>

**Variants**

| Zero-speed relay and delay time | SUBTYPE: input or time |

**Parameter**

- **Name**: max. 29 ASCII characters plaintext
- **Release time**: 1s … 300 s in multiples of 1s
- **Unlocking device**: with / without
- **Slave type**: standard/A/B slave
- **Address**: AS-Interface bus address (1 … 31)
- **Bit address**: In-0 … In-3 or Out-0 … Out-3, inverted / not inverted

**Input mask**

![Input mask](image)
Description

After the first output circuit is switched off, the second output circuit is switched on if the zero-speed relays report that machine standstill has occurred. Zero-speed relays are to be assigned as devices to the second output circuit.

In order to also facilitate the release of the door lock during communication disturbances and other errors, the set delay time is adhered to for inactive zero-speed relays. This release time is the time between the switching off of the first output circuit and the switching on of the second. The release time can be set between 1s and 300s in increments of 1s.

Before the first output circuit is switched on, the second must be switched off. If the validation, ON state, is performed again before the second output circuit is switched on, the first output circuit is switched back on and the second remains switched off.

Note

After the AS-Interface safety monitor is switched on, the second output circuit is inactive until the monitored movement has come to a standstill, however for no longer than the duration of the set release time.

Unlocking device function

After the first output circuit is switched off (e.g. following an emergency shutdown), the second output circuit is switched on after the set release time has passed (or by the zero-speed relays) so that the doors unlock. This unlocking is not always desired. By enabling Unlocking device (checkbox activated), a standard slave can be specified. The state (LOCK signal) of this standard slave determines whether or not the locking is to be retained even after the release time has passed. When the machine is switched off, the LOCK signal can thus be used to freely turn door locking on and off.

Restart/Reset of error condition option for safe AS-Interface output (actuator)

If an AS-Interface safety monitor is configured with safe AS-Interface output (control of safe AS-Interface actuators) in the Information about monitor and bus, devices for the reset of error condition and the restart of the actuator must also be configured. After inserting the output device in the configuration, this is apparent from the 2 dummies for the restart and reset of error condition devices.

![Dummy Diagram]

Assign the dummies for restart and reset of error condition the desired devices by using drag&drop to move devices from the icon library onto the dummies.

Note

For an automatic restart, simply assign the restart dummy the TRUE system device.
Once the dummies are assigned the appropriate devices, you can make further settings for the reset of error condition and for restart by reopening the input mask of the output device.

To do this, click the output device with the right mouse button, select the Edit command from the pop-up menu which opens and click the AS-iS control tab in the input mask.

Input mask

In the Reset of error condition and Restart areas in the Help signals part of the window, you can define in detail which signals result in an activation of the reset of error condition and in restart of the safe actuator.

Available for selection for activating the reset of error condition are:

- Once on OFF --> ON
- Once on ON --> OFF
- Once on change of state

Available for selection for activating the restart are:

- Continuous while ON
- Continuous while OFF
- Continuous while ON and OFF
- Once on OFF --> ON
- Once on ON --> OFF
- Once on change of state

Define the events for activating the reset of error condition and restart and confirm your entry with OK.
### Configuration log

**Example: with unlocking device**

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
<th>SUBTYPE</th>
<th>LOCK</th>
<th>ADDRESS</th>
<th>BIT</th>
</tr>
</thead>
<tbody>
<tr>
<td>35</td>
<td>103</td>
<td>channel 1</td>
<td>input or time</td>
<td>yes</td>
<td>10</td>
<td>In-0</td>
</tr>
<tr>
<td>0036</td>
<td>0037</td>
<td>0038</td>
<td>0039</td>
<td>0040</td>
<td>0041</td>
<td></td>
</tr>
<tr>
<td>20.000 Sec</td>
<td></td>
<td>10.000 Sec</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Example: without unlocking device**

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
<th>SUBTYPE</th>
<th>LOCK</th>
<th>ADDRESS</th>
<th>BIT</th>
</tr>
</thead>
<tbody>
<tr>
<td>35</td>
<td>103</td>
<td>channel 1</td>
<td>input or time</td>
<td>no</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0036</td>
<td>0037</td>
<td>0038</td>
<td>0039</td>
<td>0040</td>
<td>0041</td>
<td></td>
</tr>
<tr>
<td>20.000 Sec</td>
<td></td>
<td>10.000 Sec</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Example: Without unlocking device, safe AS-i output**

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNED</th>
<th>SUBTYPE</th>
<th>LOCK</th>
<th>DELAY TIME</th>
<th>SAFE ACTUATOR ADDRESS</th>
<th>Help Signal 1</th>
<th>Help Signal 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>37</td>
<td>103</td>
<td>channel 1</td>
<td>input or time</td>
<td>no</td>
<td>20.000 Sec</td>
<td>27</td>
<td>35</td>
<td>1</td>
</tr>
<tr>
<td>0053</td>
<td>0054</td>
<td>0055</td>
<td>0056</td>
<td>0057</td>
<td>0058</td>
<td>0059</td>
<td>0060</td>
<td>0061</td>
</tr>
<tr>
<td></td>
<td>0058</td>
<td>0059</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Door lock by means of zero-speed relay and delay time with stop category 1

Note
This output device is available only with two dependent OSSDs.

Symbol
OSSD
or

Functional device
Door lock

### Type
<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>104</td>
<td>door lock and stop 1 with delayed relay</td>
</tr>
</tbody>
</table>

### Variants
| Delay time | SUBTYPE: input or time |

### Parameter
Name: max. 29 ASCII characters plaintext
Release time: 1s … 250 s in multiples of 1s
Unlocking device: with / without
Slave type: standard/A/B slave
Address: AS-Interface bus address (1 … 31)
Bit address: In-0 … In-3 or Out-0 … Out-3, inverted / not inverted
Relay delay: 0s … 300s in multiples of 100ms

### Input mask

### Description
After the first output circuit is switched off, the second output circuit is switched on if the zero-speed relays report that machine standstill has occurred. Zero-speed relays are to be assigned as devices to the second output circuit.

In order to also facilitate the release of the door lock during communication disturbances and other errors, the set delay time is adhered to for inactive zero-speed relays. This release time is the time between the switching off of the first output circuit and the switching on of the second. The release time can be set between 1s and 250s in increments of 1s.
The first output circuit is switched off after the set relay delay time has elapsed; the correspon-
ding message output is switched off immediately (stop category 1). The message output of the
second output circuit is switched at the same time as the corresponding relay output.

**Notice**

The message output is not safe. A safe maximum switch-off delay only exists for the output
circuits.

In the event of an internal error in the AS-Interface safety monitor, the output circuits are swit-
chec off immediately. For all other errors, e.g. communication interruption, the set switch-off
delay is retained.

Before the first output circuit is switched on, the second must be switched off. If the validation,
ON state, is performed again before the second output circuit is switched on, the first output
circuit is switched back on and the second remains switched off.

**Note**

After the AS-Interface safety monitor is switched on, the second output circuit is inactive until
the monitored movement has come to a standstill, however for no longer than the duration of
the set release time.

**Unlocking device function**

After the first output circuit is switched off (e.g. following an emergency shutdown), the second
output circuit is switched on after the set release time has passed (or by the zero-speed relays)
so that the doors unlock. This unlocking is not always desired. By enabling **Unlocking device**
(checkbox activated), a standard slave can be specified. The state (LOCK signal) of this stan-
dard slave determines whether or not the locking is to be retained even after the release time
has passed. When the machine is switched off, the LOCK signal can thus be used to freely
turn door locking on and off.

**Restart/Reset of error condition option for safe AS-Interface output (actuator)**

If an AS-Interface safety monitor is configured with safe AS-Interface output (control of safe
AS-Interface actuators) in the Information about monitor and bus, devices for the reset of error
condition and the restart of the actuator must also be configured. After inserting the output de-
vice in the configuration, this is apparent from the 2 dummies for the restart and reset of error
condition devices.
Assign the dummies for restart and reset of error condition the desired devices by using drag&drop to move devices from the icon library onto the dummies.

**Note**

For an automatic restart, simply assign the restart dummy the TRUE system device.

Once the dummies are assigned the appropriate devices, you can make further settings for the reset of error condition and for restart by reopening the input mask of the output device.

To do this, click the output device with the right mouse button, select the **Edit** command from the pop-up menu which opens and click the **AS-iS control** tab in the input mask.

**Input mask**

In the Reset of error condition and Restart areas in the Help signals part of the window, you can define in detail which signals result in an activation of the reset of error condition and in restart of the safe actuator.

Available for selection for activating the reset of error condition are:

- Once on OFF --> ON
- Once on ON --> OFF
- Once on change of state

Available for selection for activating the restart are:

- Continuous while ON
- Continuous while OFF
- Continuous while ON and OFF
- Once on OFF --> ON
- Once on ON --> OFF
- Once on change of state

Define the events for activating the reset of error condition and restart and confirm your entry with OK.
Configuration log

Example: with unlocking device

| 0053 INDEX: | 37 = "Name" |
| 0054 TYPE: | 104 = door lock and stop 1 with delayed relay |
| 0055 ASSIGNED: | channel one |
| 0056 SUBTYPE: | input or time |
| 0057 STOP1 DELAY: | 2.000 Sec |
| 0058 UNLOCK DLY : | 20.000 Sec |
| 0059 LOCK: | yes ADDRESS: 10 BIT: In-0 noninv |

Example: without unlocking device

| 0053 INDEX: | 37 = "Name" |
| 0054 TYPE: | 104 = door lock and stop 1 with delayed relay |
| 0055 ASSIGNED: | channel one |
| 0056 SUBTYPE: | input or time |
| 0057 STOP1 DELAY: | 2.000 Sec |
| 0058 UNLOCK DLY : | 20.000 Sec |
| 0059 LOCK: | no |

Example: Without unlocking device, safe AS-i output

| 0053 INDEX: | 37 = "Name" |
| 0054 TYPE: | 104 = door lock and stop 1 with delayed relay |
| 0055 ASSIGNED: | channel one |
| 0056 SUBTYPE: | input or time |
| 0057 STOP1 DELAY: | 2.000 Sec |
| 0058 UNLOCK DLY : | 20.000 Sec |
| 0059 LOCK: | no |
| 0060 SAFE ACTUATOR ADDRESS 27 |
| 0061 Help Signal 1 from Device 35 at switching ON |
| 0062 Help Signal 2 from Device 1 at switching ON |

Door lock by means of delay time

Note

This output device is available only with two dependent OSSDs.

Symbol

\[
\begin{align*}
\text{Symbol} & : \text{Door lock} \\
\text{Variants} & : \text{Delay time} \quad \text{SUBTYPE: time}
\end{align*}
\]
4.3 Creating and changing a configuration

Parameter

Name: max. 29 ASCII characters plaintext
Release time: 1s … 300 s in multiples of 1s
Unlocking device: with / without
Slave type: standard/A/B slave
Address: AS-Interface bus address (1 … 31)
Bit address: In-0 … In-3 or Out-0 … Out-3, inverted / not inverted

Input mask

![Image of input mask]
Description
After the first output circuit is switched off, the second output circuit is switched on after the set delay time has elapsed. The delay time can be set between 1s and 300s in increments of 1s. Before the first output circuit is switched on, the second must be switched off.

If the validation, ON state, is performed again before the second output circuit is switched on, the first output circuit is switched back on and the second remains switched off.

Note
After the AS-Interface safety monitor is switched on, the second output circuit is inactive for at least the duration of the set release time.

Unlocking device function
After the first output circuit is switched off (e.g. following an emergency shutdown), the second output circuit is switched on after the set release time has passed (or by the zero-speed relays) so that the doors unlock. This unlocking is not always desired. By enabling Unlocking device (checkbox activated), a standard slave can be specified. The state (LOCK signal) of this standard slave determines whether or not the locking is to be retained even after the delay time has passed. When the machine is switched off, the LOCK signal can thus be used to freely turn door locking on and off.

Restart/Reset of error condition option for safe AS-Interface output (actuator)
If an AS-Interface safety monitor is configured with safe AS-Interface output (control of safe AS-Interface actuators) in the Information about monitor and bus, devices for the reset of error condition and the restart of the actuator must also be configured. After inserting the output device in the configuration, this is apparent from the 2 dummies for the restart and reset of error condition devices.

Assign the dummies for restart and reset of error condition the desired devices by using drag&drop to move devices from the icon library onto the dummies.

Note
For an automatic restart, simply assign the restart dummy the TRUE system device.
Once the dummies are assigned the appropriate devices, you can make further settings for the reset of error condition and for restart by reopening the input mask of the output device.

To do this, click the output device with the right mouse button, select the Edit command from the pop-up menu which opens and click the AS-iS control tab in the input mask.

Input mask

In the Reset of error condition and Restart areas in the Help signals part of the window, you can define in detail which signals result in an activation of the reset of error condition and in restart of the safe actuator.

Available for selection for activating the reset of error condition are:
- Once on OFF --> ON
- Once on ON --> OFF
- Once on change of state

Available for selection for activating the restart are:
- Continuous while ON
- Continuous while OFF
- Continuous while ON and OFF
- Once on OFF --> ON
- Once on ON --> OFF
- Once on change of state

Define the events for activating the reset of error condition and restart and confirm your entry with OK.
Configuration logl

Example: with unlocking device

<table>
<thead>
<tr>
<th>0036</th>
<th>INDEX: 35 = &quot;Name&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>0037</td>
<td>TYPE: 103 = door lock</td>
</tr>
<tr>
<td>0038</td>
<td>ASSIGNED: channel one</td>
</tr>
<tr>
<td>0039</td>
<td>SUBTYPE: time</td>
</tr>
<tr>
<td>0040</td>
<td>LOCK: yes ADDRESS: 10 BIT: In-0 noninv</td>
</tr>
<tr>
<td>0041</td>
<td>DELAY TIME: 20.000 Sec</td>
</tr>
</tbody>
</table>

Example: without unlocking device

<table>
<thead>
<tr>
<th>0036</th>
<th>INDEX: 35 = &quot;Name&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>0037</td>
<td>TYPE: 103 = door lock</td>
</tr>
<tr>
<td>0038</td>
<td>ASSIGNED: channel one</td>
</tr>
<tr>
<td>0039</td>
<td>SUBTYPE: time</td>
</tr>
<tr>
<td>0040</td>
<td>LOCK: no</td>
</tr>
<tr>
<td>0041</td>
<td>DELAY TIME: 20.000 Sec</td>
</tr>
</tbody>
</table>

Example: Without unlocking device, safe AS-i output

<table>
<thead>
<tr>
<th>0053</th>
<th>INDEX: 37 = &quot;Name&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>0054</td>
<td>TYPE: 103 = door lock</td>
</tr>
<tr>
<td>0055</td>
<td>ASSIGNED: channel one</td>
</tr>
<tr>
<td>0056</td>
<td>SUBTYPE: time</td>
</tr>
<tr>
<td>0057</td>
<td>LOCK: no</td>
</tr>
<tr>
<td>0058</td>
<td>DELAY TIME: 20.000 Sec</td>
</tr>
<tr>
<td>0059</td>
<td>SAFE ACTUATOR ADDRESS 27</td>
</tr>
<tr>
<td>0060</td>
<td>Help Signal 1 from Device 35 at switching ON</td>
</tr>
<tr>
<td>0061</td>
<td>Help Signal 2 from Device 1 at switching ON</td>
</tr>
</tbody>
</table>
Door lock by means of delay time with stop category 1

**Note**

This output device is available only with two dependent OSSDs.

**Symbol**

[Symbol image]

in the dependent OSSD

**Functional device**

Door lock

**Table: Type and Designation in the configuration log**

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>104</td>
<td>door lock and stop 1 with delayed relay</td>
</tr>
</tbody>
</table>

**Variants**

<table>
<thead>
<tr>
<th>Delay time</th>
<th>SUBTYPE: time</th>
</tr>
</thead>
</table>

**Parameter**

Name: max. 29 ASCII characters plaintext

Release time: 1 s … 250 s in multiples of 1s

Unlocking device: with / without

Slave type: standard/A/B slave

Address: AS-Interface bus address (1 … 31)

Bit address: In-0 … In-3 or Out-0 … Out-3, inverted / not inverted

Relay delay: 0s … 300s in multiples of 100ms

**Input mask**

![Input mask image]
Description

After the first output circuit is switched off, the second output circuit is switched on after the set delay time has elapsed. The delay time can be set between 1s and 250s in increments of 1s. Before the first output circuit is switched on, the second must be switched off.

The first output circuit is switched off after the set relay delay time has elapsed; the corresponding message output is switched off immediately (stop category 1). The message output of the second output circuit is switched at the same time as the corresponding relay output.

Notice

The message output is not safe. A safe maximum switch-off delay only exists for the output circuits.

In the event of an internal error in the AS-Interface safety monitor, the output circuits are switched off immediately. For all other errors, e.g. communication interruption, the set switch-off delay is retained.

If the validation, ON state, is performed again before the second output circuit is switched on, the first output circuit is switched back on and the second remains switched off.

Note

After the AS-Interface safety monitor is switched on, the second output circuit is inactive for at least the duration of the set release time.

Unlocking device function

After the first output circuit is switched off (e.g. following an emergency shutdown), the second output circuit is switched on after the set release time has passed (or by the zero-speed relays) so that the doors unlock. This unlocking is not always desired. By enabling Unlocking device (checkbox activated), a standard slave can be specified. The state (LOCK signal) of this standard slave determines whether or not the locking is to be retained even after the delay time has passed. When the machine is switched off, the LOCK signal can thus be used to freely turn door locking on and off.

Restart/Reset of error condition option for safe AS-Interface output (actuator)

If an AS-Interface safety monitor is configured with safe AS-Interface output (control of safe AS-Interface actuators) in the Information about monitor and bus, devices for the reset of error condition and the restart of the actuator must also be configured. After inserting the output device in the configuration, this is apparent from the 2 dummies for the restart and reset of error condition devices.
Assign the dummies for restart and reset of error condition the desired devices by using drag&drop to move devices from the icon library onto the dummies.

**Note**

For an automatic restart, simply assign the restart dummy the TRUE system device.

Once the dummies are assigned the appropriate devices, you can make further settings for the reset of error condition and for restart by reopening the input mask of the output device.

To do this, click the output device with the right mouse button, select the **Edit** command from the pop-up menu which opens and click the **AS-iS control** tab in the input mask.

**Input mask**

![Input mask](image)

In the Reset of error condition and Restart areas in the Help signals part of the window, you can define in detail which signals result in an activation of the reset of error condition and in restart of the safe actuator.

Available for selection for activating the reset of error condition are:

- Once on OFF --> ON
- Once on ON --> OFF
- Once on change of state

Available for selection for activating the restart are:

- Continuous while ON
- Continuous while OFF
- Continuous while ON and OFF
- Once on OFF --> ON
- Once on ON --> OFF
- Once on change of state

Define the events for activating the reset of error condition and restart and confirm your entry with OK.
### Configuration log1

#### Example: with unlocking device

<table>
<thead>
<tr>
<th>INDEX</th>
<th>36 = &quot;Name&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>TYPE</td>
<td>104 = door lock and stop 1 with delayed relay</td>
</tr>
<tr>
<td>ASSIGNED</td>
<td>channel one</td>
</tr>
<tr>
<td>SUBTYPE</td>
<td>time</td>
</tr>
<tr>
<td>STOP1 DELAY</td>
<td>10.000 Sec</td>
</tr>
<tr>
<td>UNLOCK DLY</td>
<td>20.000 Sec</td>
</tr>
<tr>
<td>LOCK</td>
<td>yes</td>
</tr>
<tr>
<td>ADDRESS</td>
<td>20</td>
</tr>
<tr>
<td>BIT</td>
<td>In-0 noninv</td>
</tr>
</tbody>
</table>

#### Example: without unlocking device

<table>
<thead>
<tr>
<th>INDEX</th>
<th>36 = &quot;Name&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>TYPE</td>
<td>104 = door lock and stop 1 with delayed relay</td>
</tr>
<tr>
<td>ASSIGNED</td>
<td>channel one</td>
</tr>
<tr>
<td>SUBTYPE</td>
<td>time</td>
</tr>
<tr>
<td>STOP1 DELAY</td>
<td>10.000 Sec</td>
</tr>
<tr>
<td>UNLOCK DLY</td>
<td>20.000 Sec</td>
</tr>
<tr>
<td>LOCK</td>
<td>no</td>
</tr>
</tbody>
</table>

#### Example: Without unlocking device, safe AS-i output

<table>
<thead>
<tr>
<th>INDEX</th>
<th>37 = &quot;Name&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>TYPE</td>
<td>104 = door lock and stop 1 with delayed relay</td>
</tr>
<tr>
<td>ASSIGNED</td>
<td>channel one</td>
</tr>
<tr>
<td>SUBTYPE</td>
<td>time</td>
</tr>
<tr>
<td>STOP1 DELAY</td>
<td>10.000 Sec</td>
</tr>
<tr>
<td>UNLOCK DLY</td>
<td>20.000 Sec</td>
</tr>
<tr>
<td>LOCK</td>
<td>no</td>
</tr>
<tr>
<td>SAFE ACTUATOR ADDRESS</td>
<td>27</td>
</tr>
<tr>
<td>Help Signal 1 from Device</td>
<td>35 at switching ON</td>
</tr>
<tr>
<td>Help Signal 2 from Device</td>
<td>1 at switching ON</td>
</tr>
</tbody>
</table>
4.3.6 Diagnostic devices

Diagnostic devices are used to represent the state of safety-oriented AS-interface output slaves in the asimon online diagnostics.

**Note**

These diagnostic devices are available for AS-interface safety monitors with operating software version 3.10 and higher.

**Actuator diagnostics**

**Symbol**

**Functional device** Actuator diagnostics

<table>
<thead>
<tr>
<th>Type</th>
<th>Designation in the configuration log</th>
</tr>
</thead>
<tbody>
<tr>
<td>130</td>
<td>diagnostics device for safe actuator</td>
</tr>
</tbody>
</table>

**Variants**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name:</td>
<td>max. 29 ASCII characters plain text</td>
</tr>
<tr>
<td>Slave type:</td>
<td>standard/A/B slave</td>
</tr>
<tr>
<td>Address:</td>
<td>AS-I bus address (1 ... 31)</td>
</tr>
<tr>
<td>Diagnostics type:</td>
<td>slave type of the safe output slave</td>
</tr>
</tbody>
</table>

**Note**

The respective diagnostics type of the safe AS-interface output slave which must be selected in the input mask is manufacturer-dependent and is specified by the manufacturer in the technical data. Please select these accordingly.
Input mask

![Input mask diagram]

Description

The diagnostic device of the safe output slave has no safety-relevant function, but is used to visualize the state of the safe AS-i output slave.

**Note**

For communication with the AS-i master, the standard address (not the safe address) of the AS-i output slave must be specified in the parameter Address in the input mask of the diagnostic device.

During online diagnostics or diagnostic color-coding via AS-i interface, the displayed color indicates the state of the safe output slave. The colors have the following meaning:

<table>
<thead>
<tr>
<th>Display or color</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>green, continuous</td>
<td>Device is in the ON state (output slave switched on)</td>
</tr>
<tr>
<td>green, flashing</td>
<td>Device is in the ON state, but already in the process of being switched to the OFF state, e.g. switch-off delay is activated</td>
</tr>
<tr>
<td>green / yellow</td>
<td>Notice! Safe actuator - manufacturer dependent, see technical description of the safe AS-interface actuator</td>
</tr>
<tr>
<td>yellow, continuous</td>
<td>Device is ready, but is still waiting for another condition, e.g. local acknowledgment, start button via auxiliary signal 2</td>
</tr>
<tr>
<td>yellow, flashing</td>
<td>(Start-up) test required, e.g. time condition of synchronization time has been exceeded. The action must be repeated</td>
</tr>
<tr>
<td>red, continuous</td>
<td>Device is in the OFF state (output slave switched off)</td>
</tr>
<tr>
<td>red, flashing</td>
<td>Error unlock is active, release through auxiliary signal 1</td>
</tr>
<tr>
<td>gray</td>
<td>No communication with the AS-i slave</td>
</tr>
</tbody>
</table>
For an example of online actuator diagnostics via asimon see chapter "Diagnostics" (diagnostics examples) (see chapter 6.1).

Figure 4-6  Example 1: Configuration of the diagnostic device of the safe output slave

Configuration log

<table>
<thead>
<tr>
<th>Example: Diagnostics of safe AS-interface output slave</th>
</tr>
</thead>
<tbody>
<tr>
<td>0052 INDEX: 37 = “Name”</td>
</tr>
<tr>
<td>0053 TYPE: 130 = diagnostics device for safe actuator</td>
</tr>
<tr>
<td>0054 ASSIGNED: channel two</td>
</tr>
</tbody>
</table>
4.3.7 System devices

System devices are internal variables which the user can use to access intermediate results. During the calculation timespan (cycle time of the bus system), their values are constant. They are processed before the configured device is calculated, i.e. they contain the values from the previous calculation.

Note

Within a configuration, system devices can only be used as auxiliary variables for the logical linking of states in the logic devices.

<table>
<thead>
<tr>
<th>System device</th>
<th>Icon</th>
<th>Index</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE</td>
<td>![ON]</td>
<td>1</td>
<td>static on</td>
</tr>
<tr>
<td>FALSE</td>
<td>![OFF]</td>
<td>17</td>
<td>static off</td>
</tr>
<tr>
<td>State of output switching element 1</td>
<td>![1]</td>
<td>2</td>
<td>main output one</td>
</tr>
<tr>
<td>Negated state of output switching element 1</td>
<td>![1]</td>
<td>18</td>
<td>not main output one</td>
</tr>
<tr>
<td>State of output switching element 2</td>
<td>![2]</td>
<td>3</td>
<td>main output two</td>
</tr>
<tr>
<td>Negated state of output switching element 2</td>
<td>![2]</td>
<td>19</td>
<td>not main output two</td>
</tr>
<tr>
<td>State of message output 1</td>
<td>![1]</td>
<td>4</td>
<td>notify output one</td>
</tr>
<tr>
<td>Negated state of message output 1</td>
<td>![1]</td>
<td>20</td>
<td>not notify output one</td>
</tr>
<tr>
<td>State of message output 2</td>
<td>![2]</td>
<td>5</td>
<td>notify output two</td>
</tr>
<tr>
<td>Negated state of message output 2</td>
<td>![2]</td>
<td>21</td>
<td>not notify output two</td>
</tr>
<tr>
<td>State of OSSD 1</td>
<td>![1]</td>
<td>6</td>
<td>devices started one</td>
</tr>
<tr>
<td>Negated state of OSSD 1</td>
<td>![1]</td>
<td>22</td>
<td>not devices started one</td>
</tr>
<tr>
<td>State of OSSD 2</td>
<td>![2]</td>
<td>7</td>
<td>devices started two</td>
</tr>
<tr>
<td>Negated state of OSSD 2</td>
<td>![2]</td>
<td>23</td>
<td>not devices started two</td>
</tr>
<tr>
<td>State of devices before start 1</td>
<td>![1]</td>
<td>8</td>
<td>dev before start one</td>
</tr>
<tr>
<td>Negated state of devices before start 1</td>
<td>![1]</td>
<td>24</td>
<td>not dev before start one</td>
</tr>
<tr>
<td>State of devices before start 2</td>
<td>![2]</td>
<td>9</td>
<td>dev before start two</td>
</tr>
<tr>
<td>Negated state of devices before start 2</td>
<td>![2]</td>
<td>25</td>
<td>not dev before start two</td>
</tr>
</tbody>
</table>
4.3.8 User devices

By defining user devices, you can simplify the multiple use of logical devices within a configuration.

A logical unit consisting of any combination of monitoring devices, logic devices, external device monitoring devices and system devices can be defined as a user device. To do this, all components of a user device must be logically linked to one another, i.e. a user device has exactly one logical output value.

Once defined, user devices are available in the icon library with a selectable symbol (icon), which can be used multiple times in configuration/OSSD windows.

![User devices in the icon library](image)

Figure 4-7 User devices in the icon library

Defining user devices

A user device is defined by selecting the device which supplies the logical result of a logical unit of devices, clicking this device with the right mouse button and then selecting the Create user device command from the pop-up window which opens.

![Example: Creating a user device](image)

Figure 4-8 Example: Creating a user device
The user device is then displayed in a separate window with its components and in the configuration windows as a single device and is added to the icon library by name.

**Figure 4-9  Example: Created user device**

**Changing the symbol of the user device**

Click a user device with the right mouse button and select the **Edit user device symbol ...** command to assign the device a different device symbol. Select the desired new symbol for the device from the window which opens and confirm with OK.

**Figure 4-10  Changing the symbol of the user device**

The new symbol is now displayed in the configuration windows and in the icon library.

**Deleting user devices**

Click a user device with the right mouse button and select the **Delete user device** command to cancel the definition of the user device. The window for the user device is closed, the user device is removed from the icon library and the logical components of the device are displayed in the configuration windows instead of the user device.
4.3.9 Activating and deactivating devices

Changing the state of the devices

Note
This functionality is only available in AS-Interface safety monitors starting with version 2.0.

AS-Interface safety monitors starting with version 2.0 offer the possibility to activate and deactivate devices. As a result, it is possible to configure all conceivable options in the safety-relevant design of a machine. Through targeted deactivation of devices, the configuration can be adapted to the actual situation.

Deactivating devices

Caution
Observe all safety regulations when you deactivate a device. This must only be performed by an authorised safety technician.

When you select a device with the mouse and click the right mouse button, the following pop-up menu opens:
Select the **Deactivate** command. In the window which opens, you specify under which conditions the deactivated device is to be replaced in the configuration. To do this within an AND device, select the value **TRUE**. This is in the top configuration level. To do this within an OR device, select the value **FALSE**.

This device then always delivers the preset value regardless of whether the safe slave is installed on the bus.

This option can also be used for commissioning when the safe slave is not yet installed but parts of the configuration are to be put into operation.

If the safe AS-Interface address of the device to be deactivated is no longer used in any other device\(^1\), you can decide during deactivation how this address should be used:

1. **Information about bus for address … Delete:** The address should be removed from the bus information (results in no check mark for this address - neither under “Safe” nor “Standard”) if the safe slave is also physically removed from the AS-Interface bus.

2. **Information about bus for address … Retain:** The address is retained as an unused safe address (results in a deselectable check mark for this address in the “Safe” column) if the safe slave physically remains in the AS-Interface bus.

---

\(^1\) Such multiple usage is, however, only possible with the "zero sequence detection" device.
Configuring the AS-Interface safety monitor

4.3 Creating and changing a configuration

Background:
As long as they remain on the bus, the code sequences of all safe slaves must be known to the monitor for safety reasons. The code sequences are, therefore, also queried when teaching the safe configuration (teach) in this case. If, on the other hand, a safe slave is removed from the bus but not from the bus information, an error message which requests that the configuration procedure be reperformed does not appear until teaching the safe configuration.

After deactivating a device, the device is displayed in grey. Within logic devices, deactivated devices are represented with green-grey colour (value **TRUE**) or with red-grey colour (value **FALSE**) depending on their value.

![Deactivated device](image)

Deactivated device

Figure 4-11 Display of a deactivated device

**Note**
When you deactivate a logic device, you can no longer see the devices used within the logic function, and you can also no longer display the logic device. When editing a deactivated device, you can only change the names and the value.
Activating devices

In order to reactivate a deactivated device, click the right mouse button on the deactivated device. The following pop-up menu opens.

Select the **Activate** command. The device is again displayed as a full-colour image.

The safe address is reset to "safe" upon activation in the bus information and marked as used in the configuration. This is represented by greyed-out fields and a check mark which cannot be deselected in the "Safe" column.

If the safe address of the deactivated device was removed from the bus information during deactivation, it is first re-registered.

If, in the meantime, the address in question was assigned to a different, newly configured device, an address conflict may result. In this case, the input window of the device which is to be activated appears together with an info window which is attached to the edge of the window. Select either a different safe address from those which are available or ensure (after cancelling activation) that the address of the deactivated device is again available.
4.4 Saving / loading a configuration

With the Open... command in the File menu, you can load a configuration stored on a data carrier into the ASIMON program. In ASIMON it is only possible to work with one configuration, not several in different windows.

If you are working with an unsaved configuration and would like to use the Open... command to open a different configuration from a data carrier, you are first asked if you would like to save the current configuration. If you do not save here, these data are lost.

Figure 4-12 Confirmation dialog upon opening a configuration

To save a configuration, select either the Save or Save as... command from the File menu. Configurations are saved in the accustomed Windows® manner.

Note

ASIMON configuration files have the extension *.ASI (version 1 AS-Interface safety monitors), *.AS2 (version 2 AS-Interface safety monitors) or *.AS3 (version 3 AS-Interface safety monitors).

Saving a configuration on a data carrier does not ensure a useful, correct and functioning configuration. For further information, refer to chapter 5 "Commissioning the AS-Interface safety monitor".
5 Commissioning the AS-Interface safety monitor

5.1 Procedure

Caution
As the commissioning of the AS-Interface safety monitor involves safety-relevant worksteps, the commissioning must be performed by the safety officer responsible for the application.

For reasons of safety, the commissioning of the AS-Interface safety monitor is performed step by step according to a fixed procedure.

Step 1 - Call up and edit (optional) configuration

If you would like to change the configuration of a previously configured AS-Interface safety monitor, you have the option of reading the configuration stored in the AS-Interface safety monitor into ASIMON. This is particularly useful when no configuration file has been stored on a data carrier, or when a configuration file has been lost, e.g. due to data loss.

When configuring an AS-Interface safety monitor for the first time, or if you would like to completely reconfigure an AS-Interface safety monitor, continue with Step 2.

To call up the configuration, proceed as follows:

• If the AS-Interface safety monitor is in protective operation, you must first switch it to configuration operation by clicking the button or by using the Stop command in the Monitor (password protection) menu (see chapter 5.7 "Stopping the AS-Interface safety monitor").

• Then transfer the current AS-Interface safety monitor configuration to ASIMON using the Monitor -> PC command in the Monitor menu (see chapter 5.2 "Reading in a configuration from the AS-Interface safety monitor").

• Change the configuration in ASIMON as described in chapter 4.

Note
By querying the diagnostic information of an AS-Interface safety monitor used in protective operation, you can reconstruct an unknown configuration. See “Option Diagnostics” on page 18.
5.1 Procedure

Step 2 - Transfer the configuration to the AS-Interface safety monitor

After you have created a valid configuration for the connected AS-Interface safety monitor, you must then transfer it to the AS-Interface safety monitor.

Notice

The existing configuration on the AS-Interface safety monitor is overwritten during a new configuration. If you are not certain whether this configuration will be needed again in the future, please read it into ASIMON and save it to a data carrier before performing a new configuration. If you would like to reconfigure the AS-Interface safety monitor, you must first change the default password to a new password, which is known only to you as the safety officer (see chapter 5.9 "Entering and changing the password").

Proceed as follows:

- If the AS-Interface safety monitor is in protective operation, you must first switch it to configuration operation by clicking the button or by using the Stop command in the Monitor (password protection) menu (see chapter 5.7 "Stopping the AS-Interface safety monitor").
- Then transfer the current configuration from ASIMON to the AS-Interface safety monitor using the PC -> Monitor ... command (see chapter 5.3 "Transferring a configuration to the AS-Interface safety monitor").
- Following successful transfer to the AS-Interface safety monitor, the configuration must be taught in (teaching the code sequence of the safe AS-Interface slaves to be monitored). A dialog window appears after the configuration has been transferred, asking whether you would now like to do this.

Step 3 - Teaching the safe configuration

After you have transferred your configuration to the connected AS-Interface safety monitor, you must then teach it in.

This is performed for the purpose of verifying the transferred configuration and for a functional check of the safe AS-Interface slaves which are to be monitored.

Proceed as follows:

- Put the AS-Interface bus into operation, including all safe AS-Interface slaves which are to be monitored.
- Where possible, set all of the safe AS-Interface slaves which are to be monitored to the switched-on state (ON).

Note

To teach-in the safe configuration, the respective AS-Interface bus must be in full operation and the safe AS-Interface slaves which are to be monitored should, if possible, be in the switched-on state (ON). Otherwise, the AS-Interface safety monitor cannot receive code sequences.

Alternatively, you can also enter the code sequences manually.

- Confirm the query "Would you like to teach the code sequences?" with the Yes button or select on the Monitor menu the Teach safe configuration... command (see chapter 5.4 "Teach safe configuration").
- The code sequences are now taught in. If, due to the system design, not all of the safe AS-Interface slaves which are to be monitored can simultaneously be set to the switched-on state (ON), teaching in of the code sequences is repeated in steps until the code sequences of all of the slaves which are to be monitored have been read in correctly. To do
this, set all of the safe AS-Interface slaves which are to be monitored to the switched-on state (ON) in sequence. Alternatively, you can also enter the code sequences manually.

If the code sequences of all safe AS-Interface slaves which are to be monitored could reliably be read in, the provisional configuration log is then immediately transferred to ASIMON for review by the safety officer responsible for the application.

**Step 4 - Check the configuration log and validate the configuration**

Carefully check the provisional configuration log transferred from the AS-Interface safety monitor. To do this, you can print out the log or save it as a text file. The structure of the configuration log is described in detail in chapter 5.8. After doing this, you must validate the configuration in the Validate window which opens (password protection).

**Notice**

By validating the configuration, you confirm as safety officer that the system is set up correctly and all safety-relevant regulations and standards for the application have been adhered to. To do this, select from the Monitor menu the Validate… command (see chapter 5.5 "Validating the configuration").

Following validation of the AS-Interface safety monitor configuration, the final configuration log must be transferred to ASIMON as part of the application documentation to be maintained by the responsible safety officer.

Print out this log and file it together with the other safety-relevant documentation for your application. In addition, you can also save the log as a text file. The structure of the configuration log is described in detail in chapter 5.8.

**Step 5 - Start the AS-Interface safety monitor**

In the final step of the configuration, you must start the AS-Interface safety monitor, i.e. switch from configuration operation to protective operation. To do this, click the button or select the Start command from the Monitor menu (password protection, see chapter 5.6 "Starting the AS-Interface safety monitor").

You must now check that your application functions properly (see chapter "Diagnostics and error handling"). For this purpose, ASIMON automatically switches to the diagnostics view after startup (see chapter 6 "Diagnostics and error handling").
5.2 Reading in a configuration from the AS-Interface safety monitor

First switch the AS-Interface safety monitor from protective operation to configuration operation (see chapter 5.7 "Stopping the AS-Interface safety monitor").

To read in the configuration currently stored in the AS-Interface safety monitor, select in the Monitor menu the Monitor -> PC … command. The configuration is then transmitted to ASIMON. The transmission takes several seconds. The progress is displayed in a window.

Upon successful conclusion of the data transmission from the AS-Interface safety monitor, the configuration is available in ASIMON for further editing.

If an error occurs during the data transmission, an error message is output.

5.3 Transferring a configuration to the AS-Interface safety monitor

First switch the AS-Interface safety monitor from protective operation to configuration operation (see chapter 5.7 "Stopping the AS-Interface safety monitor").

To transfer the configuration currently located in ASIMON to the connected AS-Interface safety monitor, select on the Monitor menu the PC -> Monitor… command. The configuration is then transmitted to the AS-Interface safety monitor. The transmission takes several seconds. The progress is displayed in a window.

Upon successful conclusion of the data transmission to the AS-Interface safety monitor, the configuration is stored in the AS-Interface safety monitor.

If an error occurs during the data transmission, an error message is output.
5.4 Teach safe configuration

After you have transferred your configuration to the connected AS-Interface safety monitor, you must then teach in the safe configuration. For this purpose, the code sequences of the safe AS-Interface slaves to be monitored by the AS-Interface are read in. The code sequence of each safe AS-Interface slave which is to be monitored is stored in the configuration log.

Note
Additional information on code sequences and secure AS-Interface transmission can be found in the operating manual for the AS-Interface safety monitor.

Before teaching-in the safe configuration, you must commission the AS-Interface bus including all safe AS-Interface slaves which are to be monitored and, where possible, set all safe AS-Interface slaves which are to be monitored to the switched-on state (ON).

If, due to the system design, not all of the safe AS-Interface slaves which are to be monitored can simultaneously be set to the switched-on state (ON) (e.g. for a wicket gate in a material air lock in which a switch with safe AS-Interface slave is located at each of the end positions), teaching in of the code sequences is repeated in steps until the code sequences of all of the slaves which are to be monitored have been read in correctly. To do this, set all of the safe AS-Interface slaves which are to be monitored to the switched-on state (ON) in sequence.

To teach-in the code tables, select from the Monitor menu the Teach safe configuration… command or confirm when prompted "Would you like to teach the code sequences?" with the Yes button.

The code tables are then taught in by the AS-Interface safety monitor. The teaching-in process takes several seconds. The progress is displayed in a window.
If not all of the safe AS-Interface slaves which are to be monitored can be set to the switched-on state (ON) simultaneously, the following window appears in which the progress of the teaching process is graphically depicted.

Now, one after the other, set all safe AS-Interface slaves whose code sequences could not previously be read to the switched-on state (ON) for several seconds. The configuration is continuously read by the AS-Interface safety monitor. The display of the safe AS-Interface slaves which have already been taught and those which still need to be taught is updated constantly.

As an alternative to this, you can also manually enter the code sequence of a safe AS-Interface slave. To do this, double-click the checkbox of the respective safe AS-Interface slave in the CT column (code table). The following window for manual input of the code sequence opens.

Enter the correct code sequence and confirm your entry with OK.

Upon successful conclusion of the teaching process or after entering all code sequences, click OK. Immediately afterward, the preliminary configuration log is transmitted to **ASIMON**.

**Note**

In the **Incremental teach** window, switch states S1 and S2 are displayed for the respective slaves in addition to the teach state. In this way, you can also detect possible device malfunctions or communication faults from a single screen.

Incremental teaching of the code sequences also functions with older AS-Interface safety monitor models, but takes longer as the entire configuration must always be loaded into the safety monitor between two successive teach operations.
The progress of the transmission of the provisional configuration log is displayed in a window.

An info window then prompts you to have the configuration reviewed by the safety officer responsible for the application using the configuration log.

The provisional configuration log is displayed in ASIMON in a separate window.

**Note**

The configuration log is always written in English.
You can print out this provisional configuration log and/or store it as a file, as long as the protocol window remains open. To do this, select on the Monitor menu in the Configuration log submenu the appropriate command.

With the Save as... command, the standard Windows® dialog window for saving files is opened; with the Print... command, the file is printed directly on the set printer.

After you have successfully checked the configuration using the provisional configuration log, you can validate the configuration in the AS-Interface safety monitor.
5.5 Validating the configuration

Note
By validating the configuration, you confirm as safety officer that the system is set up correctly and all safety-relevant regulations and standards for the application have been adhered to.

To validate a configuration, select on the Monitor menu the Validate… command. A dialog box appears in which you can validate a configuration by entering your name and the password.

Note
Configuration validation is, as are several other safety-relevant commands, password protected. The default password of a brand-new AS-Interface safety monitor is "SIMON". You must change this default password to a password known only to the safety officer responsible for the application (see chapter 5.9 "Entering and changing the password").

Confirm your entry with the OK button. An info window then confirms successful validation of the configuration.

Note
Following successful validation, save the configuration again on the PC. In this way you ensure that the download time and the taught-in code sequences are also stored in the configuration file and the ASIMON diagnostics recognise the correct configuration.

Note
The validation information in addition to the password, however, in a different location. Using this information, the manufacturer can generate a generic password which can be used to re-enable the AS-Interface safety monitor should the password be lost.

The validation information can also be found in line 10 of the final configuration log.
Immediately afterward, the final configuration log is transmitted to ASIMON. The progress of the transmission of the final configuration log is displayed in a window.

The final configuration log is displayed in ASIMON in a separate window. As an indication of a validated configuration and to differentiate from a provisional configuration log, the validation information is now displayed in line 10.

**Note**
The configuration log is always written in English.

"VALIDATED..." (line 10):
indicates a final configuration log with validation information
- date and time
- name
- code
- sequential number of the configuration
You can print out the final configuration log and/or store it as a file. To do this, select on the Monitor menu in the Configuration log submenu the appropriate command.

With the Save as... command, the standard Windows® dialog window for saving files is opened; with the Print... command, the file is printed directly on the set default printer.

The final configuration log serves as safety-relevant, application documentation to be maintained by the responsible safety officer.

Print out this log and file it together with the other safety-relevant documentation for your application. The structure of the configuration log is described in detail in chapter 5.8.

After you have successfully validated the configuration, you can start the AS-Interface safety monitor, i.e. put it into protective operation.

5.6 Starting the AS-Interface safety monitor

If a valid, validated configuration is present in the AS-Interface safety monitor, you can switch the AS-Interface safety monitor from configuration operation to protective operation by clicking the ✓ button or with the Start command in the Monitor menu.

After starting protective operation, the status line informs you of the change to the new operating mode and ASIMON automatically switches to the diagnostics view (see chapter "Diagnostics and error handling").

The change from protective operation to configuration operation is then possible only by means of a Stop command (see chapter 5.7 "Stopping the AS-Interface safety monitor").
5.7 Stopping the AS-Interface safety monitor

If the AS-Interface safety monitor is in protective operation, it can only be switched to configuration operation by ASIMON with the **Stop** command in the **Monitor** menu or by clicking the button.

A Stop command is accepted by the AS-Interface safety monitor when

- the valid password is entered.
- no AS-Interface telegrams are present on the bus, even without password.

**Note**
When replacing a defective safe input slave, it is possible to change from protective operation to configuration operation even without a connected PC by using the AS-Interface safety monitor service button. Further information can be found in the operating manual for the AS-Interface safety monitor.

A Stop command is treated similarly to the activation (shutting-down) of a monitoring device, i.e. depending on the configured output device, it may take up to one minute before the AS-Interface safety monitor switches off the safe switching outputs and switches to configuration operation.

Following execution of the stop command, the status bar provides information about the change to configuration operation.

---

5.8 Configuration documentation

**Configuration log**

The configuration log serves as safety-relevant documentation of the application (see chapter 5.4 and chapter 5.5). It contains all information about the configuration of the AS-Interface safety monitor.

The provisional configuration log is to be used by the safety officer for reviewing the configuration of the AS-Interface safety monitor and the safety-relevant AS-Interface application.

The final configuration log is to be used by the safety officer for documenting the configuration of the AS-Interface safety monitor and the safety-relevant AS-Interface application. It is an important part of the safety-relevant documentation of your application and must be filed with the safety-relevant documentation.

**Note**
The configuration log is always written in English.
The structure is explained below using an example.

```
Example of a final configuration log

0000 **************************************************************************0
0001 CONFIGURATION AS-INTERFACE SAFETY MONITOR                                 1
0002 IDENT: "Configuration 1"                                                  2
0003 **************************************************************************3
0004 MONITOR SECTION 4
0005 **************************************************************************5
0006 MONITOR VERSION: 03.00 enhanced                                          6
0007 CONFIG STRUCTURE: 02.01                                                   7
0008 PC VERSION:       02.03                                                   8
0009 DOWNLOAD TIME:    2007/09/10 12:54                                        9
0010 VALIDATED:        2007/09/10 12:54 BY: "SIMON" CODE: CCB5 COUNT: 0011    0
0011 MONITOR ADDRESS:   28 - 31 DIAGNOSIS: all devices                        1
0012 MODE:             two independent output groups                           2
0013 DIAG FREEZE:      no                                                      3
0014 ERROR UNLOCK:     no                                                      4
0015 OUTPUT CH1: relais                                                    5
0016 OUTPUT CH2: relais, AS-i CODE: 16 CD A9 E5                               6
0017 **************************************************************************7
0018 DEVICE SECTION 8
0019 **************************************************************************9
0020 NUMBER OF DEVICES: 8                                                   0
0021 --------------------------------------------------------------------------1
0022 INDEX:       32 = "NA 1"                                                  2
0023 TYPE:        20 = double channel forced safety input                      3
0024 SUBTYPE:    no startup test                                               4
0025 SUBTYPE:    no local acknowledge                                          5
0026 ASSIGNED:   channel one                                                   6
0027 SAFE SLAVE:   1                                                           7
0028 --------------------------------------------------------------------------8
0029 INDEX:       33 = "NA 3"                                                  9
0030 TYPE:        20 = double channel forced safety input                      0
0031 SUBTYPE:    no startup test                                               1
0032 SUBTYPE:    no local acknowledge                                          2
0033 ASSIGNED:   channel one                                                   3
0034 SAFE SLAVE:   2                                                           4
0035 --------------------------------------------------------------------------5
0036 INDEX:       34 = "NA 2"                                                  6
0037 TYPE:        20 = double channel forced safety input                      7
0038 SUBTYPE:    no startup test                                               8
0039 SUBTYPE:    no local acknowledge                                          9
0040 ASSIGNED:   channel two                                                   0
0041 SAFE SLAVE:   4                                                           1
0042 --------------------------------------------------------------------------9
0043 INDEX:       36 = "S 2"                                                   0
0044 TYPE:        81 = manual start standard slave                             1
0045 ASSIGNED:   channel two                                                   2
0046 ADDRESS:    10   BIT: In-1 noninv                                         3
```
### Example of a final configuration log

<table>
<thead>
<tr>
<th>INDEX</th>
<th>TYPE</th>
<th>ASSIGNMENT</th>
<th>ADDRESS</th>
<th>CODE</th>
</tr>
</thead>
<tbody>
<tr>
<td>37</td>
<td>‘S 1’</td>
<td>channel one</td>
<td>10</td>
<td>In-0 noninv</td>
</tr>
<tr>
<td>38</td>
<td>‘M 1’</td>
<td>channel one</td>
<td>10</td>
<td>stop category 0</td>
</tr>
<tr>
<td>39</td>
<td>‘M 2’</td>
<td>channel two</td>
<td>10</td>
<td>stop category 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>11</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>12</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>13</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>14</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>15</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>16</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>17</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>18</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>19</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>20</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>21</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>22</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>23</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>24</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>25</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>26</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>27</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>28</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>29</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>30</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>31</td>
<td></td>
</tr>
</tbody>
</table>

Example of a final configuration log
Example of a final configuration log

```
0101 **************************************************************************
0102 INFO SECTION
0103 **************************************************************************
0104 INACTIVE: none
0105 **************************************************************************
0107 END OF CONFIGURATION
0108 **************************************************************************
```

Lines 0000 … 0003: Header information of the configuration log
  Line 0002: Configuration title in quotation marks

Lines 0004 … 0017: Information about the AS-Interface safety monitor
  Line 0006: Software version of the AS-Interface safety monitor
  Line 0007: Version of the configuration structure (firmware)
  Line 0008: Version of the ASIMON PC software
  Line 0009: Time at which the stored configuration was transmitted
  Line 0010: Time at which the stored configuration was validated
  Line 0011: AS-Interface bus address(es) of the safety monitor / device diagnostics
  Line 0012: Operating mode (see "Operating mode" on page 20)
  Line 0013: Diagnosis stop yes/no
  Line 0014: Reset of error condition yes/no
  Line 0015: Type of output of OSSD 1
  Line 0016: Type of output of OSSD 2

Lines 0018 … 0021: Start of the device descriptions
  Line 0020: Number of configured devices

Lines 0022 … 0028: Description of the device with index 32
  Line 0022: Index and name of the device
  Line 0023: Type of device
  Line 0024: Device variant
  Line 0025: Device variant
  Line 0026: OSSD assignment
  Line 0027: AS-Interface bus address of the corresponding, safe AS-Interface slave

Note
The detailed descriptions of the devices as well as an example of their respective entries in the configuration log can be found in chapter 4.3.
5.8 Configuration documentation

Lines 0068 ... 0101: Information about the AS-Interface bus
- Line 0070 ... Table of the AS-Interface bus addresses with designation of their assignment, see following explanation
- Line 0100:

Lines 0102 ... 0108: Footer information of the configuration log
- Line 0104: Designation of inactive slaves
- Line 0106: Repetition of the validation information
- Line 0107: Designation of configuration log end

Explanation of the table entries for the AS-Interface bus address assignments

no entry No entry present.
not used standard Bus address is occupied by an AS-Interface standard slave which is, however, not monitored by the AS-Interface safety monitor.
used standard Bus address is occupied by an AS-Interface standard slave which is monitored by the AS-Interface safety monitor, e.g. local acknowledgement, manual start etc.
not used safety input Bus address is occupied by a safe AS-Interface slave which is, however, not monitored by the AS-Interface safety monitor. Also listed is the code table for this safe AS-Interface slave.
used safety input Bus address is occupied by a safe AS-Interface slave which is monitored by the AS-Interface safety monitor, e.g. emergency shutdown, contactless active protective device (AOPD), safety guard, safe AS-Interface output etc. Also listed is the code table for this safe AS-Interface slave.

Example of a provisional configuration log (excerpt)

```
0000 **************************************************************************0
0001 CONFIGURATION AS-INTERFACE SAFETY MONITOR                                 1
0002 IDENT: "Configuration 1"                                                  2
0003 **************************************************************************3
0004 MONITOR SECTION                                                           4
0005 **************************************************************************5
0006 MONITOR VERSION: 02.12 enhanced                                           6
0007 CONFIG STRUCTURE: 02.01                                                   7
0008 PC VERSION:       02.02                                                   8
0009 DOWNLOAD TIME:    2005/08/05 19:07                                        9
0010 NOT VALIDATED                                                             0
0011 MONITOR ADDRESS:   28 - 31  DIAGNOSIS: all devices                        1
0012 MODE:             two independent output groups                           2
0013 DIAG FREEZE:      no                                                      3
0014 ERROR UNLOCK:     no                                                      4
0015 OUTPUT CH1:       relais                                                  5
0016 OUTPUT CH2:       relais, AS-i         CODE:       16 CD A9 E5            6
0017 **************************************************************************5
    :                                                                       7
    :
```

A provisional configuration log can be identified by the entry "NOT VALIDATED" in line 10
The configuration log of a faulty configuration contains error entries.

In the above example, line 79 contains the error message indicating that the code table of the safe AS-Interface slave is faulty. The code "00 00 00 00" indicates that this safe AS-Interface slave was not switched on (ON state) during the teaching of the safe configuration. Line 115 at the end of the configuration log also contains the error message indicating that the configuration is faulty.
5.8 Configuration documentation

### AS-Interface diagnosis indices

**Note**

If the default assignment of the diagnosis indices is changed (see chapter 7.2) and this configuration is loaded into the AS-Interface safety monitor, the current assignments of the device indices to the AS-i diagnosis indices is included in the configuration log as an assignment list.

#### Example configuration log with AS-i diagnosis index assignment

```
0101 ******************************************************************************
0102 INACTIVE: none
0103 --------------------------------------------------------------------------
0104 AS-INTERFACE DIAGNOSIS REFERENCE LIST
0105 DIAG INDEX: 00 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15
0106 DEVICE: -- 32 33 35 34 -- -- -- -- -- -- -- -- -- -- --
0107
0108 DIAG INDEX: 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31
0109 DEVICE: -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
0110
0111 DIAG INDEX: 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47
0112 DEVICE: -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
0113 ******************************************************************************
```
Printing the configuration

With the Print -> Configuration as text ... command in the File menu, you can also print out the configuration currently present in ASIMON as a list.

**Note**

Printing the configuration using the Print command in the File menu does not replace the configuration log. It serves only as a good documentation aid in the set program language.

Following is an example of such a configuration hardcopy.

```
Date: 22.02.2008 15:02:13
Configuration title: Configuration 1
Download time: 04. Januar 2007 14:51
Monitor address: 28 / 29 / 30 / 31
AS-Interface diagnosis: All devices
Operating mode: Two independent OSSDs
Reset of error condition: -

132 Emergency shutdown
Name: "NA 1"
Type: forced
Start-up test: No
Local acknowledgement: No
OSSD: 1 / 2
Address: 1

133 Emergency shutdown
Name: "NA 2"
Type: forced
Start-up test: No
Local acknowledgement: No
OSSD: 1
Address: 4

134 Emergency shutdown
Name: "NA 3"
Type: forced
Start-up test: No
Local acknowledgement: No
OSSD: 1
Address: 2

135 AOPD
Name: "BWS 1"
Type: forced
Start-up test: No
Local acknowledgement: No
OSSD: 1 / 2
Address: 3

136 Monitored start - standard slave
Name: "S 1"
Address: 1
OSSD: 1
In: 1
Inverted: no

137 Monitored start - standard slave
Name: "S 2"
Address: 10
OSSD: 2
In: 1
Inverted: inverted

138 Stop category 0
Name: "M 1"
OSSD: 1
Address: 1

139 Stop category 1
Name: "M 2"
OSSD: 2
Address: 2
```
Printing window contents

In addition to printing out the complete configuration as a list, you can also graphically print out the contents of a configuration window. To do this, first bring the desired window to the foreground (active window). In the File menu, select the Print -> Active window as graphic ... command or click the window with the right mouse button and select the Print graphic ... command from the pop-up menu which opens.

In the Print dialog window which opens, select the desired printer if necessary and confirm with OK. Shown below is an example of a graphical printout of a configuration window.

Note

The printout of the configuration window does not replace the configuration log. It serves only as a good documentation aid in the set program language.

TIP:

The printout of a configuration window contains checkboxes located to the upper right of each device which you can use to tick off the commissioning of each device.
5.9 Entering and changing the password

The following safety-relevant, important commands are protected in ASIMON by a password:

- PC -> Monitor…
- Teach safe configuration
- Validate…
- Stop
- Change password…

After calling up a password-protected command, a password dialog box opens in which the password is entered and the authorisation for executing the command is checked.

If an incorrect password is entered, an error message is output and command execution is interrupted.

**Note**

When a correct password is entered, ASIMON remembers the password for 5 minutes. If you execute other password-protected commands during this period, you do not need to re-enter the password. Each time a password-protected command is executed, the internal marker time is reset to 5 minutes.

This makes working with the software easier, as you do not need to constantly enter the password. It should, however, not lead to careless use of the password.

The default password (factory setting) of the AS-Interface safety monitor is "SIMON". If you would like to reconfigure the AS-Interface safety monitor, you must first change this default password to a new one known only to you as safety officer.
5.9 Entering and changing the password

With the **Change password**… command in the **Monitor** menu, you can change the password of the connected AS-Interface safety monitor in configuration operation.

The following dialog box opens:

![Password dialog](image)

4 … 8 alphanumerical characters;
A … Z, a … z, 0 … 9
Password is case-sensitive!

Confirm your entry with the **OK** button. The new password is now stored in the AS-Interface safety monitor and must be used for all password-protected commands from now on.
Diagnostics and error handling

6.1 Diagnostics

Use the Diagnostics command in the Monitor menu or click the button to call up the diagnostics view of the configuration stored in the AS-Interface safety monitor.

**Note**
The Diagnostics command is available only when the AS-Interface safety monitor is in protective operation!

In protective operation, the AS-Interface safety monitor continuously transmits diagnostic data to ASIMON via the configuration interface. In the diagnostics view, the data are displayed in the status bar as they pass through.

For the diagnostics view, these data are converted to virtual LEDs (tree structure display) for each device in the configuration or represented as coloured device outlines and device connections (circuit diagram display) which provide a quick overview of the state of the OSSD(s).

Example 1 (circuit diagram display): both OSSDs are validated

Example 1 (tree structure display): both OSSDs are validated

An LED or outline/line colour is assigned to each configured device which indicates its state.
In addition, each OSSD also has three LEDs (only in the tree structure display) which correspond to the device LEDs on the AS-Interface safety monitor: 1, 2 and 3 (for a description of the states, refer to the operating manual of the AS-Interface safety monitor).

The devices or device LEDs can have the following states:

<table>
<thead>
<tr>
<th>Display or colour</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>green, continuous</td>
<td>Device is in the ON state (switched on)</td>
</tr>
<tr>
<td>green, flashing</td>
<td>Device is in the ON state (switched on), but already in the process of being switched to the OFF state, e.g. switch-off delay</td>
</tr>
<tr>
<td>yellow, continuous</td>
<td>Device is ready, but is still waiting for another condition, e.g. local acknowledgement, diagnosis stop or start button</td>
</tr>
<tr>
<td>yellow, flashing</td>
<td>A (start) test must be performed</td>
</tr>
<tr>
<td>red, continuous</td>
<td>Device is in the OFF state (switched off)</td>
</tr>
</tbody>
</table>
| red, flashing     | The error lock is active, release by means of one of the following actions:  
                   • Reset of error condition with the Service button  
                   • Actuate slave for reset of error condition  
                   • Power OFF/ON  
                   • AS-Interface bus OFF/ON |
| grey, off         | No communication with the AS-Interface slave |

Note

Additional diagnostic information can be obtained via the AS-Interface bus and the device LEDs on the AS-Interface safety monitor and, if applicable, the participating AS-Interface slaves. Additional information on diagnostics can be found in chapter 7.
Examples of typical diagnostic states follow.

Example 2 (circuit diagram display):

Example 2 (tree structure display):

Example 3 (circuit diagram display):

Example 3 (tree structure display):
6.2 Troubleshooting and error rectification

The ASIMON software provides information for most errors and operating states via
• the status bar
• message and info window
• the diagnostics

Additional information on troubleshooting can be obtained:
• through diagnostics via the AS-Interface bus (see chapter 7)
• the device LEDs on the AS-Interface safety monitor
  (see operating manual of the AS-Interface safety monitor)
• the device LEDs on the participating AS-Interface slaves (where present).

If you should still have problems during troubleshooting, please first consult the online help and
the handbooks/operating manuals of the participating devices.

If necessary, check the bus addresses and cable connections of the participating devices.

6.3 Known problems

Problem:

The mouse cursor jumps erratically on the PC screen

The Microsoft Windows operating systems check by default whether a mouse is connected to
a serial interface (COM1, COM2, ...). If the serial connection exists between the safety monitor
and the PC when the PC is started up, the AS-Interface safety monitor may be interpreted by
the operating system as a mouse.

The result: the mouse cursor jumps erratically about the PC screen.

Remedy:

As a remedy, the connection to the monitor can be separated while the PC starts. In addition,
the start behaviour of the operating system can be changed. For details, refer to the user do-
umentation provided by the manufacturer of your PC or operating system.
Diagnostics via AS-Interface

7

7.1 General procedure

Note

The assignment of an AS-Interface slave address for the AS-Interface safety monitor is a prerequisite for diagnosing the AS-Interface safety monitor on the AS-Interface master.

Using the AS-Interface bus, diagnosis of the AS-Interface safety monitor and configured devices is possible from the AS-Interface master, normally a PLC with master module.

However, to ensure reliable transmission and efficient evaluation of the diagnostic data, a series of requirements must be satisfied:

- Relatively long telegram propagation times may occur, particularly when using an additional bus system between PLC and AS-Interface. Owing to the asynchronous transmission in the master in the case of two successive, identical data calls, the PLC may not necessarily know when the AS-Interface safety monitor is responding to the new call. Thus, the answers to two successive, different data calls should differ by at least one bit.

- The diagnostic data must be consistent, i.e. the status information sent by the AS-Interface safety monitor must match the actual device states, especially if the propagation time to the PLC is longer than the updating time in the AS-Interface safety monitor (approx. 30 ... 150ms).

- Whether a deactivated relay of an output circuit represents the normal state depends on the operating mode of the AS-Interface safety monitor. The diagnostics in the PLC should only be called in the event of a deviation from the normal state.

The diagnostic procedure described below satisfies these requirements and should therefore always be followed.

Diagnostic procedure

The PLC always queries the AS-Interface safety monitor alternately with two data calls (0) and (1). These data calls return the basic information (state of the output circuits, protective/configuration operation) to allow a diagnosis. The AS-Interface safety monitor answers the two calls with the same user data (3 bit, D2 ... D0). Bit D3 is a control bit, similar (but not identical) to a toggle bit. D3 is 0 for all even data calls (0); D3 is 1 for all odd data calls (1). This enables the PLC to detect whether the answer has changed.

Data calls (0) and (1) return the answer X000 if the normal state exists (protective operation, everything OK). For devices with only one output circuit and with two dependent output circuits, output circuit 2 is always marked as OK. With two independent output circuits, an unconfigured circuit is also marked as OK. In order to be able to interpret what is OK and what is not OK, the user must be familiar with his configuration.
If the data call changes from (0) to (1), the data set is stored in the AS-Interface safety monitor. Bit D3 in the answer, however, remains reset until the process is concluded. As a result, the PLC thinks it has received answers to data call (0). If D3 is set, a consistent data set exists.

If, with the bit D3 set, the answer from the AS-Interface safety monitor signals deactivation of an output circuit, detailed diagnostic information can now be queried in the stored state with the specific data calls (2) … (B). Depending on the setting in the configuration of the AS-Interface safety monitor, data calls (4) … (B) return device diagnostic information sorted according to output circuit (see chapter 7.3.2) or unsorted (see chapter 7.3.3).

**Note**

If the AS-Interface safety monitor is in configuration operation, it is not possible to query the detailed diagnostic information using the data calls (2) … (B).

A fresh data call (0) cancels the stored state again.
When performing diagnostics via the AS-i, the PLC is informed of the indices of the devices which are switched off. In earlier versions of the AS-Interface safety monitor, if a device was added to or deleted from the configuration, all subsequent indices were shifted. As a result, it was necessary for the user to modify the diagnostics program in the PLC.

In the Edit menu of ASIMON version 2.1 / 3.x, you can now use the Device index assignment menu item to freely assign diagnosis indices to the devices for AS-Interface diagnostics.

![Device index assignment for AS-i diagnostics](image)

**Note**

You can also call up the Device index assignment window by clicking the Diagnosis index button when creating or editing a device. When editing a device, the current diagnosis index of the device is also displayed below the Diagnosis index button.

In the lower right part of the Device index assignment for AS-i diagnostics window, you can first define whether the diagnosis index is to use the range from 0 … 47 (standard setting) or the range from 32 … 79 (analogous to the device index).

By activating the Risk of overwriting checkbox, ASIMON will display the following info window to warn you if you attempt to assign an already assigned diagnosis index to a different device.
7.2 Assignment of the AS-Interface diagnosis indices

Editing assignments

By default, all configured devices are assigned sequentially increasing diagnosis indices. The device with index 32 is assigned diagnosis index 0, the device with index 33 is assigned diagnosis index 1, etc.

Note

Use the Device sorting button to restore this original assignment at any time.

If the default assignment of the diagnosis indices is changed, the colour of the table headings changes from grey to green.

If a device is not assigned to a diagnosis index, the Device index assignment window is split horizontally and the unassigned devices appear in the lower window area.
When editing the assignment table, the following options are always available:

- **Assignment via drag&drop** with the mouse.
- **Direct editing** of the device indices in the upper window area in the **Device index** column.
- **Direct editing** of the diagnosis indices in the lower window area in the **Diagnosis index** column.
- Editing via the **AS-i sorting, Delete assignment, Cut, Copy, Paste, Delete line and Insert line** buttons.
- Editing with keyboard commands: Cursor buttons and <Tab> (Navigation) <Alt>+<B> (Device sorting), <Alt>+<A> (AS-i sorting), <Alt>+<I> (Delete assignment), <Ctrl>+<X> (Cut), <Ctrl>+<C> (Copy), <Ctrl>+<V> (Paste), <Delete> (Delete line), <Insert> (Insert line), <Ctrl>+<Z> (Undo), <Ctrl>+<Y> (Redo).

Use the **Undo** and **Redo** buttons to reverse or restore changes which you have made step-by-step.

**Device sorting**

The original sequentially increasing assignment of all configured devices to the diagnosis indices is restored.

**AS-i sorting**

All devices assigned to an AS-Interface address are assigned to the diagnosis index which corresponds to the AS-Interface address. The remaining devices are listed in the lower window area by increasing device index.

**Delete assignment**

The assignment of the devices to the diagnosis indices is completely deleted and all devices are listed in the lower window area by increasing device index.

**Cut**

The contents of the marked line are cut and then added at the appropriate location in the lower window area; the line remains empty.

**Copy**

The contents of the marked line are copied to the clipboard.

**Paste**

The contents of the clipboard are pasted into the marked line.

**Delete line**

The marked line is deleted and the device added at the appropriate location in the lower window area; the lines which follow the deleted line are shifted up (diagnosis index minus one).
Insert line
A blank line is added above the marked line, the lines which follow the added line are shifted down (diagnosis index plus one).

After all changes have been made, click the **OK** button to accept the new device index assignment for the AS-Interface diagnostics.

**Note**
If the default assignment of the diagnosis indices is changed (indicated by a change in the colour of the table headings from grey to green) and this configuration is loaded into the AS-Interface safety monitor, the current assignment of the device indices to the AS-i diagnosis indices is included in the configuration log as an assignment list.

<table>
<thead>
<tr>
<th>Example configuration log with AS-i diagnosis index assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>0101 ***************************************************************</td>
</tr>
<tr>
<td>0102 INACTIVE: none</td>
</tr>
<tr>
<td>0103 ---------------------------------------------------------------</td>
</tr>
<tr>
<td>0104 AS-INTERFACE DIAGNOSIS REFERENCE LIST</td>
</tr>
<tr>
<td>0105 DIAG INDEX: 00 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15</td>
</tr>
<tr>
<td>0106 DEVICE: -- 32 33 34 -- -- -- -- -- -- -- -- -- -- --</td>
</tr>
<tr>
<td>0107</td>
</tr>
<tr>
<td>0108 DIAG INDEX: 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31</td>
</tr>
<tr>
<td>0109 DEVICE: -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --</td>
</tr>
<tr>
<td>0110</td>
</tr>
<tr>
<td>0111 DIAG INDEX: 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47</td>
</tr>
<tr>
<td>0112 DEVICE: -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --</td>
</tr>
<tr>
<td>0113 ***************************************************************</td>
</tr>
</tbody>
</table>
7.3 Telegrams

7.3.1 Diagnosis of AS-Interface safety monitor

State of output circuits, operating mode

**Note**
The alternate sending of data calls (0) and (1) is essential for consistent data transmission. See "Diagnostic procedure" on page 169.

The binary values of the data calls relate to the AS-Interface level and may possibly be inverted at PLC level.

<table>
<thead>
<tr>
<th>Data call / Value</th>
<th>Answer D3 ... D0</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>(0) / 111 State of monitor</td>
<td>0000</td>
<td>Protective operation, everything OK (unavailable, unconfigured or dependent output circuits are displayed as OK).</td>
</tr>
<tr>
<td></td>
<td>0001</td>
<td>Protective operation, output circuit 1 off.</td>
</tr>
<tr>
<td></td>
<td>0010</td>
<td>Protective operation, output circuit 2 off.</td>
</tr>
<tr>
<td></td>
<td>0011</td>
<td>Protective operation, both output circuits off.</td>
</tr>
<tr>
<td></td>
<td>0100</td>
<td>Configuration operation: Power On.</td>
</tr>
<tr>
<td></td>
<td>0101</td>
<td>Configuration operation</td>
</tr>
<tr>
<td></td>
<td>0110</td>
<td>Reserved / not defined</td>
</tr>
<tr>
<td></td>
<td>0111</td>
<td>Configuration operation, fatal device error, RESET or device exchange required.</td>
</tr>
<tr>
<td></td>
<td>1XXX</td>
<td>No up-to-date diagnostic information available, please wait.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data call / Value</th>
<th>Answer D3 ... D0</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) / 1110 Store diagnostic information (state of monitor)</td>
<td>1000</td>
<td>Protective operation, everything OK (unavailable, unconfigured or dependent output circuits are displayed as OK).</td>
</tr>
<tr>
<td></td>
<td>1001</td>
<td>Protective operation, output circuit 1 off.</td>
</tr>
<tr>
<td></td>
<td>1010</td>
<td>Protective operation, output circuit 2 off.</td>
</tr>
<tr>
<td></td>
<td>1011</td>
<td>Protective operation, both output circuits off.</td>
</tr>
<tr>
<td></td>
<td>1100</td>
<td>Configuration operation: Power On.</td>
</tr>
<tr>
<td></td>
<td>1101</td>
<td>Configuration operation</td>
</tr>
<tr>
<td></td>
<td>1110</td>
<td>Reserved / not defined</td>
</tr>
<tr>
<td></td>
<td>1111</td>
<td>Configuration operation, fatal device error, RESET or device exchange required.</td>
</tr>
</tbody>
</table>
State of device LEDs

Data calls (2) and (3) return a simplified indication of the output circuit LEDs on the AS-Interface safety monitor.

If answer to data call (1) = 10XX::

<table>
<thead>
<tr>
<th>Data call / Value</th>
<th>Answer D3 ... D0</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>(2) / 1101</td>
<td></td>
<td></td>
</tr>
<tr>
<td>State of LEDs of</td>
<td>0000</td>
<td>Green = contacts of output circuit closed</td>
</tr>
<tr>
<td>output circuit 1</td>
<td>0001</td>
<td>Yellow = startup/restart-disable active</td>
</tr>
<tr>
<td></td>
<td>0010</td>
<td>Yellow flashing or red = contacts of output circuit open</td>
</tr>
<tr>
<td></td>
<td>0011</td>
<td>Red flashing = error on level of the monitored</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AS-Interface components</td>
</tr>
<tr>
<td></td>
<td>01XX</td>
<td>Reserved</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data call / Value</th>
<th>Answer D3 ... D0</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>(3) / 1100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>State of LEDs of</td>
<td>1000</td>
<td>Green = contacts of output circuit closed</td>
</tr>
<tr>
<td>output circuit 2</td>
<td>1001</td>
<td>Yellow = startup/restart-disable active</td>
</tr>
<tr>
<td></td>
<td>1010</td>
<td>Yellow flashing or red = contacts of output circuit open</td>
</tr>
<tr>
<td></td>
<td>1011</td>
<td>Red flashing = error on level of the monitored</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AS-Interface components</td>
</tr>
<tr>
<td></td>
<td>11XX</td>
<td>Reserved</td>
</tr>
</tbody>
</table>
Colour coding

Note
The colour of a device corresponds to the colour of the virtual LEDs in the diagnostic view of the ASIMON configuration software. A device which is not assigned to any output circuit is always shown in green.

Table 7-1 Colour coding

<table>
<thead>
<tr>
<th>Code CCC (D2 ... D0)</th>
<th>Colour</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>000</td>
<td>green, continuous</td>
<td>Device is in the ON state (switched on)</td>
</tr>
<tr>
<td>001</td>
<td>green, flashing</td>
<td>Device is in the ON state (switched on), but already in the process of being switched to the OFF state, e.g. switch-off delay</td>
</tr>
<tr>
<td>010</td>
<td>yellow, continuous</td>
<td>Device is ready, but is still waiting for another condition, e.g. local acknowledgement, diagnosis stop or start button</td>
</tr>
<tr>
<td>011</td>
<td>yellow, flashing</td>
<td>Time condition exceeded, action must be repeated, e.g. synchronisation time exceeded</td>
</tr>
<tr>
<td>100</td>
<td>red, continuous</td>
<td>Device is in the OFF state (switched off)</td>
</tr>
<tr>
<td>101</td>
<td>red, flashing</td>
<td>The error lock is active, release by means of one of the following actions:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Acknowledge with the service button</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Power OFF/ON</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• AS-Interface bus OFF/ON</td>
</tr>
<tr>
<td>110</td>
<td>grey, off</td>
<td>No communication with the AS-Interface slave</td>
</tr>
</tbody>
</table>

Note
During proper protective operation, there are also devices which are not in the green state. When searching for the cause of a shutdown, the device with the lowest device index is the most important. Others may just be subsequent effects (example: when the emergency shutdown button is pressed, the start device and timer are also in the OFF state).

By appropriately programming the functional device in the PLC, the user can be guided to the primary cause of the error. Detailed knowledge of the configuration and the function of the AS-Interface safety monitor are necessary for the interpretation of additional information.

Because the device numbers can be shifted if the configuration is changed, we recommend using the diagnosis index assignment.
7.3.2 Diagnosis of devices, sorted by OSSD

With the appropriate configuration setting, data calls (4) … (B) return device diagnostic information sorted according to output circuit.

**Note**

Make sure that the correct diagnosis type is set for the AS-Interface safety monitor in the Information about monitor and bus window of the ASIMON configuration software.

The values returned in calls (5) and (6) as well as (9) and (A) refer to the device diagnosis index in the configuration program and not to an AS-Interface address.

Always execute data calls (4) … (7) and (8) … (B) together in sequence for each device.

### Sorted device diagnosis, output circuit 1

If answer to data call (1) = 10X1:

<table>
<thead>
<tr>
<th>Data call / Value</th>
<th>Answer D3 ... D0</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>(4) / 1011</td>
<td>0XXX</td>
<td>XXX = 0: no devices, answers to data calls (5) … (7) not relevant</td>
</tr>
<tr>
<td></td>
<td></td>
<td>XXX = 1 ... 6: number of devices in output circuit 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>XXX = 7: number of devices is &gt; 6 in output circuit 1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data call / Value</th>
<th>Answer D3 ... D0</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>(5) / 1010</td>
<td>1HHH</td>
<td>HHH = I5,I4,I3: diagnosis index of device in output circuit 1 of configuration (HHHLLL = diagnosis index)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data call / Value</th>
<th>Answer D3 ... D0</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>(6) / 1001</td>
<td>0LLL</td>
<td>LLL = I2,I1,I0: diagnosis index of device in output circuit 1 of configuration (HHHLLL = diagnosis index)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data call / Value</th>
<th>Answer D3 ... D0</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>(7) / 1000</td>
<td>1CCC</td>
<td>CCC = Farbe colour (see Table 7-1 on page 177)</td>
</tr>
</tbody>
</table>
### Sorted device diagnosis, output circuit 2

If answer to data call (1) = 101X:

<table>
<thead>
<tr>
<th>Data call / Value</th>
<th>Answer D3 … D0</th>
<th>Meaning</th>
</tr>
</thead>
</table>
| (8) / 0111        | 0XXX           | XXX = 0: no devices, answers to data calls (5) … (7) not relevant  
                             XXX = 1 … 6: number of devices in output circuit 2  
                             XXX = 7: number of devices is > 6 in output circuit 2 |

<table>
<thead>
<tr>
<th>Data call / Value</th>
<th>Answer D3 … D0</th>
<th>Meaning</th>
</tr>
</thead>
</table>
| (9) / 0110        | 1HHH           | HHH = I5,I4,I3: diagnosis index of device in output circuit 2 of configuration  
                             (HHHLLL = diagnosis index) |

<table>
<thead>
<tr>
<th>Data call / Value</th>
<th>Answer D3 … D0</th>
<th>Meaning</th>
</tr>
</thead>
</table>
| (A) / 0101        | 0LLL           | LLL = I2,I1,I0: diagnosis index of device in output circuit 2 of configuration  
                             (HHHLLL = diagnosis index) |

<table>
<thead>
<tr>
<th>Data call / Value</th>
<th>Answer D3 … D0</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>(B) / 0100</td>
<td>1CCC</td>
<td>CCC = colour (see Table 7-1 on page 177)</td>
</tr>
</tbody>
</table>

**Note**

Data calls (C) 0011 to (F) 0000 are reserved.
7.3.3 Diagnosis of devices, unsorted

With the appropriate configuration setting, data calls (4) … (B) return unsorted device diagnostic information for all devices.

**Note**

Make sure that the correct diagnosis type is set for the AS-Interface safety monitor in the Information about monitor and bus window of the ASIMON configuration software. The values returned in calls (5) and (6) as well as (9) and (A) refer to the device diagnosis index in the configuration program and not to an AS-Interface address. Always execute data calls (4) … (7) and (8) … (B) together in sequence for each device.

Unsorted device diagnosis, all devices

If answer to data call (1) = 1001, 1010 or 1011:

<table>
<thead>
<tr>
<th>Data call / Value</th>
<th>Answer D3 ... D0</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>(4) / 1011</td>
<td>XXXX</td>
<td></td>
</tr>
<tr>
<td>Number of devices not green, continuous</td>
<td>XXX = 0:</td>
<td>no devices, answers to data calls (5) … (7) not relevant.</td>
</tr>
<tr>
<td></td>
<td>XXX = 1 ... 6:</td>
<td>number of devices not green.</td>
</tr>
<tr>
<td></td>
<td>XXX = 7:</td>
<td>number of devices not green is &gt; 6 (for colours, see Table 7-1 on page 177).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data call / Value</th>
<th>Answer D3 ... D0</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>(5) / 1010</td>
<td>1HHH</td>
<td></td>
</tr>
<tr>
<td>Device address HIGH</td>
<td>HHH = I5,I4,I3: diagnosis index of device of configuration (HHHLLL = diagnosis index).</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data call / Value</th>
<th>Answer D3 ... D0</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>(6) / 1001</td>
<td>0LLL</td>
<td></td>
</tr>
<tr>
<td>Device address LOW</td>
<td>LLL = I2,I1,I0: diagnosis index of device of configuration (HHHLLL = diagnosis index).</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data call / Value</th>
<th>Answer D3 ... D0</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>(7) / 1000</td>
<td>1CCC</td>
<td></td>
</tr>
<tr>
<td>Colour of device</td>
<td>CCC = colour (see Table 7-1 on page 177).</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data call / Value</th>
<th>Answer D3 ... D0</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>(8) / 0111</td>
<td>0XXX</td>
<td>not used</td>
</tr>
</tbody>
</table>
### Data call / Value

<table>
<thead>
<tr>
<th>Data call / Value</th>
<th>Answer D3 ... D0</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>(9) / 0110</td>
<td>1HHH</td>
<td><strong>Meaning</strong></td>
</tr>
<tr>
<td>Device address</td>
<td></td>
<td><strong>HIGH</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>HH = I5,I4,I3: diagnosis index of device of configuration (HHLLL = diagnosis index).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data call / Value</th>
<th>Answer D3 ... D0</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>(A) / 0101</td>
<td>0LLL</td>
<td><strong>Meaning</strong></td>
</tr>
<tr>
<td>Device address</td>
<td></td>
<td><strong>LOW</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>LLL = I2,I1,I0: diagnosis index of device of configuration (HHLLL = diagnosis index).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data call / Value</th>
<th>Answer D3 ... D0</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>(B) / 0100</td>
<td>10XX</td>
<td><strong>Meaning</strong></td>
</tr>
<tr>
<td>Assignment to out-</td>
<td></td>
<td>put circuit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>XX = 00: device from pre-processing</td>
</tr>
<tr>
<td></td>
<td></td>
<td>XX = 01: device from output circuit 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>XX = 10: device from output circuit 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>XX = 11: device from both output circuits</td>
</tr>
</tbody>
</table>

**Note**

Data calls (C) 0011 to (F) 0000 are reserved.
7.4 Example: Querying with diagnosis sorted according to OSSD

**Figure 7-1** Querying with diagnosis sorted according to output circuit
## Appendix

### Selection and ordering data

<table>
<thead>
<tr>
<th>Version</th>
<th>Order No.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basic safety monitor</strong></td>
<td></td>
</tr>
<tr>
<td>With screw-type terminals, removable terminals</td>
<td></td>
</tr>
<tr>
<td>• One enabling circuit (monitor type 1)</td>
<td>3RK1 105-1AE04-0CA0</td>
</tr>
<tr>
<td>• Two enabling circuits (monitor type 2)</td>
<td>3RK1 105-1BE04-0CA0</td>
</tr>
<tr>
<td><strong>Enhanced safety monitor</strong></td>
<td></td>
</tr>
<tr>
<td>With screw-type terminals, removable terminals</td>
<td></td>
</tr>
<tr>
<td>• One enabling circuit (monitor type 3)</td>
<td>3RK1 105-1AE04-2CA0</td>
</tr>
<tr>
<td>• Two enabling circuits (monitor type 4)</td>
<td>3RK1 105-1BE04-2CA0</td>
</tr>
<tr>
<td><strong>Enhanced safety monitor with integrated safe slave</strong></td>
<td></td>
</tr>
<tr>
<td>With screw-type terminals, removable terminals</td>
<td></td>
</tr>
<tr>
<td>• Two enabling circuits including control of a safe AS-i output / safe</td>
<td>3RK1 105-1BE04-4CA0</td>
</tr>
<tr>
<td>coupling (monitor type 6)</td>
<td></td>
</tr>
<tr>
<td><strong>Basic safety monitor</strong></td>
<td></td>
</tr>
<tr>
<td>With spring-loaded terminal, removable terminals</td>
<td></td>
</tr>
<tr>
<td>• One enabling circuit (monitor type 1)</td>
<td>3RK1 105-1AG04-0CA0</td>
</tr>
<tr>
<td>• Two enabling circuits (monitor type 2)</td>
<td>3RK1 105-1BG04-0CA0</td>
</tr>
<tr>
<td><strong>Enhanced safety monitor</strong></td>
<td></td>
</tr>
<tr>
<td>With spring-loaded terminal, removable terminals</td>
<td></td>
</tr>
<tr>
<td>• One enabling circuit (monitor type 3)</td>
<td>3RK1 105-1AG04-2CA0</td>
</tr>
<tr>
<td>• Two enabling circuits (monitor type 4)</td>
<td>3RK1 105-1BG04-2CA0</td>
</tr>
<tr>
<td><strong>Enhanced safety monitor with integrated safe slave</strong></td>
<td></td>
</tr>
<tr>
<td>With spring-loaded terminal, removable terminals</td>
<td></td>
</tr>
<tr>
<td>• Two enabling circuits including control of a safe AS-i output / safe</td>
<td>3RK1 105-1BG04-4CA0</td>
</tr>
<tr>
<td>coupling (monitor type 6)</td>
<td></td>
</tr>
<tr>
<td><strong>Configuration Software ASIMON V3</strong></td>
<td></td>
</tr>
<tr>
<td>ASIsafe CD</td>
<td>3RK1 802-2FB06-0GA1</td>
</tr>
</tbody>
</table>

For further information, see:
